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About This Book

Using Advanced Features introduces you to many OS/2 functions and
includes sections on configuring your system and maximizing system
performance to get the most out of using IBM Operating System/2
Version 1 .3 (referred to as the OS/2 program) . Topics also describe
OS/2 functions and how they interrelate . Practical tips and
techniques are included in these topics to help you use the features
of the OS/2 program more easily and productively .

Who Should Read This Book
This book is written primarily for experienced operating system users
and is intended for use with the online OS/2 Command Reference . It
is helpful if you are familiar with Presentation Manager and the
information outlined in Getting Started .

How This Book Is Organized
Information in this book is organized in the following manner :

Chapter 1 familiarizes you with the basic features of the OS/2
program, including its multitasking capabilities .

Chapter 2 provides information to help customize your system to
meet your individual needs .

Chapter 3 contains material to assist in maximizing system
performance through process and memory management .

Chapter 4 explains OS/2 command symbols and gives
instructions for redirecting input and output on your system .

Chapter 5 furnishes information to aid in diagnosing system
problems .

Chapter 6 compares the differences between IBM DOS and DOS
mode of the OS/2 program .

Chapter 7 supplies data on creating and running batch files .

Chapter 8 provides information on editing and creating files with
the System Editor .

Appendix A contains key assignments for the System Editor .
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Appendix B contains explanations to messages that may be
displayed in DOS mode .

Appendix C includes an alphabetic listing of OS/2 commands .

Appendix D contains an alphabetic table of Procedures Language
2/REXX instructions and functions .
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Chapter 1 . About This Operating System

IBM* Operating System/2* (OS/2*) Standard Edition Version 1 .3 is a
program that controls the workings of your computing system . It
provides easy access to programs and information by allowing you to
state your computer requirements in terms that are easily
understood . This lets you complete your work quickly without having
to view the behind-the-scenes programming code that makes your
system function .

You can compare features of the OS/2 program to desktop materials
you would normally use in an office environment .

Figure 1 . Operating System12 - the Desktop Manager

For example, multiple windows on your screen are similar to pieces
of paper on a desktop . Like papers, windows can be stacked, so that
other windows are blocked from view . You can also cascade
(overlap) windows so that you can partially see the windows
underneath .

Because the OS/2 program allows you to view several windows at
one time, you don't need to remember or write down information
available from different sources . You can install desktop programs
that make a calendar, notepad, or telephone book just a touch away .

Trademark of IBM Corporation .
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Also, if you normally manage and maintain documents in a file
cabinet, you will feel comfortable using the File Manager . Let the File
Manager help you organize and control information . You can think of
directory icons ((]) as folders inside a file cabinet, and file icons (D)
as papers inside the folders .

The functions of the OS/2 program that you are probably most
familiar with are file-related activities such as creating, copying, or
erasing files . In addition to these tasks, OS/2 provides other
services. These services include allocating resources, scheduling,
protecting programs, and providing a suitable computing
environment in which to run your programs .

This book includes OS/2 topics such as multitasking capabilities,
memory management, and DOS compatibility . Also introduced are
several distinct features of the OS/2 program . One of these is the
System Editor, a program which provides text editing functions for
creating, editing, and managing files. Also explained are beneficial
ways to get the most from the OS/2 program by, for example,
customizing your system to maximize performance .
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Operating Modes
The OS/2 program provides the operating environments of OS/2
mode and DOS mode . Although each mode affects the processing of
programs and commands differently, most commands work in both
modes. There are, however, some commands that provide functions
specific to only one mode . Refer to the "Table of OS/2 Commands"
on page 211 for a list of OS/2 commands .

OS/2 mode
Commonly called protect mode, this multiprogramming
environment allows you to run several OS/2 programs at the
same time. This gives each program the potential of taking
advantage of available physical memory up to 16 megabytes
(MB) . OS/2 mode allows you to achieve a high level of
interaction with an OS/2 program . It permits you to run some
programs in interactive windows on your screen . At the same
time, you can run other programs in the background, away from
view. Your operating system also protects each program so that
it does not interfere with or change another program running at
the same time .

DOS mode
When using the OS/2 program, you may choose to use DOS
mode, an environment similar to IBM Disk Operating System
Version 4 .0. Unlike most programs in OS/2 mode, a program
running in DOS mode does not run in a window . Instead, it takes
over the entire screen and runs only in the foreground session .
You can, however, run a DOS mode program in the foreground
with several active OS/2 programs running in the background at
the same time .

Commonly called real mode, this mode allows you to continue
using DOS programs with your new operating system . You can
start DOS tasks or begin a DOS program almost as though you
were using DOS 4 .0. However, not all programs originally written
for a personal computer work properly in DOS mode (for
example, timing- and network-dependent programs) . Refer to
"DOS Mode Compatibility" on page 95 for program limitations
and answers to compatibility questions .
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Working with Input/Output (I/O)
Work begins when you enter input, or information, into your computer
system for processing . You do this by performing operations such as
typing on your keyboard, clicking a mouse button, or gathering data
from a disk. Work ends with output, the results of an operation .
Examples of output operations are displaying results on your screen,
storing information on a disk, or printing information on a printer .

9

4

9

/'Vµ

Figure 2. Input/Output (I/O) Devices

Depending on your type of system, the central processing unit (CPU)
processes I/O operations differently. A program in a single-tasking
system, such as IBM DOS, can perform only one I/O operation at a
time. The program working on an I/O request waits for the CPU to
return the result from an operation before the CPU can process other
information. In a multitasking system such as OS/2, however, many
programs can request I/O operations at the same time . OS/2 queues
these multiple requests and processes them each in turn .
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Multitasking with OS/2
The multitasking features of the OS/2 program allow you to process
many tasks (basic units of work) at the same time . OS/2 divides
processor time between multiple tasks . This gives the impression
that your programs, jobs, or files are running at the same time . By
sharing the system's resources among tasks, multitasking increases
productivity by reducing the time required to switch between
programs. It allows processing to take place in the background while
you are working on another task in the foreground .

The simplest example of multitasking is working with sessions,
running several tasks at the same time . For example, while you are
doing word processing in the foreground, recalculation of a
spreadsheet could be processing in the background . Moreover, OS/2
protects the information contained in each running program from
being changed by another program running at the same time .

Figure 3. Multitasking. Allows tasks to process in background windows
while you are working on another task in the foreground .
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Although many programs appear to be processing at the same time
when you view windows on your screen, the CPU carries out only one
task at a time . The processor sometimes waits for input or output
from a slower device (such as the keyboard or disk) . For this reason,
many program developers today design programs to create or control
one or more tasks . For more complex processing requirements,
developers can design a program so that its functions are divided
among a collection of cooperating processes and threads, as shown :

6 About This Operating System

Figure 4. Processes and Threads . A program can be designed as
separate processes, each consisting of many threads waiting to
be processed by the CPU .

Note: For information on processes and threads, refer to "Processes
and Threads" on page 10 .



For example, suppose you were developing a copy program . You
might decide to read data from one drive with one thread, while at the
same time, write to the other drive with another thread . This
maximizes system performance because programs use the
processor's time more productively .

Windows and Sessions
Each task or program you start runs in its own window, giving the
appearance that each task is running in a separate, protected
personal computer . Windows, called sessions, are protected
environments that allow many programs to coexist within the system,
and not interfere with one another . Because each OS/2 session runs
independently, changes you make in one session do not affect other
sessions. For example, setting a new path for an OS/2 session
affects only that OS/2 session ; it does not change paths to other
sessions .

The following screen represents two cascading windows :

DOS

DOS

	

Print Manager

Main

Group-Main

Introducing OS/2

Desktop Manager
Group View Desktop Help

Utilities

8

OS/2
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A session can be one of two types :

Foreground Session
You can work directly with this interactive session . It receives input
from your keyboard and mouse, or displays information on your
screen . In addition, the CPU gives the foreground session a higher
priority than a background session . This allows a program in the
foreground session to run faster, improving performance for this
session .

8 About This Operating System



Background Sessions
You cannot work directly with this session . Instead, this session
continues to run in the background, away from your view . Within
windows, background sessions share the display screen with the
foreground session . You cannot, however, interact with a background
session (such as typing on the keyboard) until you bring the job to the
foreground .

Programs can run unattended in background sessions, receiving
processor time as it becomes available . However, if a program in a
background session is awaiting further instruction, it stops running
and stays suspended until you either end the session or bring it to the
foreground .

When running a program in DOS mode, OS/2 suspends the program
when you switch it to the background . This is why DOS mode does
not support timing-dependent programs such as communications and
real-time programs. These programs have defined time constraints
in which the CPU must complete processing . If DOS isn't active (in
the foreground), the CPU does not complete processing within these
time constraints .

About This Operating System 9



Processes and Threads
Many tasks, such as those involving programs or files, can occupy
various windows of your screen at the same time . Besides viewing
and running these tasks at the same time, programs can also
simultaneously reside in memory, share memory, and alternate the
use of the CPU among them . Called multiprogramming, this process
is managed by a scheduler, which improves the overall efficiency of
the system by coordinating priority-based jobs going to the CPU .

One process manages many of the programs that you run . This
process is responsible for the mode, screen contents, and resources
used by the running program . Each process, or instance of program
operation, contains one or more threads, the most elementary units
in processing. Threads, dispatched on a priority basis, use processor
running cycles and share the resources of the process that created
them .

A time-slicing scheduler makes sure that threads of equal priority
receive an equal opportunity to process . Because threads use the
resources of the process, threads or processes running at the same
time must communicate with one another . Communication is
necessary to coordinate both their access to shared resources and
their order of running .

Although one process manages most programs, program developers
can design a more complex program as separate processes, or
multiple threads, within a single process . In this way, a complex
program can send more than one thread to use processor cycles,
thereby speeding up its performance. Then, when many programs
are running and occupying memory at the same time, the CPU can
switch between these processes . This makes your system more
productive .
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Figure 5. Processes and Threads . A program can be designed as
separate processes or multiple threads within a single process .

Note: For further information on processes and threads, refer to
"Process Management" on page 62 .
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Running OS/2 Programs

The three types of OS/2 programs that you can run in sessions are as
follows :

Presentation Manager

Presentation Manager* programs use full windowing capabilities .
These programs create one or more windows that make the
function of your program visible and easy to access . You can
monitor what other programs are doing and switch between
programs whenever required .

Windowed

Windowed programs have limited windowing capabilities i n
comparison to Presentation Manager programs. Instead of
creating one or more windows on the screen, OS/2 supplies this
type of program with a standard window that you can move and
size.

An example is the OS/2 windowed command prompt . If you
choose to run an OS/2 command prompt in a window, other
program windows remain visible on the screen . This
environment is well suited to text-based programs that can
operate in the background, such as compilers or editors . You can
then interact with another program in the foreground session .

Full-screen

Full-screen programs fill the entire screen . Although other
programs may be currently running, the full-screen program does
not share the display screen . You can access other running
programs by repeatedly pressing the Alt and Esc keys . You can
also switch to the Task List window to select a program by
pressing the Ctrl and Esc keys . It is possible for you to run
several full-screen programs at the same time you might be
running other programs in windows .

' Trademark of IBM Corporation .
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You can start and run several OS/2 programs at the same time by
selecting :

•

	

A program title listed in the Group-Main or Group-Utilities
window

•

	

A program file from the File Manager window, or

•

	

An OS/2 full-screen or window command prompt from the
Group-Main window, as shown :

Note: If you want to return to the Group-Main window, type EXIT at
the command prompt and press the Enter key .

An OS/2 program continues to run even if it is not visible . You can
run as many as 16 Presentation Manager programs, 16 windowed
programs, and 12 full-screen programs at the same time . However,
the actual number of sessions that you can start at the same time
depends on the amount of memory available in your system .
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OS/2 Command Processing
The OS/2 mode command processor, CMD .EXE, is a program that
interprets and runs commands. It reads the type of program you
enter into the system and tries to determine what action to take . The
information that came with your program should describe its program
type. If it does not and you choose the default option, the OS/2
command processor attempts to run the program in the session for
which the program was designed . If the program information does
not contain the program type, it starts the program as a full-screen
program .

During batch processing, CMD.EXE allows you to specify the
extension of a file or program . If you do not specify an extension, or
if CM D . EXE does not find the file including the extension, the
processor searches for a COM extension, an EXE extension, and
lastly, a CMD extension. CMD.EXE adds the default extensions to
the end of the path and file name you typed . The OS/2 command
operator does not replace the extension as it did in the previous
versions. CMD.EXE leaves in place any extension that you might
have already typed . For example, if you type a file named ABC.EXE
at the command prompt, the search order is :

ABC. EXE
ABC.EXE.COM
ABC.EXE.EXE
ABC.EXE.CMD

OS/2 batch files (files with .CMD extensions), entered at the OS/2
command prompt or processed by OS/2, run in windows by default .
However, if you use the following START command parameters :

/WIN (windowed)
/FS (full-screen)
/PM (Presentation Manager)

you can force a program to run in a certain type of session. Make
sure that your program is capable of running in the session you
choose. You can also use the START command in a special batch file
named STARTUP.CMD to begin programs in additional OS/2
sessions. This file begins a process automatically when you start
OS/2. Refer to page 111 for further information on STARTUP .CMD .
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Running DOS Programs
The OS/2 program provides DOS mode so that you can run a single
DOS program in the foreground session while running OS/2 programs
in the background . OS/2, however, limits the DOS programs you want
processed to 640KB. They can run only within the first megabyte of
system storage .

The following are ways to enter DOS mode from Presentation
Manager:

•

	

Press the Alt and Esc keys enough times, depending on how
many programs are running .

•

	

From the Task List window, double-click on DOS, or select it and
press the Enter key .

•

	

Double-click on the DOS mode icon, as shown :

DOS,

Note: Once your program completes, press the Ctrl and Esc keys to
display the Task List window.

You can start only one DOS prompt to enter a command or begin a
DOS program. This is because only one DOS command processor
can process a command or program at a time . Also, because a DOS
program requires the entire screen in the foreground session, it
cannot take advantage of OS/2 windowing . The CPU only processes
the program when it displays on your screen .

Suppose for example that you are working with a DOS program and
return to the Presentation Manager . The DOS program stops running
and only begins running again when you return to the DOS session .
(If the DOS program is keeping track of the time of day by counting
clock ticks, the program may have an incorrect time when it
resumes .)
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Many existing programs written for IBM DOS can run in DOS mode .
Programs that may not run in DOS mode include :

•

	

Timing-dependent programs
such as communications and real-time programs .

•

	

Hardware-specific routines
such as device drivers and plotter programs .

•

	

Network-dependent programs .

When a program is running under IBM DOS, it is the only task that the
system can process at that time . The only other tasks that share the
processor are background jobs, such as print spoolers or network
message retrievers .

In OS/2, several programs can process in background OS/2 sessions
while the DOS session is operating in the foreground. This means the
behavior of a DOS program may change somewhat when there are
many OS/2 programs running in the background . To ensure greater
compatibility while running programs in the DOS session, make sure
that no OS/2 programs are running in the background .

Notes :

1 . Refer to "DOS Mode Compatibility" on page 95 for further
information on running DOS programs .

2. To display the amount of fixed disk space available, use the
CHKDSK command while in DOS mode. Refer to the OS/2
Command Reference for more information on CHKDSK .
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Chapter 2. Customized Installation

There are many choices you can make to customize this multitasking,
virtual memory operating system . This chapter describes ways to set
up your system by making choices based on your computer type and
the tasks you want to perform . This chapter also describes options
available after you install the OS/2 program .

Configuring OS/2
During installation, the OS/2 program adds a CONFIG .SYS file in the
root directory of your system . This single CONFIG .SYS file, which
contains command statements that set up your system, configures the
system for both DOS and OS/2 modes . Each time you start your
system, the OS/2 program searches the root directory of the drive
where you started the operating system for a file named
CONFIG.SYS. When it finds the file, the OS/2 program reads the file
and interprets the statements .

Reconfiguring OS/2
If you change certain statements in your CONFIG .SYS file after
installation, your system might not be able to restart . This is because
the operating system requires certain statements i n CONFIG .SYS that
inform the system of the location of files that do not exist in the root
directory of the startup drive .

Statements Required to Restart Your System
The following statements are required in the CONFIG .SYS file to
restart your system . Parameters are based on your system setup .

SET PATH =C :\OS2 ;C :\OS2\SYSTEM ;C :\OS2\INSTALL ; C :\ ;
LIBPATH=C :\OS2\DLL ;C :\ ;
COUNTRY=0UI,C :\OS2\SYSTEM\COUNTRY .SYS
DEVICE=C :\OS2\PMDD .SYS

Configuring DOS Mode
Although the CONFIG .SYS file configures the system for both DOS
and OS/2 modes, some statements pertain only to DOS mode and are
ignored in OS/2 mode . The following commands apply only to DOS
mode and then only if the PROTECTONLY =NO statement is present
in the CONFIG .SYS file. Refer to the PROTECTONLY command on
page 70 for a description of its use .
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BREAK
Allows you to instruct DOS to check if you have pressed the Ctrl
and Break keys together when a program requests OS/2 to
perform any functions .

FCBS
Determines file control block management information for the
DOS environment. A file control block (FCB) is a record that
contains all the information about a file (for example, its
structure, length, and name) .

RMSIZE
Specifies the highest storage address allowed for the DOS
operating environment. If RMSIZE is less than 640KB, OS/2
programs can use the remaining memory up to 640KB .

SHELL
Specifies the path name of the top-level command processor that
OS/2 loads in DOS mode. (Usually DOS mode requires the
default file named COMMAND.COM .)

Note: OS/2 ignores the DOS commands FILES and LASTDRIVE .

Changing CONFIG.SYS
The statements placed in the CONFIG.SYS file provide initial values
to maximize performance for your particular system . Your operating
system uses these values when you do not specify a value, but you
can change them at any time . One reason to change the statements
in the CONFIG.SYS file would be if the information that came with
your programs recommends special values .

If you decide to change your CONFIG .SYS file after you install OS/2,
you can either reuse the installation program and add, change, or
delete command statements, or use an editor . If a CONFIG .SYS file
already existed on your system before you installed OS/2 Version 1 .3,
the installation program renames the old CONFIG .SYS file to
CONFIG .BAK . This is so that the existing CONFIG .SYS file remains
intact under the backup ( .BAK) name . You can then, if you choose,
combine the command statements from the two files . Also, in case
the CONFIG .SYS file becomes damaged, system installation
automatically creates a backup copy of CONFIG .SYS . (Refer to page
93 for the recovery procedure .)

In most cases, you probably would not want to repeat the entire
installation process to make a few changes in the CONFIG.SYS file .
However, you might consider rerunning the installation program if
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you have to change interrelated or device-dependent statements in
the CONFIG .SYS file .

For example, assume you did not start code page switching during
system installation and you now want to use this feature . By
reinstalling the OS/2 program, you can let the installation program
set up the interrelated DEVINFO, COUNTRY, and CODEPAGE
statements in CONFIG .SYS for you . It uses the information provided
by your responses to construct the appropriate statements for your
CONFIG .SYS file. If you do decide to change your CONFIG .SYS file by
reinstalling the system, refer to "Installing OS/2" i n Getting Started .

On the following page is an example of what you might find in your
CONFIG .SYS file if you install OS/2 selecting the defaults on an IBM
PS/2* Model 60 with an attached IBM Personal System/2* mouse .
Keep in mind that OS/2 reads CONFIG .SYS only during system
startup . Changes to the file do not take effect until you restart the
system .

Note: You can specify the following statements multiple times in
your CONFIG .SYS file. If you specify any of the following
statements more than once, OS/2 uses the last correct
statement. Keep in mind that since some device drivers, such
as MOUSE .SYS, POINTDD .SYS, and COMOx.SYS, have
interdependences, these statements are processed in the
order you specify .

DEVICE
DEVINFO
IOPL (list only)
REM
RUN
SET
TRACE

Trademark of IBM Corporation
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Note : Refer to the OS/2 Command Reference for the syntax of the
command, associated parameters, and examples .

Adding Device Drivers to CONFIG .SYS
A device driver defines the interface between the operating system or
its programs and the hardware device (for example, between the
keyboard and the display) .

Note: For information on adding a printer or plotter to your system,
refer to "Setting Up a Printer or Plotter" on page 34 .

You can replace device drivers or add other devices by placing
DEVICE statements in the CONFIG .SYS file. The DEVICE statement
specifies the path and complete file name of the device driver in your
CONFIG.SYS file. Once you have added the DEVICE statement to the
CONFIG.SYS file, you must restart the system before the device
driver operates . The OS/2 program processes DEVICE statements in
the order in which they appear in the CONFIG .SYS file .
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OS/2 System Editor - C:\CONFIG .SYS
File £dit Options Help

C :\OS2\CMD .EXE
SET COMSPEC=C :\OS2\CMD .EXE
LIBPATH=C:\OS2\DLL ;C :\ ;

SET PROMPT=$i[$p]
SET HELP=C :\OS2\HELP
BUFFERS=30
DISKCACHE=64
MAXWAIT=3
MEMrIAN=SWAP,MOVE,SWAPDOS
PROTECTONLY=NO
SWAPPATH=C :\OS2\SYSTEM
THREADS=128

DEVICE=C :\0S2\POINTDD .SYS
DEVICE=C :\0S2\IBtM40002 .SYS
DEVICE=C :\OS2\MOUSE .SYS
DEVICE=C :\OS2\PMDD .SYS
SET KEYS=ON
SET BOOKSHELF=C :\OS2\BOOK
SHELL=C :\OS2\COMMAND .COM
BREAK=OFF
FCBS=16,8
RMSIZE=640
DEVICE=C :\0S2\EGA .SYS
DEVICE=C :\0S2\DOS .SYS

PROTSHELL=C :\OS2\PMSHELL .EXE

SET PATH=C :\OS2 ;C :\OS2\SYSTEM ;C :\OS2\INSTALL ;C :\ ;
SET DPATH=C :\OS2 ;C :\OS2\SYSTEM ;C :\OS2\INSTALL ;C :\ ;

COUNTRY=001, C :\OS2\SYSTEM\COUNTRY .SYS
DEVINFO=SCR,VGA,C:\OS2\VIOTBL .DCP
SET VIDEO_DEVICES=VIO_IBMVGA
SET VIO_IBMVGA=DEVICE(BVHVGA)

C :\OS2\OS2 .INI C:\OS2SYS .INI

512

TYPE: IBMNOU$

/P
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The OS/2 diskettes contain the following device drivers. To use these
device drivers, add DEVICE statements in the CONFIG .SYS file .

Device Driver Purpose

ANSI.SYS

COMOx.SYS

EGA.SYS

EXTDSKDD.SYS

MOUSE.SYS

PM DD.SYS

POINTDD.SYS

VDISK.SYS

XGARINGO.SYS

Allows extended screen and keyboard support in
DOS mode .

Allows OS/2 serial communication programs or
system programs such as SPOOL to use serial
devices .

Allows DOS programs that require Enhanced
Graphics Adapter support to be run .

Allows access to an external diskette drive by
referencing a logical drive letter .

Implements support for pointing devices .

Provides pointer draw device driver support for
the Presentation Manager .

Provides mouse pointer draw support .

Installs a simulated disk called a virtual disk .

Provides device driver support for the Extended
Graphics Array; used with the Presentation
Manager XGA display driver .

Note: For further information on these device drivers, refer to the
DEVICE command in the OS/2 Command Reference .

OS/2 and its device drivers manage attached devices for programs
that run in both the OS/2 and DOS environments. OS/2 device drivers
can process requests from either DOS or OS/2 programs . You also
start DOS device drivers when you start your system, but they can
process requests only from DOS programs .

In OS/2 mode, there are also special drivers called presentation
drivers that service requests from programs running in Presentation
Manager sessions . These drivers add additional subsystem support
for printers, plotters, and video screens .

The standard presentation drivers that support the keyboard, display,
printer, diskette drive, fixed disk, and clock devices were added to
CONFIG.SYS when you installed the OS/2 program ; therefore it is
unnecessary for you to add these device drivers to the CONFIG .SYS
file with DEVICE statements .
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When installed, OS/2 provides an automated way to install new
device drivers (except presentation drivers) without using the
installation program . Refer to the DDINSTAL command in the OS/2
Command Reference for further information .

Changing AUTOEXEC.BAT
The first time you select the DOS command prompt from the
Presentation Manager, the DOS command processor,
COMMAND.COM, automatically processes a batch file named
AUTOEXEC.BAT in the root directory of the startup drive . Similar to
the CONFIG.SYS file, AUTOEXEC.BAT is created for you during
system installation . It is useful if you want to run commands in DOS
mode, set a path, or process another program or batch file . After you
have installed OS/2 on your fixed disk, the following is an example of
what you might find i n the AUTOEXEC . BAT file :

DOS

DOS

8
Print Manager
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OS/2 System Editor - C . \AUTMTC .BAT

	

V A

File Edit Qptions Help

PATH C :\0S2 ;C :\0S2\SYSTEM
APPEND C:\0S2 ;C :\0S2\SYSTEM
SET COMSPEC=C :\0S2\COWAND.COM
CALL HELP ON

4

i



Definitions of the command statements are as follows :

PATH
Searches the specified directories for program files that OS/2
cannot find by searching the current directory .

APPEND
Establishes a path for your system to search for data files outside
the current directory .

SET
Sets one string in the environment equal to another string for
later use in programs . For example,

SET COMSPEC=C :\OS2\COMMAND .COM

sets a search path for the COMSPEC environment variable to the
subdirectory where OS/2 placed the DOS command processor .

CALL
Allows a batch file to be called from within another batch file
without ending the first batch file . For example :

CALL HELP ON

displays a help line as a part of the command prompt .

Note: For further information on batch files, including the
AUTOEXEC.BAT file, refer to "Creating and Using Procedures
Language 2/REXX and Batch Files" on page 106 .
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Updating Support for Your Display Adapter
If you change your display and adapter after you have installed the
OS/2 program, you must also change the display adapter support on
your system. You can either reinstall the OS/2 program or update
Presentation Manager display adapter support . To change display
adapter support, follow these steps :

1 . Select the correct combination of DLL and SYS files that support
your display adapter :

2. Turn on your system .

Trademark of IBM Corporation .

24 Customized Installation

IBMCGA.DLL
BVHCGA.DLL

IBM Color Graphics Adapter

IBMCGA.DLL
BVHEGA.DLL

IBM Enhanced Graphics Adapter
with 64KB of graphics memory

IBMEGA.DLL
BVHEGA.DLL

IBM Enhanced Graphics Adapter with
greater than 64KB of graphics memory

IBMVGA.DLL
BVHVGA.DLL

IBM Personal System/2 Video Graphics Array

IBMVGA.DLL
BVHVGA.DLL

IBM Personal Computer AT* or an IBM PC XT*
Model 286 with an IBM Personal System/2 Display
Adapter

IBMVGA.DLL
BVHVGA.DLL
BVH8514A.DLL

IBM Personal System/2 8514/A

IBMBGA.DLL
BVHVGA.DLL
BVH8514A.DLL

IBM Personal System/2 8514/A
with memory expansion

IBMVGA.DLL
BVHMPA.DLL

IBM Personal Computer AT or an IBM PC XT Model
286 with a PS/2 Display Adapter and a PS/2
Monochrome Display

BVHMPA.DLL IBM Personal Computer AT with a Monochrome
Adapter

IBMXGA.DLL
BVHVGA.DLL
BVHXGA.DLL
XGARINGO.SYS

IBM Personal System/2 Extended Graphics Array



3 . Edit the CONFIG.SYS file using an editor such as the System
Editor.

4. Type and save the appropriate statements in your CONFIG .SYS
file using the correct files from the table in step 1 and these
parameters :

DEVINFO=SCR,xxx,C :\0S2\VIOTBL .DCP
SET VIDEO DEVICES=VIO_IBMxxx, VIO_IBMxxx
SET VIO_IBMxxx=DEVICE(BVHxxx,BVHxxx)
DEVICE xxx .SYS

Note: Depending on your particular adapter type, the second
VIO xxx and BVHxxx files and the DEVICE= statement might
be optional . This is because for every VIO_IBMxxx file
attached to the SET VIDEO DEVICES= statement, there must
be a corresponding SET V I O I BMxxx= statement. All
display adapters do not require a DEVICE= statement .

For example, if you have a Color Graphics Adapter, type :

DEVINFO=SCR,CGA,C :\0S2\VIOTBL .DCP
SET VIDEO_DEVICES=VIO_IBMCGA
SET VIO_IBMCGA=DEVICE(BVHCGA)

•

	

If your system has only one display and it is attached to the
8514/A adapter, type :

DEVINFO=SCR,BGA,C :\0S2\VIOTBL .DCP
SET VIDEO_DEVICES=VIO_IBM8514A
SET VIO_IBM8514A=DEVICE(BVHVGA,BVH8514A)

•

	

If you are installing an 8514/A adapter and have two displays
attached to your system, type :

DEVINFO=SCR,BGA,C :\0S2\VIOTBL .DCP
SET VIDEO DEVICES=VIO_IBMVGA, VIO_IBM8514A
SET VIO_IBMVGA=DEVICE(BVHVGA)
SET VIO IBM8514A=DEVICE(BVH8514A)

•

	

If you are installing a Personal System/2 Extended Graphics
Array adapter to your system, type :

DEVINFO=SCR,VGA,C :\OS2\VIOTBL .DCP
SET VIDEO DEVICES=VIO IBMXWY
SET VIO IBMXWY=DEVICE(BVHVGA,BVHXGA)
DEVICE=C :\OS2\XGARINGO .SYS

•

	

If you are adding a high resolution display, insert OS/2
diskette 5 .
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a . Enter the following, substituting the correct files from the
table in step 1, to rename the support files :

UNPACK A:IBMnxx .DL@ C :\OS2\DLL
UNPACK A :BVHxxx .DL@ C :\OS2\DLL

Note: If you are installing a monochrome adapter on an
IBM Personal Computer AT, there is no IBMxxx .DLL
file to unpack.

For example, enter the following for an 8514/A adapter
with memory expansion :

UNPACK A :IBMBGA .DL@ C :\OS2\DLL
UNPACK A :BVHVGA .DL@ C :\OS2\DLL
UNPACK A :BVH8514A .DL@ C :\OS2\DLL

For a Personal System/2 Extended Graphics Array :

UNPACK A :IBMXGA .DL@ C :\OS2\DLL
UNPACK A :BVHVGA .DL@ C :\OS2\DLL
UNPACK A :BVHXGA .DL@ C :\OS2\DLL
UNPACK A :XGARINGO .SY@ C :\OS2

b. Remove OS/2 diskette 5 from drive A .

5. Insert the OS/2 Installation diskette in drive A ; then, press and
hold the Ctrl, Alt, and Del keys together to restart the system .

6. Press the Esc key when OS/2 displays the IBM logo .

7. Enter the following to change to drive C :

C •

8. Enter the following to change to the DLL subdirectory :

CD \0S2\DLL

9 . To copy the support file, enter the following substituting the
correct file i n step 1 :

COPY \IBMxxx .DLL DISPLAY .DLL

Note: If you are installing a monochrome adapter on an IBM
Personal Computer AT, there is no IBMxxx .DLL file to copy
to DISPLAY . DLL because you cannot run Presentation
Manager on a monochrome display .

For example, enter the following for an 8514/A adapter with
memory expansion :

COPY IBMBGA .DLL DISPLAY .DLL
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10 . Turn the system off, and add the physical adapter you want to
install .

11 . Turn the system on to update the adapter support on your system .

Extended Graphics Array Features
The IBM Personal System/2 Extended Graphics Array (XGA) OS/2
Presentation Manager display driver operates in one of two screen
resolutions, depending on the amount of video memory your system
has. For example :

•

	

If your system has 1MB of video memory (8 Video RAM modules
installed), no options are needed . Your system will run at high
resolution (displaying 1024x768 pixels on the screen) and can
also display up to 256 different colors .

•

	

If your system has 0.5MB of video memory (only 4 Video RAM
modules installed), you can choose to operate at either :

High resolution (1024x768 pixels) with the ability to display up
to 16 colors simultaneously, but without the ability to use
anti-aliased text; or

Medium resolution (640x480 pixels) with the ability to display
up to 256 colors simultaneously, and the ability to use
anti-aliased text .

If your system has 0.5MB of video memory, the first time you start
OS/2, high resolution (1024x768 pixels) with 16 colors is selected .
You can change to medium resolution (640x480 pixels) with 256 colors
by running the XGASETUP program . This program is distributed on the
diskettes that accompanied your Personal System/2 system unit or
Personal System/2 Extended Graphics Array adapter card . For
further information, refer to the READ .ME file on this diskette. Note that
the XGASETUP program is not available from the OS/2 Desktop
Manager with OS/2 Version 1 .3 .

The IBM Personal System/2 Extended Graphics Array (XGA) OS/2
Presentation Manager display driver also supports anti-aliased text,
which offers improved appearance and readability of text displayed
on CRT display screens .

Anti-aliased text is available on systems that support 256 colors as
follows :

•

	

If your system has 0.5MB of video memory, and you configure it
as high resolution (1024x768 pixels) with 16 colors, anti-aliased
text is not available .
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• If your system has 0.5MB of video memory, and you configure it
as medium resolution (640x480 pixels) with 256 colors,
anti-aliased text Is available .

•

	

If your system has 1 MB of video memory, anti-aliased text Is
available .

The anti-aliased text fonts are distributed on the diskettes that
accompanied your Personal System/2 system unit or Personal
System/2 Extended Graphics Array adapter card . To install
anti-aliased text fonts on your system, create the following directory :

C :\OS2\DDFONTS

If you want to select an anti-aliased system font, copy all files with a
.FNT extension from the Personal System/2 diskette to the new
directory DDFONTS . Then run the SYSFONT.EXE program, which is
also on the Personal System/2 diskette . Note that the SYSFONT
program is not available from the OS/2 Desktop Manager with OS/2
Version 1 .3. Refer to the READ.ME file on the Personal System/2
diskette for more information on anti-aliased fonts .

Selecting Options After Installation

After you have installed the OS/2 program, you can reinstall it or you
can add selectable options. Follow the initial installation instructions
as described in the Getting Started book. The Refresh Installation
Configuration panel provides two choices :

Reinstalling the Operating System: If you choose this option, OS/2
installation does not format the fixed disk partition . It adds operating
system files to the files that already exist on your fixed disk. Your
current files remain intact .

Adding Selectable Operating-System Options:
following configuration options :

•

	

Country Information
•

	

Documentation
•

	

Fonts
•

	

High Performance File System
•

	

Optional System Utilities
•

	

OS/2 DOS Environment
•

	

Picture Utilities
•

	

Serial Device Support
•

	

Serviceability and Diagnostic Aids .
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For further information on Selecting System Configuration, see
"Selecting System Installation Options" in the Getting Started book.

Adding the OS/2 Command Reference After Installation
To install the OS/2 Command Reference after you have installed the
OS/2 program, select the Documentation option under Adding
Selectable Operating System Options . The system will install the
OS/2 Command Reference for you .

When the reinstallation is complete, you will need to restart your
system by pressing the Ctrl, Alt, and Del keys together . The OS/2
Command Reference is added to the Group-Main window .

Accessing the OS/2 Command Reference : From the Group-Main
window, double-click on OS/2 Command Reference, or select it and
press the Enter key .

Note: If you want to add the OS/2 Command Reference to the
Group-Utilities window, refer to "Adding Program Titles to a
Program Group Window" i n the Getting Started book.

Adding a Mouse After Installation

To add a mouse after installation without having to re-install the OS/2
program, follow these steps:

Note: All statements for serial mouse device drivers must precede
any COMOx.SYS statements in the CONFIG.SYS file .

1 . To provide mouse pointer draw support for the mouse types listed
below, edit the CONFIG .SYS file and enter :

DEVICE=C :\0S2\POINTDD .SYS

2. Enter the DEVICE statement listed below in your CONFIG .SYS
file, using only the parameters that are appropriate for your
particular system and mouse .
(The SERIAL=COMx and MODELxxx parameters are optional .)

DEVICE=C :\0S2\filename SERIAL=COMx MODELxxx
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• Substitute these parameters if you have an IBM Personal
Computer AT, IBM PC XT Model 286, IBM PS/2 Model 25 286,
or IBM PS/2 Model 30 286 :

filename

	

Specifies the complete name of the file
containing the mouse device driver . Use :

IBMM0001 .SYS

	

IBM Personal System/2 Mouse

MSBUS01 .SYS

	

Microsoft" Bus Mouse

MSINP01 .SYS

	

Microsoft In-Port Mouse
Microsoft Mouse with Bus Interface

MSSERO1 .SYS

	

Microsoft Serial Mouse
Microsoft Mouse with Serial Interface

MSPS201 .SYS

	

Microsoft Mouse with PS/2 Interface

PCMOUO1 .SYS

	

PC Mouse Systems**

VISION01 .SYS

	

Visi-On**

SERIAL=COMx Specifies the serial communications port
connected to the mouse device driver .
Use :

1

	

First COM port (default)

2

	

Second COM port

Note: This parameter is not valid for the IBM Personal
System/2 Mouse, Microsoft Mouse with Bus Interface,
or Microsoft In-Port Mouse .

" Microsoft is a trademark of Microsoft Corporation . PC Mouse Systems is a
trademark of Metagraphic/Mouse System . Visi-On is a trademark of VisiCorp .
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MODEL xxx

	

Specifies the model number for the mouse .
Use :

099 or 199 Microsoft Serial Mouse, Microsoft Bus
Mouse, or Microsoft Mouse with Serial
Interface

Note: This parameter is only applicable to the above mice .

•

	

Substitute these parameters if you have a model of the IBM
Personal System/2 other than Model 25 286 or Model 30 286 :

filename

	

Specifies the complete name of the file
containing the mouse device driver . Use:

IBMM0002.SYS

	

IBM Personal System/2 Mouse

MSSER02.SYS

	

Microsoft Serial Mouse
Microsoft Mouse with Serial Interface

PCM0002.SYS

	

PC Mouse Systems

VISION02.SYS

	

Visi-On

MSPS202.SYS

	

Microsoft Mouse with PS/2 Interface

SERIAL COMx Specifies the serial communications port
connected to the mouse device driver .
Use :

1 through 8

	

Communication ports
(COM1 - default)

Note: This parameter is not valid for the IBM Personal
System/2 Mouse (IBMM0002.SYS) .

MODEL xxx

	

Specifies the model number for the mouse .
Use :

099 or 199

	

Microsoft Serial Mouse
Microsoft Mouse with Serial Interface

Note: This parameter is only applicable to the above mice .
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3 . Enter a second DEVICE statement in your CONFIG .SYS file, using
only the parameters appropriate for your system and mouse .

DEVICE=C :\OS2\MOUSE .SYS MODE=m QSIZE=q TYPE=name

Note: The MODE=m and QSIZE=q parameters are optional .

MODE = m

	

Specifies the mode that the mouse device
driver supports . Use :

P OS/2 mode only

R DOS mode only

B

	

Both (default)

QSIZE = q

	

Specifies the length of the queue for events to
be used for all OS/2 mode tasks . Use :

1 - 100

	

Event records (defau It = 10)

TYPE = name

	

Specifies the name of the device driver
handling the hardware . Use :

IBMMOU$

	

IBM Personal System/2 Mouse

MSSER$

	

Microsoft Serial Mouse
Microsoft Mouse with Serial Interface

MSINP$

	

Microsoft In-Port Mouse
Microsoft Mouse with Bus Interface

MSPS2$

	

Microsoft Mouse with PS/2 Interface

PCMOU$

	

PC Mouse Systems

VISION$

	

Visi-On

4. Restart the system by pressing the Ctrl, Alt, and Del keys
together .

If, for example, you want to install an IBM Personal System/2 mouse
on a PS/2 model (other than Model 25 286 or Model 30 286), enter the
following in CONFIG .SYS :

DEVICE=C :\OS2\POINTDD .SYS
DEVICE=C :\OS2\IBMMOUU2 .SYS
DEVICE=C :\OS2\MOUSE .SYS TYPE=IBMMOU$
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Instead, if you want to install a Microsoft mouse with a serial
interface on an IBM Personal System/2 (other than Model 25 286 or
Model 30 286) using communications (COM) port 2 in OS/2 mode,
enter :

DEVICE=C :\OS2\POINTDD .SYS
DEVICE=C :\OS2\MSSERU2 .SYS SERIAL=COM2 MODEL=199
DEVICE=C :\OS2\MOUSE .SYS TYPE=MSSER$ MODE=P QSIZE=15
DEVICE=C :\OS2\COMU2 .SYS

When you start your system, OS/2 loads the mouse device driver
using COM2 port, leaving the COM1 and COM3 ports available for the
COM02.SYS device driver. As the COM02 .SYS device driver installs,
a message tells you that OS/2 could not locate the device adapter ; the
device adapter is not available because the mouse claimed the port .
You must enter the COMOx.SYS statement after the mouse statements
so that the mouse can gain access to the COM port .
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Setting Up a Printer or Plotter

To attach a new printer or plotter, you first need to set up printer
support on your system before creating or setting up queues . For
example, you must :

•

	

Add a printer driver

Printer drivers are device drivers that provide hardware-specific
information about a particular printer or plotter. The instructions
that came with your printer should describe whether it is serial or
parallel . The system needs this information to use the device .

•

	

Add a printer name ; then, connect it to a port and a printer driver
•

	

Add a queue name

•

	

Change your printer driver settings .

Before you add a printer to your system, you need to determine its
type. Once you know your printer type, follow the instructions for
your particular printer or plotter . Keep in mind that you can set up
several printer drivers that support the same printer .
Note: Make sure that you have attached your printer cable to the

correct port on the back of your computer. Connect a parallel
printer to any parallel port; connect a serial printer to a COM
(communications) port .

You can use the Printer install choice in the Setup pulldown from the
Print Manager, or the Control Panel and Print Manager to set up your
new printer or plotter .

Note: Using the Printer install choice is the recommended procedure
because it is the easiest, most efficient method .

For more information about printing, refer to OS/2 Version 1 .3 Volume
2: Print Subsystem (GG24-3631) .
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The following tables indicate where each procedure needed to set up
a printer or plotter on your system is located in this chapter :

Using the Printer Install Choice

Procedure : Page

Once you have completed these tasks, you have the choice of taking
optional actions such as changing your default printer or queue . If
you are installing a serial device, you might also want to set it up for
base printing (refer to page 49) .
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Adding printers, printer drivers, and queues 36

Using the Control Panel and the Print Manager

Procedure:
Displaying the Control Panel

Page

37
Adding a parallel printer driver 38
Adding a serial printer or plotter driver 40
Deleting a printer driver 41
Adding a queue driver 42
Deleting a queue driver 42

Displaying the Print Manager 43
Adding, changing, or deleting printer names 44
Connecting printer names with ports 45
Connecting printer drivers to a printer 45
Adding, changing, or deleting queue names 46

Using the Print Manager

Procedure: Page
Displaying the Print Manager 43
Changing default printers and queues 47
Changing printer driver settings 47
Setting up a serial device for base printing 49
Changing printer response time 50



Using the Printer Install Choice
With the Printer Install choice in the Setup pulldown from Print
Manager, you can install device drivers that contain single and
multiple files, printers, and queues all at the same time .

Note: You also can use the Control Panel and Print Manager to
install a printer or plotter as described later in this chapter.
However, using the Printer Install choice is recommended .

To use the Printer install choice :

1 . Double-click on 9 , or press the Ctrl and Esc keys to select Print
Manager from the Task List window, and press the Enter key .

2. Click on Setup, or select it and press the Enter key .
3. Click on Printer install, or select it and press the Enter key . Do

one of the following :

•

	

If you have not installed a printer on your system before, the
New Printer Driver Location window is displayed .

Insert the device drivers diskette that contains the printer
driver into drive A . If your printer driver program files are in
a directory on your fixed disk instead of on a diskette, type
the correct drive and directory name in the entry field . Do not
type the file name .

•

	

If you have installed a printer on your system before, then the
Printer Installer window is displayed .
Note: If you are changing settings, refer to printer and

plotter considerations in the READMEDD .DAT file
located on the Device Drivers diskettes .

Click on the New pushbutton in the Printer Installer window to
display the New Printer Driver Location window . Then insert
the device drivers diskette that contains the printer driver into
drive A . If your printer driver program files are in a directory
on your fixed disk instead of on a diskette, type the correct
drive and directory name in the entry field . Do not type the
file name .

If you want additional information on installing a printer (for
example, if you want to know more about changing default
options), press the F1 key or select the Help pushbutton when the
Printer Installer window is displayed. Note that any
customization information from a previous default printer will not
apply to the new default printer .
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4. Click on the Ok pushbutton, or select it and press the Enter key .

The New Printer Driver Model window is displayed with a list of
available printer drivers .

5. Select the driver that corresponds with the printer you are
installing; then click on the Ok pushbutton, or select it and press
the Enter key .

The Printer Installer window is displayed .

6. To accept the defaults displayed in the Printer Installer window,
click on the Ok pushbutton, or select it and press the Enter key .

Note: You can change the default fields to correspond with the
printer you are installing ; then click on the Ok pushbutton,
or select it and press the Enter key .

The Create Printer window is displayed . Then a window with the
name of your printer driver is displayed .

7. To accept the defaults, click on the Enter pushbutton, or make the
appropriate changes and then click on the Enter pushbutton .

The Printer Created window appears . The printer driver, printer,
queue driver and queue are now installed .

Using the Control Panel
You can use the Control Panel to select choices to set up system
preferences that act across the system . The Control Panel contains
system settings, such as display and file options, in a file called
OS2.INl located in the \OS2 directory of your fixed disk. You can
install a maximum of nine device drivers using the Control Panel .
This does not include device drivers you have installed by adding
statements to the CONFIG .SYS file. The instructions that follow are
used to install a single printer driver using the Control Panel .

Note: If you want to install multiple-file printer device drivers, the
Printer install choice provides the easiest way to do this .

1 . Press the Ctrl and Esc keys to view the Task List window .

2. Double-click on Desktop Manager, or select it and press the Enter
key .

3. Double-click on Utilities, or select it and press the Enter key .

4. Double-click on Control Panel, or select it and press the Enter
key .

The Control Panel window is displayed .
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When you are ready to close the Control Panel window, select Exit
from the Options pull-down . You may also select Close from the
System Menu located in the pull-down in the upper left-hand corner of
the window .

Adding a Parallel Printer Driver
To add a parallel printer driver, follow these steps :

1 . From the Control Panel, click on Installation, or select it and
press the Enter key .

2. Click on Add printer driver, or select it and press the Enter key .
3. Insert into drive A the Device Drivers diskette containing the

printer driver .

If your printer driver programs are in a directory on your fixed
disk instead of on a diskette, type the correct drive and directory
name in the entry field . Do not type the file name .

4. To display the names of the printer drivers, click on Add, or press
the Enter key .

Wait until the names of the printer drivers appear in the Add
Printer Driver window .
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5 . Click on or select the printer driver name for the printer you are
installing .

You may select more than one printer driver in a directory to
install at once .

6. Copy the printer driver to another directory or to the C :\OS2\DLL
directory .

7. Click on Add, or press the Enter key .

Note: To complete installation of your parallel printer, refer to
"Using the Control Panel and the Print Manager" on page 35 to
locate the procedures you want to use, and continue .

Customized Installation 39



Adding a Serial Printer or Plotter Driver
Follow these steps to add a serial printer driver. (If you selected the
option of Serial Device Support during system installation, begin this
procedure with step 3. You can bypass steps 1 and 2 because the
OS/2 installation program automatically sets up the DEVICE
statements in the CONFIG .SYS file for you .)

1 . Edit the CONFIG .SYS file (located in the root directory) using an
editor such as the System Editor .

Note: A backup copy of the CONFIG .SYS file is located in the
C:\OS2\INSTALL directory . Refer to page 93 for the
recovery procedure if you run into any difficulty .

2. Choosing from the following statements, type the appropriate
DEVICE statement in your CONFIG .SYS file :

•

	

If you have a Personal Computer AT, Personal Computer XT
Model 286, PS/2 Model 25 286, or PS/2 Model 30 286, type :

DEVICE=C :\0S2\COMO1 .SYS

This device driver supports ports COM 1 and COM2 .

•

	

If you have an IBM Personal System/2 other than Model 25
286 or Model 30 286, type :

DEVICE=C :\0S2\COM02 .SYS

This device driver supports ports COM1, COM2, and COM3 .

Note: if you already have a DEVICE statement that supports a
printer driver at serial ports COM1 through COM3, the port
is unavailable to the COMOx .SYS device driver .

3. From the Control Panel, click on Installation, or select it and
press the Enter key .

4. Click on Add printer driver, or select it and press the Enter key .

5. Insert the Device Drivers diskette containing the printer driver
into drive A .

If your printer driver programs are in a directory on your fixed
disk instead of on a diskette, type the correct drive and directory
name in the entry field . Do not type the file name .

Note: If you need to add support for more than one plotter, enter
the drive and path location where you previously installed
PLOTTERS.DRV. The default path when you first installed
the OS/2 program is C:\OS2\DLL .

6. To display the names of the printer drivers, click on Add, or press
the Enter key .
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Wait until the names of the printer drivers appear in the Add
Printer Driver window .

7 . Click on or select the printer driver name for the printer you are
instal I i ng .

You may select more than one printer driver in a directory to
install at once .

8. Copy the printer driver to another directory or to the C :\OS2\DLL
directory .

9. Click on Add, or press the Enter key .
10. From the Control Panel, click on Options, or select it and press

the Enter key .

11 . To add a port, click on Communications port, or select it and
press the Enter key .

OS/2 displays the Communications Port window and lists the
default settings for the COM ports . Use these settings for
communication between programs and serial printers .

12. Click on the settings that your serial printer requires, or use the
settings that have been preselected by the system .

Refer to the publication that came with your serial printer to
determine how to set the communication settings and switches on
your printer .

13. Click on Set, or press the Enter key .

Note: To complete installation of your serial printer, refer to "Using
the Control Panel and the Print Manager" on page 35 to locate
the procedures you want to use, and continue .

Deleting a Printer Driver
To delete a printer driver, follow these steps :

1 . From the Control Panel, click on Installation, or select it and
press the Enter key .

2 . Click on Delete printer driver, or select it and press the Enter key .

3. Click on the printer driver that you want to delete, or select it .

4. Click on Delete, or select it and press the Enter key .

A panel is displayed so that you can confirm that you want to
delete the selected printer driver from your system .

5. Click on Yes, or select it and press the Enter key .
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Note: When deleting a printer driver for a plotter, OS/2 displays a
panel so that you can delete the associated PLOTTERS .DRV
file . For multiple file drivers, only the DRV file is deleted .
Select No if you intend to use a different plotter entry .

Adding a Queue Driver
The OS/2 program provides the PM PRINT queue driver to link the
queue to the correct printer . The PM PLOT queue driver is also
supplied with OS/2 to provide reverse clipping for plotters . For
further information on the PMPLOT queue driver, see the
READMEDD.DAT file located on the Device Drivers diskette 1 . If you
would like to add a different queue driver, follow these steps :
Note: After you add a queue driver, you must associate it with a

queue by selecting the Queues choice from the Setup
pull-down of the Print Manager .

1 . From the Control Panel, click on Installation, or select it and
press the Enter key .

2. To display the Add Queue Driver window, click on Add queue
driver, or select it and press the Enter key .

3. Insert the diskette containing the queue driver into drive A .

If your queue driver is in a directory on your fixed disk instead of
on a diskette, type the correct path and directory name in the
entry field. Do not type the file name .

4. To display a list of queue driver names, click on Add, or press the
Enter key,

5. Click on or select the queue driver name that you want .

6 . Click on Add, or press the Enter key .

Deleting a Queue Driver
To delete a queue driver, follow these steps :

Note: Before deleting a queue driver, remove its associations with
queues by selecting the Queues choice from the Setup
pull-down of the Print Manager .

1 . From the Control Panel, click on Installation, or select it and
press the Enter key .

2. Click on Delete queue driver, or select it and press the Enter key .

3. Click on or select the queue driver that you want to delete .
4. Click on Delete, or select it and press the Enter key .
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A panel is displayed so that you can confirm that you want to
delete the selected queue driver from your system .

5. Click on Yes, or select it and press the Enter key .

Using the Print Manager
The Print Manager, installed in the Group-Main window, incorporates
the printer and queue setup so that you can manage and modify your
entire printing environment . Use the Print Manager to check the
status of print jobs, or use the functions in its window to set a priority,
or to reprint or cancel print jobs . Print Manager also provides you
with the ability to hold and release jobs and queues .

To display the Print Manager window on your screen :

•

	

Double-click on Q, or press the Ctrl and Esc keys to select Print
Manager from the Task List window, and press the Enter key .

OS/2 displays the Print Manager window .

Print Manager

ueue Job Setup Refresh HelI
LPT1Q

	

Job(s)

	

Queue held

System LETTER .ONE

	

7-17-90 03 :37 :03PM
2

	

System REPORT

	

7-17-90 03 :39 :26PM
System LETTER .TWO

	

7-17-90 05 :49 :01PM

DOS

DOS

p

Q, Print Manager
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Notes:

1 . When you have finished using the Print Manager window, select
Minimize from the System Menu located in the pull-down in the
upper left-hand corner of the window . As an alternative method,
you can select the minimize icon in the upper right-hand corner of
the window .

2. If you are running OS/2 without print spooling (disabled), start the
Print Manager by selecting Print Manager from the Group-Main
window. With spooling prevented, the Print Manager can still
perform printer and queue tasks .

Adding, Changing, or Deleting Printer Names
Each printer is identified to the spooler by a name defined by you .
Follow these steps to add, change, or delete printer names :

1 . From the Print Manager, click on Setup, or select it and press the
Enter key .

2 . To display the list of printers set up on your system, click on
Printers, or select it and press the Enter key .

3. Choose from the following steps :

To add a printer name :

a. Click on Add, or select it and press the Enter key .

b. From the Add Printer window, type the name and description
of the printer you want to add .

Skip the other fields. They will be addressed later .

c. Click on Add, or press the Enter key .

d . At the Printers window, click on Ok, or press the Enter key .

To change a printer name:

a. Click on or select the name of the printer you want to change .

b. Click on Change, or select it and press the Enter key .

c. From the Change Printer window, make the necessary
changes .

d . Click on Change, or press the Enter key .

e. At the Printers window, click on Ok, or press the Enter key .

To delete a printer name :

a. Click on or select the name of the printer you want to delete .

b. Click on Delete, or select it and press the Enter key .
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c. Click on Yes to confirm your choice, or select it and press the
Enter key .

Connecting Printer Names with Ports
A port is an outlet on computers where you connect printers and
plotters. To connect a printer name to a port, follow these steps :

1 . From the Print Manager, click on Setup, or select it and press the
Enter key .

2. Click on Printers, or select it and press the Enter key .

3. Click on or select the name of a printer that you want to connect
with a port from the list of printer names .

4. Click on Change, or select it and press the Enter key .

5. In the Change Printer window, click on the selection list next to
the Device field for a list of available ports, or select a port using
the arrow keys .

Note: You cannot have two printer names defined to the same
device .

6 . Click on Change, or press the Enter key .

7 . At the Printers window, click on Ok or press the Enter key .

Connecting Printer Drivers to a Printer
To connect printer drivers to a printer, follow these steps :

1 . From the Print Manager, click on Setup, or select it and press the
Enter key .

2 . Click on Printers, or select it and press the Enter key .

3 . From the list of printer names in the Printers window, click on or
select the name of the printer you want . If the driver you want is
not listed, you can install it using the Printer install choice .

4. Click on Change, or select it and press the Enter key .

5. From the Change Printers window, click on the names of the
printer drivers you want to connect with the selected printer .

If you select more than one printer driver to be connected with a
printer, the last one selected becomes the default driver . If you
only want to select one printer driver, you will need to deselect
the other one .

6. Click on Change, or press the Enter key .

7. At the Printers window, click on Ok, or press the Enter key .
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Adding, Changing, or Deleting Queue Names
You may set up multiple queues (ordered lists of jobs) on your
system . This means that you can sort your print jobs according to
some general criteria (for example, large batch jobs or small
documents) . Each job waits on the queue until it is printed on one of
the printers that the queue uses .

A queue can use one printer or it can be set up to use several
printers at the same time so that it is making better use of available
resources. Also, any of these printers can be shared with multiple
queues at the same time .

To add, change, or delete a queue, follow these steps :

Note: Set up the printers available on your system before creating or
setting up queues .

1 . From the Print Manager, click on Setup, or select it and press the
Enter key .

2. To display a list of queues available, click on Queues, or select it
and press the Enter key .

3. Choose from the following steps :

To add a queue name :

a. Click on Add, or select it and press the Enter key .

b. From the Add Queue window, type the name and description
of the queue you want to add .

c. Click on or select a queue driver, printers to be used by the
queue, and the printer driver for this queue . If you only want
to select one queue driver, you will need to deselect the other
one.

d. Click on Add, or press the Enter key .

e. At the Queues window, click on Ok, or press the Enter key .

To change a queue name :

a. Click on or select the name of the queue you want to change .

b. Click on Change, or select it and press the Enter key .

c. From the Change Queue window, make the necessary
changes .

d. Click on Change, or press the Enter key .

e. At the Queues window, click on Ok or press the Enter key .
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To delete a queue name :

a. Click on or select the name of the queue you want to delete .

b. Click on Delete, or select it and press the Enter key .

c. Click on Yes to confirm your choice, or select it and press the
Enter key .

Changing Default Printers and Queues
Frequently, a local printer is attached to port LPT1, or device name
LPT1 is redirected to a network printer server .

Note: DOS and many OS/2 non-Presentation Manager programs
print directly to the logical name PRN or the port name LPT1 .

If you would like to change your default printer and queue, follow
these steps :

1 . From the Print Manager, click on Setup, or select it and press the
Enter key .

2. Click on Application defaults, or select it and press the Enter key .

3. Click on or select the name of the queue that you want as your
default queue .

4. Click on or select the name of the printer you want as your default
printer.

5. Click on Set, or press the Enter key .

Changing Printer Driver Settings
To change printer driver settings, follow these steps :

Note: If you are changing settings, refer to printer and plotter
considerations in the READMEDD .DAT file located on the
Device Drivers diskettes .

1 . From the Print Manager, click on Setup, or select it and press the
Enter key .

2. Click on Printers, or select it and press the Enter key .

3. From the list of printer names in the Printers window, click on or
select the name of a printer that is connected to the printer driver
you want .

4. Click on Change, or select it and press the Enter key .

This displays the Change Printer window which shows the setup
of the selected printer .
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5. Click on or select the name of the printer driver you want to
change .

6. Click on Printer Properties, or select it and press the Enter key .

The system displays a window that contains the settings you can
change in the printer driver . The settings that are displayed
depend on the printer driver you select. This is where you can
add, change, or delete printer forms . It is also the only method to
change the default spool file type .

7. After making your selections, click on Enter, or press the Enter
key .

Changing Queue Printer Driver Settings
To change queue settings, follow these steps :

1 . From the Print Manager, click on Setup, or select it and press the
Enter key .

2. Click on Queues, or select it and press the Enter key .

This displays the Queues window, which lists queue names .

3. Click on or select the name of the queue that uses the queue
driver that you want to change .

4. Click on Change, or select it and press the Enter key .

This displays the Change Queue window, which shows the setup
of the selected queue name .

5. Click on or select the name of the queue driver that you want to
change .

6. Click on Job Properties, or select it and press the Enter key .

The system displays a window that contains the settings you can
change in the queue driver . The settings that are displayed
depend on the queue driver you select .

7. After making your selections, click on Enter, or select it and press
the Enter key .

8. Click on Change, or select it and press the Enter key .

9. In the Queues window, click on OK, or select it and press the
Enter key .

The queue printer driver settings for the queue driver you
selected are changed .
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Setting Up Serial Devices for Base Printing
Base printing is printing without using Presentation Manager
functions; for example, using the COPY command on the command
line, or entering keyboard functions like PrtSc or Ctrl + PrtSc . Base
printing is also printing using file system API calls such as DosOpen,
DosWrite, or DosClose .

If you are adding a serial device and plan to use base printing, it is
necessary for you to set up a dummy (fictitious) printer . A dummy
parallel printer is required because base printing only supports
output going to parallel devices (for example, LPT1, LPT2, LPT3, and
PRN) .

To add a dummy redirect printer, follow the instructions on pages 43,
44, and 45 for adding printer names, ports, and drivers . The
parameters you need are :

Name

	

Redirect

Port

	

A parallel port which is not yet used
(such as LPT3)

Printer Driver

	

None (deselect all drivers)

You can then use the SPOOL command at the command prompt to
redirect the parallel port to the serial port . For example, to redirect
input from a parallel port (LPT3) to the printer attached to a serial
port (COM1), enter :

SPOOL /D :LPT3 /O :COM1

At this point, if you want to print to the serial device attached to
COM1, enter the following at a command prompt:

COPY filename LPT3 :

Substitute the name of your file in place of filename .

Notes:

1 . To avoid having to enter the SPOOL command each time you
start your system, you can include it in the STARTUP .CMD file, a
batch file that begins processes automatically when you start the
OS/2 program .

2. Refer to the OS/2 Command Reference for further information on
the SPOOL command .
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Changing Printer Response Time
If your printer stops working properly, or if OS/2 does not send the file
you selected to the printer correctly, the printer driver might display a
message. Follow these steps to specify the number of seconds that
you want to have before receiving a message if the printer driver
detects such problems .

Note: Existing IBM-supplied device drivers do not use timing fields .
Disregard this field unless you are working with a device
driver that provides the freedom to change printer response
time .

1 . From the Print Manager, click on Setup, or select it and press the
Enter key .

2. Click on Printers, or select it and press the Enter key .

3. Click on or select any printer whose time you want to change .

4. Click on Change, or select it and press the Enter key .

5. From the Change Printer window, alter the number (in seconds)
in the following printer time-out entry field :

Transmission retry, which specifies the length of time before
a printer driver detects that data did not arrive at the printer
and should be sent again .

6. Click on Change, or select it and press the Enter key .

7. From the Printers window, click on Ok, or press the Enter key .
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Spooling and Printing
The spooler manages your system's printing process by placing data
as print jobs in temporary files on disk . In addition, spooling allows
the printing devices to be shared among several processes in the
system without interference. This gives you flexibility in organizing
and optimizing the use of system printing resources .

You can send information directly to a device or you can send it to the
spooler. Since disk I/O is faster than printer I/O, if you use the
spooler, OS/2 selects which job to run next when scheduling jobs
without being affected by the type and volume of printer I/O . OS/2
avoids intermixing data among programs running at the same time by
intercepting and separating information going to the printing device
from different processes . The data is printed or plotted when it is
complete and the required device is available .

When you submit a job for printing, the job is distributed and stored in
a print queue with other submitted print jobs . The print job stays in
the queue until the spooler, which continuously examines each
available print queue, decides which print job to send to the next
available printer or plotter .

Next, each print queue uses an installed queue driver (like PMPRINT)
to do hardware-independent processing common to all jobs on the
queue . The queue uses a queue driver to translate the jobs received
into a format which it can pass to the device driver of the physical
device .

Although several queues can use the same queue driver, each queue
is set up to use only one queue driver unless a program requests a
different queue driver for a particular job . Each queue can use one
printer or it can be set up to use several printers at the same time so
that it is making better use of available resources .
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The following figure is an example of the spooling process :

Figure 6. Spooling

You can start the system without the spooler (see "Running OS/2
without Print Spooling" on page 53) . You can also remove the
spooler during a session, and then restart the system . When you
restart the system, existing printer queues remain intact, though print
jobs in the process of being created may be lost . In addition, the
spooler responds dynamically to any changes you make . For
example, if you add a printer to a running system, the spooler
automatically supports the printer without having to be restarted .

Refer to "Printing Files" i n Getting Started for details on how to print
a file through direct manipulation to the Print Manager .
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Running OS/2 without Print Spooling
The spooler helps avoid errors when printing from multiple programs .
If you, however, do not want to share a printing device with other
programs in your system, you might want to turn the spooler off .

To prevent spooler function, follow these steps :

1 . In the Print Manager, click on Setup, or select it and press the
Enter key .

2. Click on Spooler, or select it and press the Enter key .

3. In the Spooler window, click on the radio button to turn the
spooler off (Disabled), or select it and press the Spacebar .

4. Click on Set, or press the Enter key .

5. For the change to take effect, press and hold the Ctrl, Alt, and Del
keys together to restart the system .

Note: Once you have disabled spooling, you can close the Print
Manager or use it for non-printing tasks such as changing
queue settings .

To turn the spooler on again, repeat steps 1 through 5, but click on
the Enabled radio button (or select it) in step 3 .

Spooling to a Different Directory
You can have files spooled to a directory in another partition on your
fixed disk. You might want to do this if you partitioned your disk when
you installed the system and now have insufficient room in your
current partition to store spooled files . Spooling to a directory on
drive A (or any diskette) is not supported .

Note: You can only change the spool directory if there are no jobs in
the current spool directory .

To spool files to a different directory, follow these steps :

1 . From the Print Manager, click on Setup, or select it and press the
Enter key .

2 . Click on Spooler, or select it and press the Enter key .

3. In the Spooler window, click on the Spooler path entry field, or
select it .

4. Specify a different path than the one listed .

5. Click on Set, or press the Enter key .
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Changing Country Information
Computer systems store data as numeric values . When you need to
display or print information, the system translates the numeric values
into letters, numbers, symbols, and characters that you can
recognize. Your system uses a table called a code page to achieve
this .

If you divide a code page even further, it contains the definition of one
or more character sets . For example, a character set in the U .S. code
page (437) may include :

abcdefghi j kl mnopgrstuvwxyz
0123456789
_1@#$%A&*() + 90 / ;1[]?

Many countries require accented characters, which are not contained
in the 437 code page, to support their languages . Certain countries,
therefore, created their code pages containing character sets that
allow the use of these accented characters . A character set in the
Portuguese code page (860), for example, may include :

abcdefghijklmnopgrstuvwxyzAElOU
0123456789
_!@#$%A&*() + 90 / ;1[]?

These new code pages caused difficulties because information
created i n a certain code page must be viewed i n that code page ;
otherwise, some characters will not look the same as when they were
entered . Menus, for example, may turn into strings of accented
characters, and help text may become unreadable because
alphabetic letters may display as graphics .

To solve this dilemma, IBM developed a code page that includes all
the required accented characters to support many of the European
languages. With this multilingual code page (850), data can be
interchanged without problem between personal computers in
various countries and other IBM systems . For example, suppose you
create a file using characters from code page 850 and send it to
someone in another country . When that file is received and viewed
or printed, it is identical to your copy . This means that identical
operations performed on the data in two files, such as searching and
updating, can produce identical results .

However, because some existing files still use the old character sets,
code page switching is necessary to provide a dual code page
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environment where files can be viewed in the old character set as
well as in the new character set . Once the code pages have been
defined on your system, you can display and switch between the
prepared code pages .
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Figure 7. Code Page Switching

If your country does not require code page switching, you do not need
to use it unless you want to display or print country-specific
characters located on specific code pages -for example, if you come
across files that have been created in a code page other than that for
your country, or if your character set is not contained in code page
437. For those countries that required code page switching, the code
page statements are set up in your CONFIG .SYS file during
installation .
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If your system has been set up for code page switching, you can
switch back and forth between :

•

	

Your national language code page, which contains the characters
used by the language of your country and can include characters
not found in any other code page. (National language code pages
are standard only for personal computers; thus their use is
limited .)

•

	

The multilingual code page, which has characters in common
with each of the national language code pages and includes all
characters for the languages of most European countries.

Warning: Some PC applications written for one code page may have
usability problems when using the multilingual code page . If this
happens, end the program and switch out of the multilingual code
page to the other code page before restarting the application .

OS/2 error messages, in most cases, use characters common to both
your national language code page and the multilingual code page .
When you switch code pages, OS/2 error messages remain the same .

Preparing for Code Page Switching
You must have the necessary devices and interrelated CONFIG .SYS
statements to successfully switch between two code pages at run
time .

Supported Devices
Code page switching is supported on the following devices :

Display Terminals

IBM Enhanced Color Display
IBM Personal System/2 family

Display Adapters

IBM Enhanced Graphics Adapter
IBM Personal System/2 Video Graphics Array
IBM Personal System/2 Display Adapter
IBM Personal System/2 8514/A
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Printers

IBM 4201 Proprinter* family except for Model 001
IBM 4202 Proprinter XL
IBM 5202 Quietwriter* Ill .

Note: To use code page switching on an IBM 4207 Proprinter X24 or
an IBM 4208 Proprinter XL24, your printer requires a
multilingual character set to be downloaded to the printer from
a National Language Support (NLS) diskette . These diskettes
are available in countries outside the United States .

Statements for Code Page Switching
Certain statements must be added to your CONFIG .SYS file to start
code page switching. These statements identify the code pages to be
used and also prepare devices such as your keyboard, display
terminal, and printer .

Note: Refer to "Configuring OS/2" on page 17 for further information
on CONFIG.SYS .

If the printer is correctly set up for code page switching, printing jobs
started in DOS mode or in the current OS/2 session - after a
successful CHCP command is issued-will print in the new code
page .

Incorrect, partial, or mismatched setup of statements for code page
selections, country codes, keyboard layouts, displays, or printers may
cause ineffective switching between code pages .

Note: If you plan to switch code pages, it is recommended that both
files and subdirectories be named using only the characters
A - Z and 0-9 (no accented characters) . This prevents file
access problems when switching between code pages and
their associated character capitalization rules . If you use code
page 850 only, however, you will not run into any difficulties .

To properly set up code page support, the following statements must
be correctly included in your CONFIG .SYS file or functional
irregularities may result . Refer to the OS/2 Command Reference for
examples on how to add the COUNTRY, CODEPAGE, and DEVINFO
statements to your CONFIG .SYS file .

* Trademark of IBM Corporation .
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CODEPAGE

Identifies the two code pages to be used for code page switching .
These code pages must be those supported for the country
specified by the country code in the COUNTRY statement .

Note: You can change the active code page at any time using the
CHCP command .

COUNTRY

Specifies the country code and the complete name of the file that
contains a set of country information for each code page
supported for that country .

DEVINFO

Prepares a device for code page switching . Separate DEVINFO
statements are required for each device to be used for code page
switching .

Keyboards: The keyboard statement specifies your keyboard
layout ID (keyboard country and subcountry codes) and a file
named KEYBOARD .DCP that contains a keyboard layout table for
translating keystrokes into the characters of each code page
supported by OS/2. Refer to the KEYB command in the OS/2
Command Reference for a table containing the keyboard country
and subcountry codes .

Displays: The display statement specifies your display name and
a file named VIOTBL .DCP that contains a video font table for
displaying characters in each of the code pages supported by
OS/2 .

Printers: The printer statement specifies your printer name and a
file with a DCP extension that contains a printer font table for
each code page supported by OS/2 .

Example
For example, if you want to change from a U .S. keyboard to the
French enhanced keyboard (120), follow these steps :

1 . Change the COUNTRY statement in the CONFIG.SYS file to :

COUNTRY=033

2. Add the following DEVINFO statement to the CONFIG .SYS file :

DEVINFO=KBD,FR120,C :\OS2\KEYBOARD .DCP
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3. Press the Ctrl, Alt, and Del keys together to restart your system .

Controlling Code Pages
Use the following commands to manipulate the code pages set up on
your system, once you have installed code page switching .

Note: Refer to the OS/2 Command Reference for the syntax of the
command, associated parameters, and examples .

CHCP

Displays or changes the current code page for the command
processor CMD.EXE or COMMAND.COM. OS/2 displays an error
message if you select a code page that has not been prepared for
the system .

KEYB

Selects a keyboard layout to replace the current keyboard layout .

GRAFTABL

Allows additional characters from a language code page to be
displayed when using display adapters in graphics mode .
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Chapter 3. System Performance

Each person has different computer requirements, so various types of
programs are available in the marketplace . Depending on which
programs you choose to run, each program uses varying amounts of
resources from the system - memory and storage, for example .
Careful planning is required to select the correct system
configuration for OS/2 to satisfy both short-term and long-term
requirements .

This chapter describes OS/2 functions directly related to improving
system performance. Background information concerning OS/2
memory management and file usage is included to help you
understand the reasons for the required memory and fixed disk
space. In addition, the following section summarizes CONFIG .SYS
statements that help maximize your system's resources . This allows
you to get the most work done in the least amount of time .

Remember that system installation already set up default values in
your CONFIG .SYS file. Depending on the values recommended with
the information that came with your programs, you might want to
change these defaults to suit your particular system configuration .

Note: Refer to the OS/2 Command Reference for the syntax of the
command, associated parameters, and examples .
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Process Management
Improving performance begins with a scheduler, which distributes
information to the central processing unit (CPU) . The CPU, which is
responsible for processing jobs and performing system activities, has
functions similar to those of an office secretary . The CPU receives
information that needs to be processed the same way a secretary
receives messages or letters that need to be answered .

Suppose for a minute that a secretary leaves to run an errand ; the
rest of the work waits until the secretary returns . Similarly, in older
operating systems, the CPU must wait while an input or output (I/O)
operation is running. The CPU does not continue processing until the
I/O operation is complete .

Because the CPU is waiting while I/O operations take place, the
concept of multiprogramming was devised. This concept allows the
operating system and other programs to use the CPU when it is
waiting for an I/O operation to complete .

In the following figure, suppose the CPU is processing job 1 . The
CPU may eventually stop processing to wait for an I/O operation to
finish. With multiprogramming, however, the processor does not
have time to wait. Instead, it switches to job 2 (next i n line) and
continues processing . When it is job 2's turn to wait, the CPU moves
on to another job and eventually continues processing job 1 . This
processing sequence, where the scheduler allocates a specific
amount of time to each program, is called round-robin scheduling .

Job 1

CPU

Job 2

Figure 8. Multiprogramming

Job 1 Job 2 Job 1 Job 2 Job 1 Job 2 Job 1 Job 2 Job 1

110

~ uo

	

uo

	

uo
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Time sharing assists multiprogramming by concentrating on how fast
the CPU completes jobs instead of how effectively the OS/2 program
uses processor time. With multiprogramming, there are many jobs
wanting access to the processor, competing for its time . With time
sharing, each job receives a series of small, equal shares of time .

These time slices are designated intervals of time allocated for
processing a thread. The continuous allocation of time slices to
competing jobs ensures that all jobs get an opportunity to use the
CPU . In this way, no single job can monopolize the CPU when it is
not performing I/O operations .

The OS/2 program uses a scheduler to handle the distribution of time
slices . This gives control to a thread according to its priority class
and makes sure that threads of equal priority are given equal
chances to process . When a time slice elapses, or when the active
thread starts an operation for which it must wait (such as I/O), control
is passed to another thread according to priorities of waiting threads .
At any time, if an active task waits for an event, such as I/O, it loses
its time slice until that event occurs . The CPU then reactivates the
task after the program completes its I/O operation .

For example, suppose job A receives a time slice from the scheduler
and runs for a few milliseconds . When job A's time slice is over, the
CPU picks up another program to process, even though job A has not
completed its processing . The CPU eventually gets back to job A to
process another time slice, and so on . This appears as though the
CPU is processing several of your programs at the same time . In
actuality, however, the processor can only work on a single task at a
time .

The following are CONFIG .SYS statements for process management .
To control the OS/2 operating environment and multitasking
capabilities, you may regulate the following CONFIG .SYS statements .
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Specifying the Number of Threads (THREADS)
The THREADS statement determines the maximum number of
independent actions, known as threads, that can be active in the
system at any time. The default value includes an allowance for
system threads (depending on your system configuration) to be used
for OS/2 itself and an allowance for programs . You must account
here for any system extensions, additional applications, or complex
operating environments that require threads .

Allocating CPU Time (TIMESLICE)
The TIMESLICE statement specifies in milliseconds the amount of
CPU time allocated to each thread . If you only specify one value with
TIMESLICE, OS/2 sets both the minimum and maximum TIMESLICE
values to that value. The minimum value is the first number in the
statement. The OS/2 program uses this value for special situations
and it should generally be allowed to default. The maximum value is
the optional second number in the statement . This number is the
amount of time used for round-robin scheduling among threads of
equal priority .

Setting Thread Priority (PRIORITY)
The PRIORITY statement selects priority calculation in scheduling
regular class threads . OS/2 has a concept of priority classes and
priority levels . OS/2 dynamically varies the priorities of regular class
threads. This dynamic change in priority is calculated from a base
level, which may be changed by a system call . The priority of a
process can be either absolute or dynamic. The dynamic priority is
the default and means that the system continually recalculates the
priority of a process .

Setting Maximum Wait Time (MAXWAIT)
The MAXWAIT statement specifies the maximum time in seconds
(from 1 to 255) that a thread must wait to get the processor resources
before having its priority boosted . In other words, it is the number of
seconds that pass before the priority of a process gets increased
because of lack of processor time . When the scheduler denies a
regular class thread the processor for a defined number of seconds, it
receives a temporary boost in priority for a minimum time slice .
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Memory Management
Memory management dynamically allocates and releases memory as
needed and collects fragmented memory as appropriate .

Virtual Memory and Segment Swapping
By using virtual memory, operating systems give computers the
illusion of being larger than they are i n reality . It allows more
program code and data to be concurrently active than the amount of
memory physically installed on your computer .

This is accomplished by using a memory management technique
called swapping, where the OS/2 program attempts to keep in
physical memory only those portions of a program that are currently
being used . Inactive portions of a program are placed in a swap file
where they remain until they are needed in physical memory . This
method allows OS/2 to maintain a greater number of programs in an
active state than would be possible if a non-virtual memory system
were being used .

Random access memory (RAM), commonly called physical memory,
temporarily stores data while the system is still processing the
information . By swapping RAM in OS/2 mode, it is possible to store
and start programs that use up to 16MB of address space .

Segment swapping becomes necessary when you start a combination
of programs and data which together require more memory than the
amount physically installed on your system . For example, a program
could process a large spreadsheet and have all of the contents
resident in memory at once. The user would not have to split the
spreadsheet into smaller segments . Since the entire spreadsheet is
resident, recalculation can be faster .
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By allowing memory overcommitment, you can execute more
programs than will fit into available memory at the same time . Your
virtual operating system divides the information from your files and
programs into sections and stores the sections on the fixed disk .
OS/2 can then load active segments that are needed instead of
having to load an entire program into memory at once . As programs
require more sections, the OS/2 program swaps segments to the
fixed disk to free physical memory space for additional programs . In
this way, more program code and data may be concurrently active
than the available physical memory can contain .

For swapping to occur, the system requires enough free disk storage
to contain the maximum number of segments that OS/2 will swap to
disk during an OS/2 session . The size of the swap file at system
installation is 640KB. If the system determines that programs require
additional space, it is dynamically allocated as needed .

The OS/2 program might swap memory segments that are not
currently active to your fixed disk to make one large area of unused
contiguous memory . An algorithm decides which segments to swap
to disk, swapping the least recently used segments first .

OS/2 does not swap segments that programs use frequently, because
it would probably have to swap the segments back to physical
memory, slowing down performance . OS/2 might also discard
memory segments out of RAM instead of swapping them out. This is
as long as you did not change the segment since you first loaded it
from disk. When the discarded segment is later referenced, a fresh
copy is read from the disk .

The following pages show CONFIG .SYS statements for memory and
storage management provided by OS/2 . Refer to the OS/2 Command
Reference for further information on command parameters .
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Determining Disk Buffers (BUFFERS)
Buffering, which deals with the timeliness of I/O devices, is one
memory management method . The disk buffer is a 512-byte portion
of storage that the OS/2 program uses to hold I/O information
temporarily. It assists i n helping the I/O device and the CPU to work
at the same time .

By using the disk buffer, OS/2 can read and write blocks of
information . Once the information is read into the buffer, the CPU is
ready to process it. While the information is in the buffer or being
processed by the CPU, the input device can begin reading new pieces
of information so the processor does not have to wait unnecessarily
to process information and program instructions . The CPU can
complete its operation, because the next block of information to
process is already i n the buffer area .

Some other situations might also occur . For example, suppose the
CPU completes its work and there is no information in the buffer to
process. The CPU must wait until the next block of information is
read into memory by the input device . Similarly, if the input device
reads information into the buffer before the CPU has time to process
the records, the buffer might reach its capacity and have to wait until
the CPU accepts more information to process .

In your CONFIG .SYS file, there is a BUFFERS statement that
determines the number of disk buffers that the OS/2 program will
keep in memory. Depending on how many programs you work with at
a given time, you may want to experiment with this number to
maximize performance on your system .

If you run many programs under OS/2, you can increase the speed of
your system by increasing the value specified for BUFFERS (for
example, BUFFERS = 70) . However, remember that when you
increase the number of disk buffers, you decrease your available
memory by 512 bytes for each buffer specified . Additional buffers
may cause some programs to run more slowly because there is less
memory available for the program to keep information . This can
result in more frequent memory swapping, which will slow down
performance (see page 65) .
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Allocating Storage Blocks (DISKCACHE)
Another method of improving system performance is disk caching,
which allows a portion of the computer's system storage to be used
as an additional fixed disk buffer. Disk caching assists the buffer
area by holding the most frequently used information, thus enabling
the CPU to continue processing with fewer interruptions .

For example, suppose that the input device is operating slower than
the CPU . Without disk caching, the processor slowly empties the
buffers of information and eventually stops processing . The CPU is
delayed until the input device supplies additional information . In this
situation, the performance of the input device, which should rely on
the speed of the CPU, is seemingly independent of CPU processing .

The disk cache speeds up computer operations that read from the
fixed disk by keeping frequently accessed information in a cache
buffer. When a program requests fixed disk information that is
already in the cache buffer, the disk cache sends the information
directly to the program . This method of accessing information is
much faster than if the information has to be read from the disk each
time.

In OS/2 mode, you can allocate the number of blocks of storage for
control information and use by specifying the DISKCACHE statement .
Although specifying this statement increases the speed of your
system, when you increase the size of your disk cache you also
decrease the size of available storage . For this reason, you may
want to experiment with the number of blocks you specify to get
maximum performance .
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Setting Swapping and Segment Motion (MEMMAN)
The MEMMAN statement allows or prevents swapping and segment
motion in your system . The first parameter, SWAP or NOSWAP,
specifies whether you want the system to swap memory segments to
disk. If you want to run several large programs at the same time, or if
you have one program that is too large for available memory, set this
parameter to SWAP .

The second parameter, MOVE or NOMOVE, specifies whether
memory data segments in your system are allowed to move . SWAP
and MOVE are the system defaults . However, where timing is critical
(for example, when process control tasks are being performed), it is a
good idea to prevent all swapping and segment motion in your
system . By specifying the NOMOVE parameter, you can prevent
storage compaction ; use NOSWAP to prevent swapping. When you
turn off swapping, the OS/2 program requires more physical memory
to restart your system ; 5MB of memory is required .

Specifying the Swap File (SWAPPATH)
With advanced memory management techniques, the OS/2 program
attempts to keep only those portions of a program that are actually
active in physical memory. Inactive portions of a program are placed
in a special swap file where they remain until they are needed in
physical memory.

The SWAPPATH statement specifies the size and location of the swap
area on disk. Using a swap file allows OS/2 to maintain a greater
number of programs in an active state than would be possible to fit
into physical memory if a non-virtual memory system was being
used .

If you use the MEMMAN command to permit swapping, the segments
being swapped from running programs go to a temporary file named
SWAPPER.DAT. This file grows in size as you start or stop programs
and load, modify, or save data files . This file can sometimes be
hundreds of thousands of bytes in size, an indication that your system
may need additional memory to improve performance . The swap file
needs to be at least 512KB in size, so you must have at least 512KB
of available storage on the swapping drive . The size of the swap file
increases as OS/2 overcommits storage .
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The default SWAPPATH statement is

SWAPPATH=C :\OS2\SYSTEM 512

but you could change it to reside in another directory or in a logical
drive (SWAPPATH=D) on a partitioned fixed disk if you are
concerned about the swap file using all available disk space . Having
the swap file reside in a separate partition might also improve
swapping performance .

The value of 512 at the end of the SWAPPATH statement is a
parameter called minfree, which regulates the amount of free space
that the swap path leaves for other program use . To ensure there will
always be.some free space on the fixed disk, you can use min free .
This will limit the growth of the swap file and make sure that you will
always have at least the minimum minfree free space on the fixed
disk .

Selecting the Operating Mode (PROTECTONLY)
The OS/2 program requires this statement in the CONFIG .SYS file .
The PROTECTONLY =YES statement allows memory under 640KB,
which is normally used for DOS programs, to be available for OS/2
programs. When PROTECTONLY=YES, you cannot run programs in
DOS (real) mode. If you later decide that you want to run DOS
programs in the lower 640KB of memory, specify
PROTECTONLY= NO. This allows you to use both DOS and OS/2
mode programs .

Setting DOS Mode Size (RMSIZE)
If you decided to specify PROTECTONLY=NO, you can further reduce
the size of the DOS environment by specifying RMSIZE . This allows
you to make the size of the DOS environment smaller than the
maximum amount available if all the remaining memory below 640KB
were used for real mode .

This statement specifies the highest storage address allowed for a
program in DOS mode. It is important to note that if you specify a
number that exceeds the amount of memory allowable for your
system configuration, the system sends you an error message . This
message states that the value was not acceptable and ignores the
statement. If you do not specify a RMSIZE statement in your
CONFIG .SYS file, the default depends on the total memory installed .
If this total is 640KB or less, then the default size is the total memory
minus the minimum required for protect mode operations . If this total
is 1024KB or greater, the default size is the amount of memory
installed below 1024KB, either 512KB or 640KB .
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This is the largest usable size for DOS mode that your system can
operate. If you enter a size larger than your system is capable of
operating, the system prints out an error message during startup and
automatically calculates the largest default value for your system .

High Performance File System Support
The High Performance File System (HPFS) is an Installable File
System (IFS) designed to provide better performance than the
existing File Allocation Table (FAT) based file system . HPFS is
designed to provide extremely fast access to very large disk volumes .
OS/2 also supports the coexistence of multiple, active file systems on
a single personal computer, with the capability of multiple and
different storage devices .

If you select HPFS as your standard file system, the OS/2 installation
procedure inserts an IFS statement as the first entry in the
CONFIG .SYS file .

System installation automatically sets up the HPFS cache for you if
you format the primary partition with HPFS (using the OS2 .INI file) . If
you format the primary partition for FAT instead, and then later want
to format another partition with HPFS, you need to add an IFS
statement to the CONFIG .SYS file together with :

RUN=C :\OS2\CACHE .EXE /LAZY :ON

Keep in mind that these statements are device-dependent and must
be included before any DEVICE statements .

Note: Refer to the OS/2 Command Reference for further information
on IFS, CACHE, and RUN statements .
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Important :
If you set the /LAZY parameter to ON, always use the Shutdown
option in the Desktop pull-down of the Desktop Manager before
turning off your system . Failure to do so will cause loss of data if the
HPFS cache buffers have not been flushed out to the disk . For safety,
and if performance is not a concern, use the /LAZY :OFF option, which
causes a write through the cache to the disk.

If you install HPFS on your system, your system files are replaced . If
you want to restart DOS from diskette, the data files are no longer
accessible .

Both the FAT-based file system and installable file systems support
standard naming conventions and the existing logical file and
directory structure. Features of HPFS include :

•

	

File names up to 254 characters in length

•

	

Fast access to very large disk volumes

•

	

Strategic allocation of directory structures

•

	

Extended attribute support

•

	

Caching of directories, data, and file system structures

•

	

Processing of metacharacters that are generally used for
displaying and printing graphics .

•

	

Large file support .
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HPFS Caching

The system installation program sets up caching for the primary

partition through the OS2 .INl file. The HPFS file system manages a

cache of memory divided into blocks of 2KB . Data that is read from

and written to the disk is transferred through this cache so that it can

be used in satisfying future requests . This cache is separate from the

BUFFERS and DISKCACHE commands discussed earlier in this

chapter.

When a user requests data that is not present in the cache, HPFS

selects the least recently used (LRU) block, writes the data within that

block to disk if necessary, and then fills the block with the requested

data. This significantly increases the chances that often-used data

will be found in memory, thus saving the expense of a disk read

operation .

In addition, the file system takes advantage of its knowledge of cache

block contents. Data not expected to be reused soon by the file

system is placed in cache blocks marked for immediate reuse . In

most cases, when a write request is received, it is not necessary to

write the data immediately to disk. HPFS takes such data and copies

it to the block cache without actually performing the disk-write

operation. Once the data is in the cache, It is written to disk as a

background activity .

Also, because these lazy-writes are performed during disk idle time,

incoming requests need not wait for large disk writes to complete .

This optimizes overall system throughput and response time for all

requesting processes .

HPFS also contains additional levels of caching that speed up access

to directories. HPFS uses this cache to quickly get to the directory on

which the request is being made .

Note: Although the file system owns the cache memory, it is the

cache driver which manages lazy-writing of cache blocks . If

the cache driver is not loaded, no lazy-writing is performed,

and all write requests are written to the disk driver . Refer to

the OS/2 Command Reference for further information on the

CACHE driver .
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Extended Attribute Support
In this version of OS/2, a file system can support additional
information about files and directories. This information is called
extended attributes . Through extended attributes, a program can
attach information to a file system object (files or directories)
describing the object to another program, to the operating system, or
to the file system driver (FSD) managing that object .

For example, the name of the file's originator can be stored on a file
object. Other uses include categorizing file objects such as icons or
bit maps, and describing formats of data in the file object such as a
data record .

A file object may have a list of extended attributes associated with it .
These are not part of a file object's data and are managed by the file
system that manages objects . An extended attribute must have a
name and a value; the name is restricted to the same character set
as a file name .

The maximum size of an extended attribute is 64KB and the value is
arbitrary data. However, a standard set of conventions for extended
attribute use is provided so that data is more easily communicated
between programs . You can also search for files based on their
attributes by using the Search option of the File pull-down window of
the File Manager.

Note: There is a possibility of losing extended attributes if the file is
rewritten or copied by DOS, by a version of OS/2 before 1 .2, or
by an application written before version 1 .2 of OS/2 .
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Chapter 4. OS/2 Command Symbols

OS/2 provides symbols which act as command operators to help you
effectively communicate between processes . This chapter describes
the functions of these command symbols and demonstrates how they
might be advantageous to you .

Symbols Interpreted as Command Operators
The following symbols are interpreted by OS/2 command processors
as command operators :
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Symbol Mode Function

> OS/2
DOS

Redirects output .

OS/2
DOS

Appends redirected output to existing data.

OS/2
DOS

Redirects input .

OS/2
DOS

Pipes output .

&& OS/2 Allows a command to run only if the
command that precedes it is successful .

OS/2 Allows a command to run only if the
command that precedes it fails .

& OS/2 Separates commands .

( ) OS/2 Groups commands .

^ OS/2 Allows input of command symbols as text .



Using Redirection Symbols > , > > , <
Suppose you want to print a list of all the files in a directory named
ACCOUNTS. You know that if you enter the DIR command while in
the ACCOUNTS directory, the names of the files in that directory
display on your screen . How can you redirect this listing to your
printer or to another file?

OS/2 provides redirection symbols to select devices other than the
keyboard and screen. Refer to the following examples where DIR is
used as the input source . Keep in mind that the results of these
examples come from the current directory on the current drive .

Warning: When using this method of providing input to a program,
be sure that all the program's input is in the file . If the program
attempts to obtain more input after it reaches end-of-file, OS/2 is
unable to supply the input and stops processing .

If you want to :

	

Enter :

Redirect the output of DIR to your printer

	

DIR >PRN

Redirect the output of DIR to a file named

	

DIR >LISTING
LISTING, creating a file named LISTING if one
does not exist, or opening and writing over the
file if It exists

Redirect the output of DIR to a file named

	

DIR >>LISTING
LISTING, creating a file named LISTING if one
does not exist, or adding the results of DIR to
the end of the file if it exists

Have an application named PROGRAM receive

	

PROGRAM <DATA .I N
input from a file named DATA-IN rather than
from the keyboard
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Redirection Sequences Using Numbers (0-9)
In OS/2 mode, before a command is issued, its input and output can
be redirected to files or other devices using special sequences
interpreted by the OS/2 command processor, CMD.EXE. The
numbers in these sequences are used as internal file IDs (handles) by
CMD.EXE and by OS/2 programs. When used in redirection
sequences with a command, input or output from or to an internal file
ID is received or obtained from the newly substituted device or file .

Any internal file ID with a single digit number can be redirected .
Redirection takes place even if the internal file ID is currently being
used by another program . This includes the following three standard
internal file IDs (shown below with their numbers) and handles 3
through 9, which are not normally used by CMD .EXE or programs . At
the completion of the command containing the redirection sequence,
the original handle condition is restored .

Number

	

Meaning

0

	

Standard input

1

	

Standard output

2

	

Standard error

Note: A program's input and output can be redirected only if the
program is reading from standard input and writing to
standard output, including standard error . If the program or
command is reading directly from the keyboard and writing
directly to the screen, then its I/O cannot be redirected .

The following redirection sequences may appear anywhere in a
simple command or within the body of one of the special commands
IF, FOR, or DETACH . Redirection is performed in the order it appears
on the command line; therefore, the order in which you enter the
commands is very important. Substitution of both environment and
batch file variables occurs before using name (a valid file name or
device) or n (numbers 0 through 9) in performing the actual
redirection .
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Sequence

	

Interpretation by CMD .EXE

name

	

Use file name as standard input (internal file ID 0) .
If the file doesn't exist, an error occurs .

>name

	

Use file or device name as standard output (internal
file ID 1) . If the file doesn't exist, it is created ;
otherwise, it is truncated to zero length .

>>name

	

Use file name as standard output (internal file ID 1) .
If the files exists, output is appended to the end of
the file ; otherwise, the file is created .

<&n

	

Standard input (internal file ID 0) is duplicated from
the internal file ID n .

>&n

	

Standard output (internal file ID 1) is duplicated from
the internal file ID n .

Note: If any of the above sequences is preceded by
n, then the internal file ID redirected is the one
specified by the first n instead of the default 0 or 1,
as shown in the next two examples .

2>&1

	

Standard error (internal file ID 2) becomes a
duplicate of standard output (internal file ID 1) . Any
output written by a process to internal file I D 2 has
the same effect as if it had been sent to internal file
ID 1

4>name

	

Internal file ID 4 becomes the file specified by name .
Any output written by a process to internal file ID 4
is sent instead to this file .
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Note that blanks may appear only between the redirection symbol
and its related file name, or between the & character and its related
number.

Also, a leading, or first, file-ID number must exist in a redirection
statement so that OS/2 interprets the number as the start of a new
redirection statement instead of part of the text in a file name . To be
associated with redirection, the number must be the first character on
a line, or it must be immediately preceded by either a blank or one of
the following delimiters :

Otherwise, the number is interpreted by CMD .EXE as part of the
previous redirection sequence . The redirection symbol following the
number is then interpreted as the beginning of the redirection
sequence. Redirection commands cannot be enclosed in quotes .
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For the following examples, assume that the programs use standard
input, standard output, and standard error .

If you want to :

	

Enter:

Have DISKCOPY's standard output
directed to a file named OLOG and any
error messages sent to a file named
ELOG

Display the word HELLO on your display
and append standard error output to a
file named OUTFILE (if OUTFILE does
not exist, it is created) .
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DISKCOPY A : B : >OLOG 2>ELOG

ECHO "HELLO"2>>OUTFILE

Direct all output and error messages

	

(DIR * .* >FILELOG)2>&1
from the DIR command to a file named
FILELOG

	

or

DIR * .* >FILELOG 2>&1

Send the output from the COBOL

	

COBOL PROG .COB >OUT ; 2>ERROR
compiler to the OUT file and send the
error messages to the ERROR file

Note: If you do not specify a number by
the > symbol, the initial value is
equal to having the number 1 by
it.

Process the APP program

	

DETACH >DATALOG APP 2>&1
noninteractively, send the output to a file
named DATALOG, and have any output

	

or

written to internal file ID 2 (standard

	

DETACH APP >DATALOG 2>&1
error) redirected to the current target of
internal file ID 1 (here, DATALOG)



Prevent All Output by a Program
It is possible to redirect any internal file ID from 0 through 9 for input
or output. Files opened as input internal file IDs are opened
read-only, whereas files opened as output internal file IDs are either
write-only (for normal redirection) or read-write (for appending) . No
attempt is made by CMD.EXE to detect standard output internal file
IDs redirected as input or vice versa . Thus, by redirecting both
standard output and standard error as input internal file IDs, it is
possible to end with no output at all . For example :

command parameters 1<INFILE 2<INFILE

All output can also be prevented by redirecting standard output and
standard error to NUL . For example, to run a program named
PROGRAM.EXE without collecting its output and error messages,
enter:

PROGRAM.EXE 1>NUL 2>NUL

or

PROGRAM .EXE 1>NUL 2>&1

Echoing of Redirection Statements
Because the two default internal file IDs can be redirected (internal
file ID 0 for standard input and internal file ID 1 for standard output), it
is necessary to visually determine which internal file IDs are being
manipulated . For this reason, all statements containing redirection
sequences are echoed (displayed on the screen) by CMD .EXE in a
format where the internal file ID number precedes the redirection
symbol . For example :

Running :

	

Echoes:

DIR >DIRFILE

	

DIR 1>DIRFILE

MORE <DIRFILE

	

MORE O<DIRFILE
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Filtering Information FIND, MORE, and SORT
You can also redirect the input of a file by filtering information. A
filter reads information from the standard input device, changes the
information in some way, and writes the result to the standard output
device .

There are three OS/2 commands that act as filters :

FIND

	

Searches files for occurrences of specified lines of text,
locates the lines, and sends the specified lines to the output
device .

MORE

	

Receives input and then displays it on an output device,
one screen at a time (useful for long files) . After each
screen, OS/2 pauses with the message

--More--

until you press any key to continue .

SORT

	

Receives input from an input device, sorts the information
(by letter or number), and writes the changed information
to an output device .

These filter commands only work with ASCII (readable) text files .
(ASCII is the standard code used for information interchange among
data processing systems, data communication systems, and
associated equipment .)

Note: Refer to the OS/2 Command Reference for the syntax
diagrams, associated parameters, and examples of the FIND,
MORE, and SORT commands .
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Piping Output to Another Command 11

OS/2 has a feature that allows the output of one program, as it would
normally display on the screen, to be used as the input to another
program without re-entering the information on the keyboard . Piping,
as this is called, is symbolized by a vertical bar ( ;) . Pipes are a fixed
length with the maximum that any pipe can hold being 64KB . Here
are some examples using the piping symbol ( ;) with OS/2 filters and
redirection symbols :

If you want to :

	

Enter:

Display the names of all the files in the

	

DIR A : ; FIND "IBM"
current directory of drive A that contain the
word IBM

Display a sorted directory listing on your

	

DIR ; SORT
standard output device

Place the sorted directory in a file named

	

DIR ; SORT > ABCLIST
ABCLIST

Display the contents of a file named

	

TYPE ABCLIST ; MORE
ABCLIST on your screen, and pause after
each screen with the message

--More--

Pipe the output of DIR to SORT, sort the

	

DIR I SORT /+24
listing starting with the 25th column, and
send the output to your screen

Cause the output listing from DIR to be

	

DIR ; SORT ; MORE
used by SORT as its input, redirect the
output to your screen, and pause after each
screen with the message

--More--

Note: Depending on the code page or keyboard you are using for
your particular country, the piping symbol (ASCII character
124) may be shown as a solid vertical bar ( I ) or a split vertical
bar ( I ) . The appearance of the symbol on your screen may
not match the symbol engraved on the key .
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Processing Commands Conditionally &&, 11
There are special symbols that allow you to make the processing of
commands dependent on the success or failure of other commands .

The && symbol allows a command to run only if the one that
precedes it is successful . That is, if the command on the left side of
the AND operator (&&) is successful, the command on the right side
is performed . For example :

If you enter :

	

OS/2 displays:

DIR MEMO && TYPE MEMO

	

the contents of a file named MEMO
on the screen (TYPE MEMO) only if it
exists in your current directory .

The U symbol allows a command to run only if the command that
precedes it fails . That is, if the command on the left side of the OR
operator ('') is not successful, the command on the right side is
performed. For example :

If you enter :

	

OS/2 displays :

TYPE MEMO ; ; TYPE \ABC\MEMO

	

the contents of the MEMO file in the
current directory . If it does not exist
there, OS/2 looks for a file named
MEMO in the ABC subdirectory to
process TYPE \ABC\MEMO.
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Separating and Grouping Commands &, 0
The & command separator symbol processes commands on both
sides of the symbol, from left to right . It produces the output from
both commands after the second command is run. For example :

If you enter :

	

OS/2 displays:

DIR C :* .BAT & DIR D :* .CMD

	

the directory of files with an
extension of BAT in drive C followed
by the directory of files with an
extension of CMD in drive D .

The () grouping symbol gathers internal commands, thereby
ensuring that the commands are run in the proper order. For
example:

If you enter :

	

OS/2 sorts :

DIR A && TYPE A ; SORT > AZ

or

DIR A && (TYPE A ; SORT > AZ)

the file and puts the results in a file
named AZ, only if a file named A
exists .

(DIR A && TYPE A) ; SORT > AZ

	

the directory entry for A and the
contents of the A file .

If you use parentheses and you forget to enter the right parenthesis,
OS/2 displays the message :

More?

You have two choices : either finish the command with the missing
closing parenthesis and press the Enter key, or press the Ctrl and
Break keys together to cancel the command .

OS/2 Command Symbols 85



Allowing Symbols to Be Input as Text ^
The escape symbol '*'allows input of command symbols as text .
When used outside quoted strings during command line input, the A

symbol causes the next character following it to be treated as normal
text. The following is an example of its effect when you use it with the
ECHO batch command .

Note: A string is a sequence of elements of the same nature, such as
characters in text .

If you enter:

	

ECHO displays:

ECHO HELLO ^>FILE

	

HELLO >FILE

If you want the escape symbol (^) to display, enter it 3 times (") as
follows :

If you enter :

	

ECHO displays :

ECHO HELLO ^^^>FILE

	

HELLO A>FILE

The first escape symbol tells the second escape symbol to print and
the third escape symbol tells the redirect output symbol to print .
Keep in mind that only in the above example would you enter the ^
three times . (Normally you would need to enter it only twice .)
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Chapter 5. Problem Determination

OS/2 has several utilities to ensure better reliability, availability, and
serviceability (RAS) . IBM provides these utilities to help i n gathering
information to isolate and correct system problems . This chapter
outlines the utilities available for your personal use and also
discusses those intended for use with help from your IBM service
coordinator .

Note: If you used the Select System Configuration choice from the
Select System Installation panel and didn't select
Serviceability and Diagnostic Aids, the utilities intended for
your IBM service coordinator are not available .

Utilities Available to You
There are certain utilities available to you that do not require
assistance from the service coordinator .

HELP - Providing System Help
HELP is one such utility, providing a help screen that tells you how to :

•

	

Switch to the next session or to the Task List
•

	

Exit the current OS/2 session
•

	

Find information in the OS/2 Command Reference
•

	

Get additional help on error and warning messages .

In addition, HELP displays a help line as a part of the command
prompt. This reminds you which keys to press to return to the
Presentation Manager. It also requests additional information related
to warning and error messages .

AUTOFAIL - Displaying Error Information
This CONFIG .SYS statement allows the OS/2 program to display
information about error conditions such as hard errors . A hard error
is an error condition that requires you to reconfigure the system or
remove the source of the error before the system can resume reliable
operation .

The system default is AUTOFAIL=NO, which causes a pop-up
window to appear that informs you of an error condition . The YES
parameter causes the appropriate error code to appear rather than a
pop-up window .
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PSTAT - Displaying Process Status Information
PSTAT displays process status information such as current processes
and threads, system semaphores, dynamic linked libraries, and
shared memory. PSTAT helps you determine which threads are
running in the system, along with their current status and current
priorities .

This command also aids you in determining why a given thread is
blocked (waiting on a system event), or why the thread's performance
is slow (low priority compared to other threads .) Moreover, it
displays the process ID which has been assigned from each process .
The process I D can then be used as input to the TRACE utility for
tracing on a per-process basis .

Diagnostic Tools for the Service Coordinator
OS/2 provides additional aids for gathering information to help isolate
problems, allowing for more productive serviceability for system
problems . These tools are intended for use only with help from your
IBM service coordinator .

Your service coordinator is the first level of customer assistance
whose role includes investigating hardware and software problems .
This person, who could be either an IBM authorized dealer or the
person assigned to be the coordinator for your particular
organization, will contact IBM, if necessary . Please do not provide
IBM with a dump or any other materials unless directed to do so by
the IBM service coordinator or an IBM service representative .

Error Logging Facility
To aid in system problem diagnosis, OS/2 offers a facility for logging
certain system errors. Providing information of this kind allows IBM
to determine and fix problems in a timely manner . Error Logging
also provides the capability to generate a formatted error log report .
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LOG - Log System Events
This statement provides information used for problem determination
by logging system events and placing a record of each event in the
System Log file. By adding this statement in the CONFIG .SYS file,
you can specify whether you want to record system events in the log
file. In addition, using LOG parameters, you can specify :

•

	

The buffer size the System Logging Facility uses to store events .
•

	

The minimum amount of free space that must be left on the fixed
disk as records are added to the System Log file .

•

	

That new entries be added to the beginning of the file when the
size of that file is reached .

•

	

The /F parameter, which allows you to specify the name of the log
file created by the System Logging Facility .

SYSLOG - Start or Stop Adding Log File Entries
SYSLOG postpones or continues logging of events in the System Log
file. Entering this command without a parameter causes OS/2 to
display the OS/2 Log Facility Main Menu . From this menu you can
display or print the log file and start or stop adding entries .

System Trace Facility
The system trace facility is used for analysis to capture a sequence of
system events, function calls, or data . The record is usually
produced for debugging purposes . After the trace data is captured,
the system trace formatter is used to retrieve it from the system trace
buffer and format the data to your display, printer, or file .

On request, the OS/2 system trace facility records certain important
events i n the system and system extensions i n a circular buffer .

If a system problem can be duplicated without a system crash, the
TRACE OFF function allows tracing to be stopped after the problem
has been recreated . This allows the state of the trace buffer to be
preserved from the time the TRACE OFF command is processed .

The tracing mechanism is performance critical ; therefore, no
statistical processing of recorded data is performed by the tracing
routines .
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Records in the buffer are identified by major and minor codes (you
can only specify TRACE by major code in the CONFIG .SYS file) .
Variable length data records are also supported and new trace events
can be added as required . Some of the data which may be recorded
in the circular buffer will include system events such as interrupts
and task switches .

If you need to use the system trace facility, an IBM service
representative will provide the buffer size . When the trace
completes, you can use the trace formatter (TRACEFMT) to organize
the data into a report . This helps you isolate causes of problems in
the OS/2 system by formatting the information placed in the trace
buffer by the TRACE facility .

OS/2 enhancements to the TRACE utility allow you to :

•

	

Trace a given process or set of processes, so that you can focus
on the events about the specified process without intermixing
events from other processes in the system . This reduces the
possibility of trace buffer overflow by minimizing the number of
events which are captured . Analyzing the formatted trace data is
quicker and easier since only events of the specified process are
recorded and displayed .

•

	

Trace by minor code, which allows you to specify exactly what
events are to be traced . Since each major event code contains
many minor codes, you often must trace events that are of no
interest .

•

	

Suspend and resume system tracing, which allows you to
suspend system tracing without removing trace points .

•

	

Clear the system trace buffer, which allows you to clear the trace
buffer after viewing the contents of the trace buffer .
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CREATEDD and the Stand-Alone Dump Facility
The Create Dump Diskette (CREATEDD) facility creates a diskette to
be used with the Stand-Alone Dump Facility which contains the
contents of storage at a specified point in time .

The Stand-Alone Dump Facility runs independently of OS/2 and
provides an image of physical memory . The Stand-Alone Dump
Facility puts the contents of storage onto a set of diskettes called
dump diskettes. With the help of an IBM service representative, you
can use this facility for problem determination by following a system
error that did not destroy the storage resident dump code and data .

A stand-alone dump is only taken at the direction of OS/2 support
personnel . This dump will normally be taken in the case of a system
hang or wait state. The dump is a physical record of RAM storage at
the time of the system hang condition . The diskette containing the
dump is sent to an OS/2 support location for analysis .

PATCH - Apply Software Repairs
This utility should be used by those who understand the need for a
patch, how to make a patch, and the effect the patch has on the
operation of a program .

PATCH has prompts that guide you through inserting changes to the
OS/2 system software . If you select the option to automatically apply
patches shipped by IBM to make fixes to IBM-supplied code,
verification is performed before the patch is applied. Verification can
not be done on non-IBM-supplied patches .

If you select the option to manually apply a patch, you are asked to
supply an offset where the patch is to be made. PATCH displays the
contents of the location specified by the offset and allows you to enter
the patch . Both the offset and the patch contents are expected to be
entered in hexadecimal notation .
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Recovering User and System INI Files

System settings, such as application defaults, display options, and file

options, are contained in the OS2 .INI startup file located in the C :\OS2

directory of your fixed disk . There is also a system file called

OS2SYS.IN1, which contains information about installed fonts and

printer drivers. In the event that you receive a message stating that

the OS2.INI file is corrupted, the OS2.INI file installed on your system

must be replaced by a valid OS2 .INI file .

During the installation process, the MAKEINI program was added to

the C :\OS2 directory on your fixed disk. The MAKEINI .EXE file

creates a new OS2.IN1 file containing default information . From the

command prompt, you should recreate both the user and system INI

files using the MAKEINI program .

Creating New INI Files

To create new user and system INI files, follow these steps :

1 . Insert the installation diskette in drive A ; then, press and hold the

Ctrl, Alt, and Del keys together to restart the system .

2. Press the Escape (Esc) key when OS/2 displays the IBM logo .

3. To change to drive C, enter :

C •

4. To change to the OS2 subdi rectory, enter :

CD \OS2

5. To erase the current OS2.INI file, enter :

ERASE OS2 .INI

6. To erase the current OS2SYS .IN1 file, enter :

ERASE OS2SYS .INI

7 . To recreate a new user INI file, enter :

MAKEINI OS2 .INI INI .RC

8. To recreate a new system INI file, enter :

MAKEINI OS2SYS .INI INISYS .RC

9. Remove the Installation diskette from drive A .

10. Restart the system by pressing the Ctrl, Alt, and Del keys

together .
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Note: You can rename the OS2 .INI and OS2SYS .INI files to names of
your choice as long as the same file names are reflected in the
PROTSHELL statement in the CONFIG.SYS file .

Recovering the CONFIG.SYS File
The CONFIG.SYS file contains command statements that configure
your system for both DOS and OS/2 modes . If CONFIG.SYS gets
corrupted, you cannot restart the system or edit the file . In the event
that the CONFIG .SYS file gets corrupted, follow these steps :

1 . Insert the Installation diskette in drive A ; then, press and hold the
Ctrl, Alt, and Del keys together to restart the system .

2. Press the Escape (Esc) key when OS/2 displays the IBM logo .

3. To change to drive C, enter:

C :

4. To rename the corrupted CONFIG .SYS file, enter :

REN CONFIG .SYS CONFIG .BAD

5. To copy the CONFIG .SYS backup file to the root directory, enter :

COPY C :\0S2\INSTALL\CONFIG .SYS C :\CONFIG .SYS

6. Remove the Installation diskette from drive A .

7. Restart the system by pressing the Ctrl, Alt, and Del keys
together.

Note: If you updated the CONFIG .SYS file after OS/2 installation, use
an editor to correct the damaged file (now named
CONFIG.BAD) or keep the current CONFIG .SYS file .
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Chapter 6. DOS Mode Compatibility

Often, OS/2 is installed on personal computers that were previously
running under IBM DOS . To make the transition easier for you, OS/2
provides a DOS compatibility mode which allows many existing DOS
programs to run without modification .

This chapter addresses some of the considerations that apply either
when programs need to be run in a mixed environment or when DOS
programs need to be run on an OS/2 system . In addition, it lists DOS
mode limitations and contains advice on changes that may be
required on your system .

Compatibility with IBM DOS 4.0
When using the OS/2 program, you can choose DOS mode, which is
an environment patterned after IBM Disk Operating System Version
4.0. However, some features of IBM DOS 4 .0 commands and utilities
are not supported or have slightly changed in the OS/2 program's
DOS mode. The following listing is an overview of these differences .

ANSI.SYS
The /L parameter is not supported .

APPEND
The /X parameter is not supported .

BACKUP
This command is supported in OS/2 mode only . Along with new
error levels, support has been added for long file names, meta
characters, and extended attributes .

BUFFERS
The /E parameter is not supported .

CHKDSK
Displays file system type information . Along with new error
levels, support has been added for long file names, meta
characters, and extended attributes . Memory statistics are
reported in DOS mode only . CHKDSK of an HPFS volume is
supported in OS/2 mode only .

COMP
End-of-file checking has been removed . You can continue
comparing if the file sizes differ . Along with new error levels,
support has been added for long file names and meta characters .
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COUNTRY
The statement specifying the file path of the code page is not
supported .

CTTY
This command is not supported .

DISKCOMP
The /1 and /8 parameters are ignored . DISKCOMP determines
the number of sides and sectors by the source diskette .
DISKCOMP also skips the volume serial number during
comparison .

DISKCOPY
The /1 and /8 parameters are ignored . DISKCOPY determines the
number of sides by the source diskette . Also, the target diskette
is an identical copy except for the volume serial number .

DISPLAY.SYS
This device driver is not supported because the function is
inherent.

DOSSHELL
This command is not supported . Presentation Manager is used
for the protect mode shell .

EXE2BIN
This command is not supported .

FASTOPEN
This command is not supported because the function is inherent .

FILES
This command is not supported .
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FORMAT
The following are changed functions :

•

	

The /S, /8, /B, and /1 parameters are not supported .

•

	

Along with new error levels, a new /FS parameter has been
added .

GRAPHICS
This command is not supported because the function is handled
by the OS/2 spooler .

IFSFUNC
This command is not supported because the function is inherent .

INSTALL
This command is not supported .

KEYB
This command is supported in OS/2 mode only .

LABEL
The option to delete the label is not supported .

LASTDRIVE
This command is not supported .

MEM
This command is not supported .

MODE
The following are deleted functions :

•

	

DISPLAY option : Shifting of screen and test pattern are not
supported .

•

	

ASYNC option: Infinite Retry (P) is replaced by the Extended
Printer Retry option, and the Ctrl+Break function is not
supported .

•

	

Redirection of parallel to serial support is not supported i n
MODE because this function is now supported by the SPOOL
command.

•

	

Code page options are not supported because this function is
enhanced by CODEPAGE and DEVINFO statements in the
CONFIG .SYS file and the CHCP command .

•

	

RATE option is not supported .

•

	

DELAY option is not supported .
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NLSFUNC
This command is not supported because the function is inherent .

PATCH
This command has long name support .

PRINT
The /B, /U, /M, /S, /Q, and /P parameters are not supported .

RECOVER
Displays file system type information . Along with new error
levels, support has been added for long file names, meta
characters, and extended attributes . RECOVER of an HPFS
volume is supported in OS/2 mode only .

RESTORE
This command is supported in OS/2 mode only . Along with new
error levels, support has been added for long file names, meta
characters, and extended attributes .

SELECT
This command is not supported because the function has been
replaced by the installation program .

SHARE
This command is not supported because the function is inherent .

STACKS
This command is not supported .

SYS
This command is not supported as an external command .

TREE
The /A parameter is not supported . Also, long name support has
been added .

VDISK.SYS
The /E parameter is not supported .

XCOPY
Along with new error levels, support has been added for long file
names, meta characters, and extended attributes .

XMAEM.SYS
This device driver is not supported .

XMA2EMS.SYS
This device driver is not supported .
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Installing Copy-Protected DOS Programs
Some copy-protected DOS programs depend on the operating system
or a version of the operating system for correct installation . Refer to
your program documentation for specific instructions on which
operating system is supported before installing or removing the
program . Also, always install or remove these programs from the
DOS command prompt .

Copy-protected DOS programs may already be installed on your fixed
disk. Once installed, many of these programs can run in DOS mode .

Some copy-protected DOS programs rely on timing during their
installation and initial startup . During installation and initial startup
of these programs, make sure that no OS/2 program is running and
that you do not switch out of DOS mode . This reduces the possibility
of an error occurring .

Printer Spooling
OS/2 has its own print spooler to control information going to the
printer from different sources . This allows OS/2 programs to send
output to a printer while your DOS program is printing .

Similarly, a print job started by your DOS program may not print
immediately . This could be either because an OS/2 program has a
job printing, or because the DOS program print job has not
completed. To force a DOS program print job to end, press the Ctrl,
Alt, and PrtSc keys together. Another way to end a DOS program
print job is to set DOS Timeout in the Print Manager . Setting DOS
Timeout lets the spooler know when a DOS job has completed
printing so that the next job can be printed . You can specify a
time-out value of 1 to 65,535 seconds . The spool file is automatically
closed after the specified time expires .

When your DOS program prints using the OS/2 print spooler, more
time may be required than when running without the print spooler . If
the print spooler has several jobs to print, jobs are printed
sequentially .

Note: For more information on spooling, refer to the SPOOL
command in the OS/2 Command Reference.
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Serial Device Support
Serial devices, such as printers and plotters, receive output from the
asynchronous communication (COM) port in your system . In OS/2
you must select the serial device (COM port) support needed by your
OS/2 programs when you configure your system . Refer to the
DEVICE =C:\OS2\COMOx.SYS statement in the OS/2 Command
Reference for further information and examples .

Most existing DOS mode programs, however, are not written to use
OS/2 COM port support. You need to select serial device support
during system installation only if you do one or more of the following :

•

	

Set asynchronous communication modes using the MODE
command

•

	

Redirect parallel printer data (LPT1, LPT2, or LPT3) to a serial
device (COM1, COM2, or COM3) using the SPOOL command

•

	

Run OS/2 programs that perform input or output to COM1, COM2,
or COM3.

Setting Asynchronous Communications Modes
In DOS mode, the MODE command is used to set asynchronous
communication modes for a serial printer or plotter, just as it is in
IBM DOS. For example, enter the following to set the baud rate for
COM 1 to 9600, the parity to NONE, the databits to 8, and the stopbits
to 1 :

d:\path\MODE COM1 :9600,N,8,1

Notes:

1 . A DEVICE= C :\OS2\COMOx.SYS statement must be in the
CONFIG.SYS file for the OS/2 program to recognize COM1 as a
device name .

2. Refer to the OS/2 Command Reference for further information on
the MODE command .
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Redirecting Parallel Printer Output to a Serial Device
In OS/2, redirection of parallel printer (LPT1, LPT2, or LPT3) output to
a serial device (COM1, COM2, or COM3) is supported by the SPOOL
command, not by the MODE command as in IBM DOS .

The OS/2 system default is to start the spooler and direct LPT1 to
LPT1, LPT2 to LPT2 and LPT3 to LPT3 . The spooler can be turned off
by using the Print Manager and restarting the system . Redirection
can be changed by issuing the SPOOL command dynamically .

Sending Output to Serial Devices
If you have a DOS program that uses a serial printer or plotter for
output and your CONFIG .SYS file contains a
DEVICE= C :\OS2\COMOx.SYS statement, you may need to use the
SETCOM40 command in the DOS session .

Some existing IBM DOS programs need the address of the COM port
to which the serial printer or plotter is attached to send data to these
devices .

SETCOM40 provides these programs with the COM port address . If
you are not sure that your program needs this information, use
SETCOM40 in case it does. Refer to SETCOM40 in the OS/2
Command Reference for further instructions .
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Managing Programs Using Serial Devices
Some IBM DOS programs have not been written for a multitasking
environment. OS/2 cannot always manage programs using serial
devices in DOS mode. These programs go to the serial device and
try to program the COM port hardware instead of first seeing if the
device is in use by another program .

To use the same serial printer or plotter in the DOS session and OS/2
sessions, you must manage the DOS program's use of these devices .
When running a program that uses the COM port device in DOS
mode, make sure that no other OS/2 program simultaneously uses
the same COM port. Let your DOS program finish printing or plotting
before switching to an OS/2 session ; otherwise, unpredictable results,
such as intermixed output, can occur.

Note: Even though the DOS program appears to be the only program
running, there can be OS/2 programs running in background
OS/2 sessions. These background OS/2 programs can
interfere with the foreground DOS program if both
simultaneously attempt to access the COM port .

To manage the printing or plotting performed by your DOS programs :

•

	

Make sure that the DEVICE= C :\OS2\COMOx.SYS statement is
added to your CONFIG.SYS file .

•

	

Issue the MODE command to set the COM port's asynchronous
communication mode so that it correctly interfaces to your serial
printer or plotter .

•

	

If an OS/2 program (such as SPOOL) is using that COM port with
a serial printer or plotter, let it finish printing or plotting before
using the same COM port device from the DOS session .
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When the OS/2 programs have finished printing :

1 . At the DOS command prompt, enter :

SETCOM40 COMx=ON

2. Start the DOS mode program and use the serial printer or plotter
in DOS mode; then, exit the program when completed .

3. At the DOS command prompt, enter :

SETCOM40 COMx=OFF

Note: Replace x with 1, 2, or 3 for the COM port being accessed .

Using a Mouse
If you indicated your mouse type during OS/2 system installation, the
correct OS/2 mouse device driver is already specified in your
CONFIG .SYS file. Note that only OS/2 mouse device drivers are
supported .

Using Programs with Enhanced Graphics
Features
For some programs using an Enhanced Graphics Adapter or IBM
PS/2 8514/A display adapter, the system might not be able to restore
the program's graphics screen when you switch to DOS mode and
then switch back again . If you are not able to restore the program's
graphics screen, do not switch from DOS mode until you have
completed the task .
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Chapter 7. Creating and Using Procedures
Language 2/REXX and Batch Files
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Batch files can be created for both DOS and OS/2 modes. Two
languages can be used in the OS/2 mode : the first language consists
of OS/2 commands, and the second language is Procedures
Language 2/REXX (referred to as REXX in the remainder of this
chapter) . The first part of this chapter covers the use of, and the rules
for, writing batch files using OS/2 and DOS mode commands .

The second half of this chapter briefly describes the use of some of
the REXX language instructions .

REXX is designated as the Systems Application Architecture*
Procedures Language for the OS/2 operating system . It was designed
to make programs easier to write and debug. High-quality
programming can now be achieved using common English words in a
natural syntax flow that both beginning and experienced
programmers can understand . REXX uses a few powerful,
general-purpose programming functions and common arithmetical
abilities, as well as OS/2 commands, within a simple framework .
Existing batch files can now be modified, given more function, and
replaced with a more powerful REXX procedure .

About Batch Files
A batch file is a common processing file containing several
commands. When you run a batch file, the OS/2 command processor
processes the commands in the batch file, one at a time . If you have
a repetitive process that requires you to enter a series of commands
at the command prompt, using a batch file that contains these
commands shortens process time and reduces the possibility of
typing errors . All batch files intended for use in DOS mode have a
.BAT file name extension ; batch files intended for use in OS/2 mode
have a .CMD file name extension .

Running Batch Files and REXX Procedures

Some general rules apply when you run batch files :

•

	

You can run a batch file :

- By typing the batch file name at an OS/2 or DOS command
prompt .

* Trademark of the IBM Corporation .
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By adding it to a program group window in the Desktop
Manager (see "Adding Titles from the Desktop Manager" in
Getting Started) .

- By using the File Manager and selecting the Associate choice
from the File pull-down . For information on associating
programs and files, see Getting Started .

•

	

It is not necessary to type the CMD or BAT extension to start a
batch file or REXX procedure, unless you have a program with
the same name as the batch file or REXX procedure .

•

	

A batch file with an extension of CMD will not run in a DOS mode
session, and a batch file with an extension of BAT will not run in
an OS/2 mode session .

•

	

REXX files only operate in OS/2 mode, must have a file name
extension of CMD, and must start with a comment line .

•

	

If you remove a diskette containing a processing batch file, the
operating system prompts you to insert it again so that the
operating system can read the next command .

•

	

The operating system remembers the directory the batch file
started in. Therefore, the commands within the batch file might
change the current directory during processing .

•

	

Batch files process quickly, if placed on a virtual disk . Refer to
the VDISK.SYS device driver in the OS/2 Command Reference for
information on virtual disks .

Browsing REXX Procedures Output

The operating system offers you the capability to browse the output of
your REXX procedures . To do this, you must start the PMREXX .EXE
program . By using PMREXX, you add the following functions and
abilities to REXX :

•

	

A window for the display of the output of a REXX procedure, such
as :
- The SAY instruction output
- The STDOUT and STDERR outputs from secondary processes

started from a REXX procedures file
- The REXX TRACE output (not to be confused with OS/2

tracing) .
•

	

An input window for :
- The PULL instruction in all of its forms
- The STDIN data for secondary processes started from a REXX

procedures file .
•

	

A browsing, scrolling, and clipboard capability for REXX output .
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• A selection of fonts for the output window .
•

	

A simple environment for experimenting with REXX instructions
through the use of the REXXTRY .CMD program. REXXTRY
interactively interprets REXX instructions and can be started
from :

A windowed environment by typing REXXTRY at the command
prompt

- Presentation Manager by selecting PMREXX REXXTRY .

Starting the PMREXX Program

There are several ways to start the PMREXX program :

•

	

You can start the PMREXX program and a REXX procedure from
an OS/2 command prompt . You do this by typing PMREXX and a
target procedure name that generates an output or input function,
as follows :

PMREXX filename .CMD arguments

where typing the arguments and CMD extension of the procedure
name are optional .

•

	

You can associate a PMREXX file with a REXX procedure and
then start it from the File Manager . Associating files is described
in the Getting Started book.

•

	

If you are using a mouse, you can start PMREXX from the File
Manager window :

1 . In the Group - Main window, double-click on File Manager, or
select it and press the Enter key .

The Directory Tree window is displayed .

2. Double-click on the OS2 directory, or select it and press the
Enter key .

The list of files in the OS2 directory is displayed .

3. Press and hold down mouse button 2 on REXXTRY .CMD; then
drag the file to the PMREXX .EXE file. (Release mouse button
2 .

Note: You can move or size the PMREXX .EXE window or
select various parts on it, the same way that you do with
other windows. If you are not familiar with these window
movement functions, see Getting Started.
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Once the output of the batch file is displayed in PMREXX, you can

select the action bar choices to take advantage of the following

PMREXX browsing features :

Action Bar Choice

	

Description

File

	

Save, Save As, and Exit the process

Edit

	

Copy, Cut and Paste to the input, Clear the

output, and Select All lines

Options

	

Restart the process, Interactive Trace, and

Set font

Actions

	

Halt procedure, Trace next clause, Re-do the

last clause, and Set Trace off

Help

	

Help for Help, Extended help, and Help on

key definitions .

The PMREXX Trace Function

The trace function in PMREXX turns on interactive tracing for the

currently operating REXX procedure. This is done by adding the /T

parameter to the PMREXX command before typing the file name or

turning trace on by selecting it from the Options pull-down . To start

the trace function from the command prompt, type the command as

follows :

PMREXX /T filename arguments

Ending Batch File Processing

In DOS mode, batch file processing is similar to that in IBM DOS . If a

filename.BAT is running in the DOS session and you press the

Control (Ctrl)+Break keys, the following prompt is displayed :

Terminate batch job (Y/N)?

If you type Y in response to this prompt, the batch file ends and

control is returned to the operating system . If you type N, the batch

file resumes processing .

If you press the Ctrl+Break keys together while a filename .CMD is

running, it ends, and control is returned to the operating system .

Treating batch files that are dependent on other batch files as a

single command avoids unpredictable results in the multitasking

environment of the OS/2 program . If a batch file that sets the
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environment variables with the SETLOCAL command is interrupted,

all environment values that were set are no longer in effect . If the

batch file is allowed to resume processing, the result might be

different from what was intended .

Special Batch Files

During the installation program, an AUTOEXEC .BAT batch file is

created and is placed in the root directory of the startup drive . You

can change it, the way you would any other batch file, by using an

editor such as the System Editor . You can also create a batch file

called STARTUP.CMD, if you want to use the OS/2 autostart facility .

(Information on the STARTUP.CMD file and the autostart facility can

be found on page 111 .)

AUTOEXEC.BAT File

When you select the DOS mode command prompt from Presentation

Manager, the DOS mode command processor searches for a special

batch file named AUTOEXEC .BAT in the root directory of the startup

drive. When it finds the AUTOEXEC .BAT file, it uses the commands i n

the batch file to define the way it starts DOS mode and its

environment. (AUTOEXEC.BAT does not run in OS/2 mode .)

The following is an example of what you might find in the

AUTOEXEC.BAT file created during the installation program :

PATH C :\OS2 ;C :\OS2\SYSTEM ;C :\ ;

SET COMSPEC=C :\OS2\COMMAND .COM

APPEND=C :\OS2 ;C :\OS2\SYSTEM ;C :\ ;

CALL HELP ON

The PATH command provides a search path to OS/2 external

commands. You can add your own paths to application programs .

The SET COMSPEC command tells the operating system where it

can find the COMMAND.COM

DOS mode processor

.

The APPEND command specifies paths to data files .

The CALL command runs a batch file that turns on the HELP bar as

part of your OS/2 command prompt .

The AUTOEXEC.BAT file can also include the command PROMPT

$P$G to set and customize the command prompt .
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Note: If you include a PROMPT command after the CALL HELP ON
command, the PROMPT command overrides the HELP prompt and
the HELP bar is deactivated .

If an AUTOEXEC .BAT file exists, you are not prompted for the date
and time when you start DOS mode from Presentation Manager . If an
AUTOEXEC.BAT file does not exist, you are prompted for the date
and time every time you start DOS mode . Because the system uses
the clock in your workstation, it is not necessary to set the time and
date each time you start the system or start DOS mode .

STARTUP.CMD File

You can take advantage of the OS/2 autostart facility by creating a
special batch file called STARTUP .CMD. Then when you start the
operating system, the first OS/2 session is started automatically and
displayed on your screen . If there is no STARTUP .CMD file, the
Group-Main window of Presentation Manager is displayed .

To start programs in additional OS/2 sessions, you can use the
internal command START in the STARTUP.CMD file . The following
are examples of STARTUP .CMD batch files :

Example 1 : Assume that you have the following commands in a
STARTUP.CMD file :

PATH C :\ ;C :\OS2 ;C :\MISCPGM ;
START CALC
START WP
START
CALENDAR

This is what happens when you start the operating system :

1 . STARTUP.CMD starts a command processor in a windowed
session that is displayed on your screen . This is where the
statements in STARTUP.CMD are processed .

2. The PATH command sets the path for the first session .

3 . The first START command starts a second session that runs a
spreadsheet program .

4. The next START command starts a third session that runs a word
processing program .

5. The last START command starts a command processor in a fourth
session .
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6. The last command starts the CALENDAR program in the first
session .

Note: Environment variables defined in STARTUP .CMD are only
active in the first session . Any other sessions started with START
commands are not affected . Thus, the path specified in this example
only affects programs that run in the session where the CALENDAR
program is running .

Example 2: Assume that you have these commands in a
STARTUP.CMD file :

START CALC
START WP

When you start the system, the sessions for the spreadsheet and
word processing applications are started . The first session started by
STARTUP.CMD displays the command prompt on your screen .

Example 3: When this STARTUP .CMD file runs :

START ENV
START CALC
START WP
EXIT

1 . START ENV starts an environment batch file to set the
environment variables .

2 . The sessions for the spreadsheet and word processing
applications are started .

3. The EXIT command causes the command processor started in the
first session by STARTUP .CMD to end . The Group-Main window
is then displayed .

A program specified with a START command can be an internal or
external command, an application program, or a batch file . If the
EXIT command is the last statement of a batch file, when the batch
file ends, the command processor is exited and the session ends .

Guidelines for Batch Files Run By START Commands

Environment variables for a session are set by having a START
command (START ENV) in a STARTUP .CMD batch file . The following
is an example of a file called ENV.CMD, and shows what an
environment-setting batch file might contain :
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PATH C :\ ;C :\OS2 ;C :\MISCPGM ;
DPATH C :\ ;C :\OS2 ;C :\LETTERS ;C :\REPORTS ;
PROMPT [EDIT]
EDIT

The last command in this example starts an editing application called
EDIT. When you end the application, the command prompt is
displayed as :

[EDIT]

When you use the START command in STARTUP .CMD to run a batch
file, your batch file should not make assumptions about the
environment, current drive, or current directory . For example, if the
purpose of your batch file is to start a program on a specified drive
within a specified directory, the complete name of the directory
should be specified with the CD (change directory) command .

Assume that your batch file starts a program called FILEMAN located
in the \XYZ directory of drive D . Your batch file should look like this :

D :
CD \XYZ

	

Correct Batch File
FILEMAN

Do not assume the default for the current directory is the root
directory, as in this example :

D •

CD XYZ

	

Incorrect Batch File
FILEMAN

For more information, refer to the START command in the OS/2
Command Reference .

Writing Batch Files

The following table lists some commands specifically designed for
general batch file operations. Any command that works on the
command line can be used i n an AUTOEXEC . BAT file or any other
batch file. Refer to the OS/2 Command Reference for more
information on these commands .
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Warning : Because the operating system can operate in a
multitasking environment, it is possible to change, delete, or replace
a batch file or REXX procedure in one operating session while it is
running in another session .

While this can be considered a useful tool to some computer
operators, it can cause problems and unexpected results for others, if
these files are altered during their operation cycle .

Command

	

Description

APPEND

	

Tells the system where to locate data files outside
of the current directory when this command is
added to the AUTOEXEC . BAT file .

CALL

	

Nests a batch file within a batch file .

ECHO

	

Allows or prevents the display of OS/2 commands
while a batch file is running .

ENDLOCAL

	

Restores the drive, directory, and variables that
were in effect before a SETLOCAL command was
issued .

EXTPROC

	

Defines an external batch file processor .

FOR

	

Allows repetitive processing of commands within
a batch file .

GOTO

	

Transfers batch processing to a specified label .

IF

	

Allows conditional processing of commands
within a batch file .

PATH

	

Tells the system where to set the search path .

PAUSE

	

Suspends processing of the batch file .

REM

	

Displays remarks from within a batch file .

SET

	

Sets an environment variable equal to a string for
later use.

SETLOCAL

	

Sets the drive, directory and variables that are
peculiar to the current batch file .

SHIFT

	

Allows more than 10 replaceable parameters in a
batch file .
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Guidelines When Writing Batch Files

Follow these guidelines when writing batch files :

•

	

One purpose of batch files is to simplify jobs ; it is a good practice
to keep the names simple too .

•

	

Do not name batch files with the same names as internal
commands, such as .COM or .EXE and a batch file with the same
file name . If you do, then it is necessary to type the file name and
extension when starting the batch file. The command interpreter
processes files such as these in the following order :

1 . COM
2 . .EXE
3 . BAT or .CMD .

•

	

Chaining allows you to start one batch file from another when the
first finishes processing . You can chain batch files by making the
last command in a batch file the name of another batch file .

•

	

You can nest batch files by using the CALL command . This calls
a second batch file from within another batch file without ending
the first batch file . Nesting allows all of the commands in the
second batch file to process before returning to the first batch file .

•

	

Any command you can type from the command prompt can be
used i n a batch file .

The two extensions for batch files are as follows :

Mode

	

Extension

DOS

	

filename.BAT

OS/2

	

filename.CMD

Warning: The different batch file extensions for DOS and the OS/2
operating system do not prevent you from putting a command that
works only in one mode into a batch file whose extension is for the
other mode. If you want to use a command in a batch file and you are
not sure if it works in both modes, refer to the command description
i n the OS/2 Command Reference before you use it .

Eliminating the Display of Batch File Commands

The ECHO command allows you to eliminate the display, or echo, of
batch file commands that are processing in either mode . You can
also eliminate, or suppress, echoing by typing an at symbol (@) as
the first character of a batch file command . For example, if you type :
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@CMDNAME

the echoing of the line the command is on is suppressed . If you type :

@ECHO OFF

the echoing of ECHO OFF is suppressed, which in turn suppresses
the lines that follow until an ECHO ON is met .

In OS/2 mode, another method can be used to suppress echoing of
batch file commands: typing /Q in the syntax of the batch file
command. For example :

BATFILE .CMD /Q

This command in a batch file is equivalent to having ECHO OFF as
the first command of the batch file, except that no ECHO OFF
message is displayed .

An ECHO ON command i n the batch file causes echoing of batch file
commands to resume . The /Q, or quiet parameter, can be placed
anywhere in the parameter list following the batch file name .

By including a FOR command and including the @ i n the DO clause,
you can suppress the echoing of the iteration of the loop .

FOR %I IN (* .*) DO @ECHO %I

This example produces a simple list of files as output .

Using Replaceable Parameters

A replaceable parameter (placeholder) is a parameter whose value is
supplied when a batch file is started either from within another batch
file or started at the command prompt. By using replaceable
parameters in a batch file, you can pass information to a batch file
when it is started . These parameters, named %0- %9, are replaced
by other values, such as file names or directories . The %0
parameter is always replaced by the file specification (drive, path,
and file name) of the batch file being started .

For example, if a batch file named SAMPLE .BAT contains these
commands :

COPY %1 %2
TYPE %2 i MORE

the operating system sequentially replaces %0 with the file being
run, and continues replacing parameters %1 and %2, through %9,
with the parameters supplied when the file is started .
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To run the SAMPLE.BAT file and pass values to the replaceable
parameters, type the name of the batch file followed by the
parameters you want sequentially substituted for %1, %2 . For
example:

SAMPLE A :DATA .OLD C :INFO .NEW

The batch file name SAMPLE is substituted for %0 ; A:DATA.OLD is
substituted for %1 ; and C :INFO.NEW is substituted for %2 . Because
the TYPE command is also in the batch file, the C :INFO.NEW file is
then displayed on your screen . The result is the same as if you
entered each of the commands with their parameters, as follows :

COPY A :DATA .OLD C :INFO .NEW
TYPE C :INFO .NEW I MORE

Notes :

1 . If you want to specify more than 10 replaceable parameters, you
can do so by using the SHIFT command .

2. If you want to use a percent sign (%) as part of a file name within
a batch file, you must specify it twice . For example, to specify a
file named ABC% .EXT in the batch file, type ABC%% . EXT .

Using Replaceable Parameters with Names

By using the SET command in a batch file, you can use strings
instead of numbers to define replaceable parameters . Strings are
names or lines of text. The SET command sets one string i n the
environment equal to another string for later use in programs .

When you use a string instead of a number, you must begin and end
the string with a percent sign (%) . However, do not use % when you
define its value with SET .

For example, if a batch file has multiple occurrences of a file name,
and you want to use this batch file at different times and specify a
different file name each time, you can specify the string at each place
in the batch file where you want the file name . For example, if you
use a string called WEEK :

%WEEK%

set the value for WEEK with a SET command that precedes the
occurrences of %WEEK% in the batch file ; for example :

SET WEEK MONDAY .ABC
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Then run your batch file. The batch processor substitutes each
occurrence of this parameter with the value you defined with the SET
command. When you want to specify a different file name, you need
only change the SET command ; for example :

SET WEEK TUESDAY .XYZ

You also can specify environmental system variables as replaceable
parameters in a batch file . For example, suppose you have this
replaceable parameter in your batch file :

lo,PATH %

When the batch processor meets this parameter, the processor
replaces it with the current value in the environment for PATH .

Writing Simple REXX Procedures

Batch files have been around since the very first days of DOS . OS/2
Version 1 .3 now adds the capability of REXX to add more power to
your batch files . As explained in the beginning of this chapter, this
power allows you to do more than just run OS/2 commands in your
batch files .

A REXX procedure is a program that lists a series of tasks in one
common processing file or batch file .

There are many languages that can be used to write programs. The
BASIC language, which is widely used in home computing, has very
few rules, but it requires writing many lines of code when you want to
write an intricate program . Languages such as PL/1, COBOL, C, APL,
and PASCAL have more rules, but they allow you to write more
functions in fewer lines .

REXX combines the simplicity of a programming language such as
BASIC with the ability to write fewer lines, as in a more powerful
language. It is easier to learn, because it uses familiar words and
concepts. REXX allows you to do simple tasks, yet has the ability to
handle complex tasks .
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Requirements

The requirements necessary for getting started in REXX are :

•

	

You need access to an IBM Personal System/2 or IBM Personal
Computer AT with OS/2 Version 1 .3 installed. REXX works only in
OS/2 mode .

•

	

You need to know how to use an editor. Refer to Chapter 8,
"Using the System Editor" on page 167 for information on the
System Editor .

Many of us learn by looking at examples, so examples of REXX
procedures are provided in this chapter . First look at the procedure,
then study the explanation of the examples to see what the procedure
contains. If you like, try the procedure to see how it works .

Writing a REXX Procedure

The following example uses the System Editor . If you are using
another editor, the procedures may vary . To write a REXX procedure
named HELLO .CMD while using the System Editor, follow these
instructions :

1 . At the OS/2 command prompt, type E HELLO .CMD and press the
Enter key .

This starts the System Editor and creates a file named
HELLO.CMD. If you already have a file named HELLO.CMD, just
use another name for the file (for example, HELLO1 .CMD). Keep
this in mind whenever you write a procedure .

2 . Type the procedure HELLO .CMD, as follows :

Notes:

a. In the examples in this chapter, commands and instructions
are shown in uppercase letters ; however, you can use
uppercase or lowercase letters or both .

b. Some instructions i n these examples are indented .
Indentation groups related lines and makes the procedure
easier to read. The number of spaces to indent the
instructions is up to you . The only rule of indentation is to
indent each group of instructions to identify it from all other
groups. It is not necessary to indent, but if you do, it is best
to indent consistently throughout the whole procedure .
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/* An introduction to REXX */
SAY "Hello! I am REXX"
SAY "What's your name?"
PULL who
IF who
THEN
SAY "Hello Stranger"
ELSE
SAY "Hello" who

EXIT

3. Click on File from the action bar (or select it and press the Enter
key) .

4. Click on Save from the File pull-down (or select it and press the
Enter key) to save this file .

5. Click on File from the action bar (or select it and press the Enter
key) .

6. Click on Exit from the File pull-down (or select it and press the
Enter key) to exit the System Editor .

To run the procedure, type the name of the procedure at the OS/2
command prompt as shown :

hello

When the procedure displays a question mark, you can either type
your name or press the Enter key to see the other response .

A brief description of each part of HELLO .CMD follows :

/* An i ntroducti on to REXX */ This is a comment that is used to
explain what the procedure is about . A comment starts with a /* and
ends with a */. All REXX procedures must start with a comment on
line one and column one of the file . The comment tells the command
processor that the procedure being run is a REXX procedure and
distinguishes it from simple batch files .

SAY "Hello! I am REXX ." SAY "What's your name?" These
instructions cause the words between the quotes to be displayed on
your screen .

PULL who The PULL instruction reads the response entered from the
keyboard and puts it into the system's memory. Who is the name of
the place in memory where the user's response is put. Any name
can be used with the PULL instruction .
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I F who - "" The IF instruction tests a condition . The test in this
example determines if who is empty . It is empty if the user types a
space and presses the Enter key or just presses the Enter key .

THEN This instruction runs the instruction that follows, if the tested
condition is true .

SAY "Hello Stranger" This instruction displays Hello Stranger on
the screen .

ELSE If the tested condition is not true, this instruction runs the
instruction that follows .

SAY "Hello" who This instruction displays Hello on the screen,
followed by whatever is i n who .

EXIT This instruction causes the procedure to stop .

Here is what would happen if a person named Bill tried the HELLO
program :

[C :\]hello
Hello! I am REXX .
What's your name?

Hello BILL

[C : \]
If Bill does not type his name, but types a blank space, this happens :

[C :\]hello
Hello! I am REXX .
What's your name?

Hello Stranger

[C :\]

If you tried running HELLO .CMD and it ran without any errors, you
now have run your first procedure. If it did not work, compare your
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procedure with the entries in step 2 on page 119 and see if you typed
something incorrectly .

Using Basic REXX Elements

Some elements (instructions, comments, and so on) for writing REXX
procedures are included i n the following pages . If you like, try the
exercises . Do not worry about making mistakes because you will be
guided through the steps . For a more complete list of REXX
instructions and functions, see Appendix D, "Procedures Language
2/REXX Instructions and Functions ."

Note: When writing a REXX procedure, it is best to use one line for
each element. If you want an element to span more than one line,
you must put a comma (,) at the end of the line to indicate that the
element continues on the next line . If you want to put more than one
element on a line, you must use a semicolon (;) to separate the
elements .

A REXX procedure can contain any or all of the following elements :
comments, strings, instructions, OS/2 commands, assignments,
labels, and internal functions .

These elements, along with some general terms and concepts, are
explained briefly in the following table so that you can see how they
contribute to a REXX procedure .

Term/Concept

	

Description

	

Page

Comment

	

Usually explains what the file does . All

	

123
REXX procedures must start with a
comment that uses the symbols /* to open
the comment and */ to close the comment .

String

	

Groups of characters within matching

	

124
single or double quotes .

Instruction

	

Tells the REXX interpreter what to do .

	

125

SAY

	

Tells the interpreter to display words, or a

	

125
Instruction

	

value computed, on the screen .

PULL

	

Prompts the user with a question mark (?) .

	

125
Instruction

	

Puts an answer in memory . Converts the
input to uppercase .

PARSE PULL

	

Puts an answer in memory . Preserves all

	

125
Instruction

	

input in the case in which it was entered .

EXIT

	

Tells the interpreter to leave the

	

126
Instruction

	

procedure .
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Term/Concept

	

Description

	

Page

Command

	

Anything not identified as a REXX

	

126
instruction, assignment, or label .

Assignment

	

Gives a value to a variable .

	

127

Label

	

A name followed by a colon . Used in

	

127
subroutines .

Mixed case

	

Not changed to uppercase. Use quotes

	

128
around strings to keep uppercase and
lowercase letters as they were typed .

Quotes for

	

To maintain spaces in what is displayed

	

128
spacing

	

when the procedure is run .

Adding blank

	

Using the SAY instruction with nothing

	

129
lines

	

defined after it .

Comment

All REXX procedures must begin with a comment. When the space of
the first line is a comment, the presence of the comment tells the
command interpreter it is about to read and run a REXX procedure .
The symbols used for the comment are as follows :

I*

	

To mark the start of a comment

*I To mark the end of a comment .

When the interpreter finds a /*, it stops interpreting ; when it
encounters a */, it begins interpreting again with the information
following the symbol . The comment can be a few words, several
lines, or no words, as in the following examples :

/* This i s a comment . */

or,

SAY "'Be Prepared!'" /* This comment is on the same line
as the instruction and continues on to the next line */

You can use only /* */ to start a REXX procedure, but it is better to put
a brief description of the procedure between the comment symbols .

The comment can tell what the procedure is for, what kind of input it
can handle, and what kind of output it produces . Comments help you
understand the procedure when you read it later, perhaps to add to it,
improve it, or use it elsewhere in the same procedure or another
procedure .
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When you write procedures, keep in mind that other people may need
to use or modify them . It is a good idea to add comments to the
instructions so that anyone can understand each step . If you do not
use a procedure for a while, you may be glad to have a reminder or
two to jog your memory . ADD.CMD could have comments such as
the following :

SAY "The sum of the two numbers is" numl + num2
EXIT

Longer procedures may require a block of comments to explain a
group of instructions as follows in the next example :

/* Subroutines start here and repeat three times . */
/* The first argument is typed on the display and */
/* the others will follow in order of operation . */

In general, explain your procedure well enough so that others can
understand it .

String

A string is any group of characters inside single quotes or double
quotes. Either single and double quotes can be used, but the
beginning and the ending quote must match . The interpreter stops
interpreting when it sees a quote and looks for the matching quote .
The characters inside the quotes remain as they are typed, with
uppercase and lowercase letters ; for example :

'The Greatest of Ease'
"A Scout is trustworthy ."

are both strings .

To use an apostrophe (single quote) or double quote marks within a
string, use the other quote symbol around the whole string ; for
example :

"Don't count your chickens before they hatch ."

or
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/* This procedure adds two numbers */
SAY "Enter the first number ." /* Enter a number */
PULL numl

	

/* Store the number */
SAY "Enter the second number ." /* Enter another number */
PULL num2

	

/* Store a second number */
/* Add numbers and display */



'Do not count your "chickens" before they hatch .'

You also can use a pair of quotes (the same as those used to mark
the string) as follows :

SAY "Mary said ""He's here ."""

This is interpreted by REXX as :

Mary said "He's here ."

Instruction

An instruction tells the system to do something . Instructions can
contain one or more assignments, labels, or commands and they
usually start on a new line. Following are explanations of some of
the more common instructions .

SAY Instruction

The format for the SAY instruction is :

SAY expression

The expression can be something you want displayed on the screen
or something to be computed, such as an equation :

SAY 5 + 6 "= eleven"

This displays 11

	

eleven on the screen . With the SAY instruction,
anything not in quotes is changed to uppercase or is processed . If
you want something to appear exactly as it is typed, enclose it in
quotes.

PULL and PARSE PULL Instructions

In a procedure, the usual sequence of instructions is to use SAY to
ask a question and PULL to receive the answer . The response typed
by the user is put into system memory . The following procedure does
not work correctly if the PULL instruction comes before the SAY
instruction .

Question : What do you think happens when the following procedure,
NAME.CMQ, is run?

/* Using the PULL Instruction */
SAY "Enter your name"
PULL name

	

/* Puts response from user into memory */
SAY "Hello" name
EXIT
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Answer: NAME.CMD puts a name in memory and then displays that
name anywhere in the file that the word name appears without the
protection of single or double quotes .

If you tried the NAME procedure, you probably noticed that your
name was changed to uppercase . To keep the characters as you type
them, use the PARSE PULL instruction . Here is an example called
CHITCHAT.CMD that uses the PARSE PULL instruction :

/* Using the PARSE PULL Instruction */
SAY "Hello! Are you still there?"
SAY "I forgot your name . What is it?"
PARSE PULL name
SAY name" Are you going to Richard's seminar?"
PULL answer
IF answer = "YES"
THEN
SAY "Good . See you there!"
IF answer - "NO"
THEN
SAY "Sorry, We will miss your input ."

EXIT

The PARSE PULL instruction reads everything from the keyboard
exactly as it is typed, in uppercase or lowercase . In this procedure,
the name is displayed just as you type it. However, answer is
changed to uppercase characters because the PULL instruction was
used. This ensures that if yes . Yes, or YES is typed, the same action
is taken . Refer to "Parsing Words" on page 156 for more information
about PARSE .

EXIT Instruction

The EXIT instruction tells the procedure to end. The EXIT instruction
should be used in a procedure that contains subroutines . Although
the EXIT instruction is optional in some procedures, it is good
programming practice to use it at the end of every procedure .

Command

A command is a word, phrase, or abbreviation that tells the system to
do something. In REXX, anything that is not a REXX instruction,
assignment, or label is considered a command . For example, you
can use the OS/2 commands such as COPY, BACKUP, PRINT, TYPE,
and so on in your procedures .

The OS/2 command TYPE can be used in a REXX procedure :
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/* Issuing commands in REXX */
TYPE hello .cmd
EXIT

Refer to "Issuing OS/2 Commands from a REXX.CMD File" on page
162 for more information .

Assignment

An assignment tells the system that the string should be put i n a
special place in system memory . In the example :

Work - "227 Congress"

the string 227 Congress is stored as the value Work i n system
memory. Because Work can have different values (be reassigned to
mean different things) in different parts of the procedure, it is called a
variable. Variables are discussed in "Variables" on page 130 .

Label

Any word that is followed by a colon (with no space between the word
and the colon) and that is not in quotes is a label . For example :

MYNAME :

A label marks the start of a subroutine. The following example shows
one use of a label (called error) within a procedure :

IF problem - 'yes' then SIGNAL error

error :
SAY 'Problem in your data'
EXIT

For more information on labels, see the "CALL Instruction" on page
160 .
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Mixed Case

You can use mixed case when writing REXX procedures . Writing in
mixed case letters can help you distinguish instructions from
variables and find errors quickly . In the HELLO procedure that
follows, all instructions are uppercase letters, and variables are
lowercase. Briefly study the following procedure and see how using
mixed case helps you :

/* An introduction to REXX */
SAY "Hello! I am REXX ."
SAY "What is your name?"
PULL who
IF who
THEN
SAY "Hello Stranger"

ELSE
SAY "Hello" who

EXIT

Quotes for Spacing

If you put more than one space between words in your procedure, the
interpreter keeps only one space between words . If you want more
space, you must use quotes, as in this procedure, QUOTES .CMD :

/* Example of cases and spaces */
SAY Be a leader Be a friend . /*One space between words*/
SAY "Be

	

a

	

leader,

	

Be

	

a

	

friend,"
SAY Be"

	

"of"

	

"service .
EXIT

When QUOTES.CMD is run, the procedure looks like this on your
screen :

[C :\]QUOTES
BE A LEADER BE A FRIEND .
Be

	

a

	

leader,

	

Be

	

a

	

friend,
BE

	

OF

	

SERVICE .

[c : \l
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Adding Blank Lines

if you do not like the way that QUOTES .CMD is displayed and want to
separate the lines of text with blank lines, you can use the SAY
instruction with nothing defined following it, as in this revision of
QUOTES.CMD :

/* Example of cases and spaces */
SAY

	

/*This displays a blank line .*/
SAY Be a leader Be a friend . /*One space between words */
SAY

	

/*This displays a blank line .*/
SAY "Be

	

a

	

leader,

	

Be

	

a

	

friend,"
SAY Be"

	

"of"

	

"service .
SAY

	

/*This displays a blank line .*/
EXIT

Now when QUOTES.CMD is run, the procedure looks like this on your
screen. Note the blank line between the two sets of text :

[C :\]QUOTES

BE A LEADER BE A FRIEND .

Be

	

a

	

leader,

	

Be

	

a

	

friend,
BE

	

OF

	

SERVICE .

[C : \1

Working with Variables and Arithmetic

An opportunity to write a procedure that you can use repeatedly is
presented on the following pages . First you will see how to use
variables and arithmetic and how to add comments throughout a
procedure to describe how it works .

Working with Variables and Arithmetic covers the following :
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Term/Concept Description/Solution Page

Variable A piece of data given a unique name 130

Value Contents of a variable 130

Operators Symbols used for arithmetic functions 133

Addition + operator 133

Subtraction - operator 133



A variable is a piece of data with a varying value . Within a
procedure, each variable is known by a unique name and is always
referred to by that name .

A period also can be used as a special kind of variable . For
information on using a period as a variable, refer to the Procedures
Language 21REXX User's Guide .

When you choose a name for a variable, the first character must be
one of :

A B C . . .Z ! ?

Lowercase letters are also allowed as a first letter. The interpreter
changes them to uppercase .

The rest of the characters can be any of the preceding characters,
including 0 through 9 .

Value

The value of a variable can change, but the name can not . When you
name a variable (give it a value), it is an assignment . For example,
any statement of the form :

symbol

	

expression

is an assignment statement . You are telling the interpreter to
compute what the expression is and put the result into a variable
called a symbol. It is the same as saying, "Let symbol be made equal
to the result of expression" or every time symbol appears in the text
of a SAY string unprotected by quotes or double quotes, display
expression in its place. The idea of assigning a value to a variable is
the same as the difference between a post office box and the contents
of the box . The box number does not change, but the contents of the
box may be changed at any time . Another example of an assignment
is :

numi

	

10
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The numi assignment has the same meaning as the word symbol has
in the previous example and the value 10 has the same meaning as
the word expression .

One way to give the variable numi a new value is by adding to the old
value in the assignment :

numl

	

numi + 3

The value of numi has now been changed from 10 to 13 .

The PULL instruction also can be used to assign a variable . In the
NAME.CMD example on page 125, the PULL name says to give name
whatever value the user types .

A special concept in REXX is that any variable that has not received a
value has the uppercase version of the variable as its initial value .
For example, if you write in a procedure,

list = 2 20 40
SAY list

you see this on your screen :

2 20 40

As you can see, list receives the values it is assigned . But if you do
not assign any value to list and only write :

SAY list

you see this on your screen :

LIST

Here is a simple procedure called VARIABLE .CMD that assigns
values to variables :

/* Assigning a value to a variable */
a = 'abc'
SAY a
b = 'def'
SAY ab
EXIT
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When you run the VARIABLE procedure, it looks like this on your
screen :

[C :\]VARIABLE
abc
abc def

[C : \1

Assigning values is easy, but you have to make sure a variable is not
used unintentionally, as in this example named MEETING .CMD :

/* Unintentional interpretation of a variable */
a = 'abc'
SAY Peter had a meeting with Dana
EXIT

When the procedure is run, it looks like this :

[C :\]MEETING
PETER HAD abc MEETING WITH DANA

[C : \l
To avoid unintentionally substituting a variable for the word, all you
have to do is put the sentence in quotes as shown in this example of
MEETING .CMD, which assigns a variable correctly :

/* No interpretation of a variable A */
a = 'abc'
SAY "Peter had a meeting with Dana"
EXIT

Working with Arithmetic

Your REXX procedures may need to include arithmetic operations of
addition, subtraction, multiplication, and division . For example, you
may want to assign a numeric value to two variables and add the
variables together.

Arithmetic operations are performed the usual way . You can use
whole numbers and decimal fractions. A whole number is an integer,
or any number that is a natural number, either positive, negative, or
zero, that does not contain a decimal part (for example, 1, 25, or 50) .
A decimal fraction contains a decimal point (for example, 1 .45 or 0.6) .

Before you see how these four operations are handled in a
procedure, here is an explanation of what the operations look like
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and the symbols used . These are just a few of the arithmetic
operations used in REXX .

Note: The examples contain a blank space between numbers and
operators so that you can see the equations better, but the blank is
optional .

Operators: The symbols used for arithmetic (+ , , *, /) are also
called operators because they operate on the adjacent terms . In the
following example, the operators act on the numbers (terms) 4 and 2 :

Note: When you are attempting to do arithmetic from data you type
using the keyboard (in response to a prompt to type numbers, for
example), you should check that the data is valid . You can do this by
using the DATATYPE() function . This function, and how to use other
built-in functions, is explained in "Functions" on page 158 .

Addition: The symbol to add numbers is the plus sign (+) . An
instruction to add two numbers is :

SAY 4 + 2

The answer you see on your screen is 6 .

Subtraction: The symbol to subtract numbers is the minus sign
An instruction to subtract two numbers is :

SAY 8-3

The answer on your screen is 5 .

Multiplication: The symbol to multiply numbers is the asterisk (*) .
An instruction to multiply two numbers is :

SAY 2 * 2

The answer on your screen is 4 .
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SAY 4 * 2 /* says "8"
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Division: With division, there are several operators you can use,
depending on whether or not you want the answer expressed as a
whole number . For example, to divide, the symbol is one slash
An instruction to divide is :

SAY 7/2

The answer on your screen is 3 .5. To divide and return just a
remainder, the symbol is two slashes (//) . To divide, and return only
the whole number portion of an answer and no remainder, the symbol
is the percent sign (%) .

This sample procedure named MATH .CMD shows you how to perform
four arithmetic operations on variables :

/* Performing arithmetic on variables */
a=4
b-2
c=a+b
SAY 'The result of
SAY
c=

c

a*b
SAY 'The result
SAY

a-b
SAY 'The result of
SAY
c=a/b
SAY 'The result of
EXIT

' a '/'

Your screen looks like this :

[C :\]MATH
The result of 4 + 2 is 6

The result of 4 * 2 is 8

The result of 4 - 2 is 2

The result of 4 / 2 is 2

[C : \1
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Evaluating Expressions: Expressions are normally evaluated from
left to right . An equation helps to illustrate this point. Until now, you
have seen equations with only one operator and two terms, such as
4 + 2. Suppose you had this equation :

9 5 + 4

The 9 - 5 would be computed first . The answer, 4, would be added to
4 for a final value : 8 .

Some operations are given priority over others . In general, the rules
of algebra apply to equations . In this equation, the division is
handled before the addition :

io+s/2
The value is 14 .

If you use parentheses in an equation, the interpreter evaluates what
is in the parentheses first ; for example:

(1U+8)/2

The value is 9 .

Writing a REXX Arithmetic Procedure

This is a review of some of the rules in the previous examples . You
might use the following sample every day . You have just seen how
REXX handles arithmetic, so this procedure adds two numbers . The
name of this procedure is ADD .CMD .

Here is a list of what is needed in this procedure :

1 . Identify and describe the REXX procedure .
2. Tell the user to type numbers .
3. Read the numbers typed using the keyboard and put the numbers

into system memory .
4. Add two numbers and display the answer on the screen .
5. Tell the interpreter to leave the procedure .
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There are many ways to write procedures to accomplish the same
task. To make it easier, in this procedure the user is asked for each
number separately, and then the numbers are added together. The
following is a discussion on how to put a procedure for ADD .CMD
together .

1 . First, what identifies a REXX procedure? If you thought of a
comment, you were right .

2. Next, you need to ask the user to enter numbers . The SAY
instruction prints a message on your screen .

3. If the number is entered, it needs to be put into computer
memory. The PULL instruction collects a response and puts it in
memory .

4. An instruction to ask for a second number can look just like the
first instruction, and it also needs to put the second number in
memory.

5. The next instruction is similar to one in the MATH procedure . In
one statement, it can tell the interpreter to add the two values
kept in memory, and display the sum on your screen . This can be
one instruction . It contains a string and the addition operation .

6. Finally, the EXIT instruction is used to finish the procedure .
7. If you want to test this program, type the procedure listed here

and file it .

/* This procedure adds two numbers */
SAY "Enter the first number ."
PULL numl
SAY "Enter the second number ."
PULL num2
SAY "The sum of the two numbers is" numl + num2
EXIT

To test ADD.CMD, type ADD at the OS/2 command prompt and try
some numbers. Here is what the procedure should look like when it
is run .
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[C :\]ADD
Enter the first number .

7

3

Enter the second number .

12

The sum of the two numbers is 15

[C : \1

More REXX Features

Some features of REXX that you can use to write more intricate
procedures will now be discussed. You will see how to have a
procedure make decisions by testing a value with the IF instruction .
You will also see how to compare values and determine if an
expression is true or false . The following terms are covered in this
section :

Term/Concept

	

Description

	

Page

IF

	

Used with THEN . Checks if the

	

138
expression is true. Makes a decision
about a single instruction .

THEN

	

Identifies the instruction to be run if

	

138
the expression is true .

ELSE

	

Identifies the instruction to be run if

	

139
the expression is false .

SELECT

	

Tells the interpreter to select one of a

	

140
number of instructions .

WHEN

	

Used with SELECT. Identifies an

	

140
expression to be tested .

OTHERWISE

	

Used with SELECT. Indicates the

	

140
instruction to be run if expressions
tested are false .

DO-END

	

Indicates that a group of instructions

	

141
should be run .

NOP

	

Used with an instruction when you

	

143
want nothing to happen for one
expression .
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Term/Concept

	

Description

	

Page

Comparisons

	

Indicate greater than, less than, equal

	

143
> < =

	

to.

NOT Operator

	

Changes the value of a term from true

	

146
or \

	

to false, or from false to true .

AND Operator

	

Gives the value of true if both terms

	

146
&

	

are true .

OR Operator

	

Gives the value of true unless both

	

147
1 or ;

	

terms are false .

Making Decisions

In the procedures discussed previously, instructions are run
sequentially . You can control the order in which instructions are run .
Depending upon the interaction of the user of your procedure, you
may choose not to run some of your lines of code . Two instructions
that let you make decisions in your procedures are the IF and
SELECT instructions . The IF instruction is similar to the OS/2 IF
command-it lets you control whether the next instruction is run or
skipped . The SELECT instruction lets you choose one instruction to
run from a group of instructions .

Making Decisions Using IF and THEN

The IF instruction is used with a THEN instruction to make a decision .
The interpreter runs the instruction if the expression is true ; for
example :

IF answer = "YES"
THEN
SAY "OK!"

In the previous example, the SAY instruction is run only if answer has
the value of YES .

Grouping Instructions Using DO and END

To tell the interpreter to run a list of instructions following the THEN
instruction, use :

DO
Instruction)
Instruction2
Instructoon3

END
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The DO instruction and its END instruction tell the interpreter to treat
any enclosed instructions as a single instruction .

ELSE

Identifies the instruction to be run if the expression is false . To tell
the interpreter to select from one of two possible instructions, use :

IF expression
THEN instruction)
ELSE instruction2

You could include the IF-THEN-ELSE format in a procedure like this :

IF answer = 'YES'
THEN SAY '0K!'
ELSE SAY 'why not?'

Try this example, GOING .CMD, choosing between two instructions, to
see how it works :

/* Using IF-THEN-ELSE */
SAY "Are you going to the meeting?"
PULL answer
IF answer = "YES"
THEN
SAY "I'l1 look for you ."
ELSE
SAY "I'll take notes for you ."

EXIT
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When this procedure is run, this is what you will see on your screen :

[C :\]GOING
Are you going to the meeting?

yes

I'll look for you .

(C : \l

Making Decisions Using SELECT, END, WHEN, OTHERWISE, and NOP

The SELECT instruction tells the interpreter to select one of a number
of instructions. It is used only with the instructions WHEN, THEN,
END, and sometimes, OTHERWISE. The END instruction marks the
end of every SELECT group . The SELECT instruction looks like this :

SELECT
WHEN expression)

THEN instruction)
WHEN expression2

THEN instruction2
WHEN expression3

THEN instruction3

OTHERWISE
instruction
instruction
instruction

END

Note: An IF-THEN instruction cannot be used with a SELECT
instruction unless it follows a WHEN or OTHERWISE instruction . You
can read this format as follows :

•

	

If expression1 is true, instructionl is run . After this, processing
continues with the instruction following the END . The END
instruction signals the end of the SELECT instruction .

•

	

If expression) is false, expression2 is tested . Then, if
expression2 is true, instruction2 is run and processing continues
with the instruction following the END .

140 REXX/Batch Files



This diagram shows the SELECT instruction :

SELECT

•

	

If, and only if, all of expressionl, expression2, and so on, are
false, then processing continues with the instruction following the
OTHERWISE .

WHEN

WHEN

WHEN

OTHERWISE

END

A DO-END could be included inside a SELECT instruction like this :

SELECT
WHEN expressionl THEN

DO
instruction)
instruction2
i nstructi on3

END

THEN
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You can use the SELECT instruction when you are looking at one
variable that can have several different values associated with it .
With each different value, you can set a different condition .

For example, suppose you wanted a reminder of weekday activities .
For the variable day, you can have a value of Monday through Friday .
Depending on the day of the week (the value of the variable), you can
list a different activity (instruction) . You could use a procedure such
as the following SELECT.CMD, which chooses from several
instructions :

Note: A THEN or ELSE instruction must be followed by an
instruction .

/* Selecting weekday activities */
SAY 'What day is it today?'
Pull day
SELECT

WHEN day = 'MONDAY'
THEN
SAY 'Model A board meeting'

WHEN day = 'TUESDAY'
THEN
SAY "Raymond's Team Meeting"

WHEN day = 'WEDNESDAY'
THEN NOP

	

/* Nothing happens here */
WHEN day = 'THURSDAY'

THEN
SAY "Richard's Seminar"

WHEN day = 'FRIDAY'
THEN
SAY "Kathryn's Book Review"

OTHERWISE
SAY "It's the weekend, anything can happen!"

END
EXIT
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When you try this procedure, here is your reminder for Thursday :

[C : \]SELECT
What day is it today?

Thursday

Richard's Seminar

[c :\)

NOP Instruction: If you intend that nothing should happen for one
expression, you can use the NOP (No Operation) instruction as shown
in the previous example for Wednesday .

True and False Operators

Determining if an expression is true or false is useful in your
procedures . If an expression is true, the computed result is 1 . If an
expression is false, the computed result is 0 . The following sections
show several ways to check for true or false operators .

Comparisons

Some operators you can use for comparisons are :

>

	

Greater than

<

	

Less than

Equal to

Comparison can be made with numbers or can be
character-to-character . Some numeric comparisons are :

The value of 5 > 3 is 1

	

This result is true .

The value of 2.0 = 002 is 1

	

This result is true .

The value of 332 < 299 is 0

	

This result is false .

REXX/Batch Files 143



If the terms being compared are not numbers, the interpreter
compares characters . For example, the two words (strings) airmail
and airplane are compared as follows :

PAD

a i r m a i 1

If this seems confusing, think of the REXX interpreter comparing the
words in this manner:

•

	

Leading and trailing blanks are ignored . These are the blank
spaces before or after the word .

•

	

The shorter word (airmail) is padded on the right with blanks .
•

	

The words are compared from left-to-right,
character-by-character.

•

	

If the strings are not equal, the first pair of characters that do not
match are used to determine the result .

A character is less than another character according to this sequence
of lowest to highest value :

Lowest

Highest

a i r P 1 a n e

∎
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NUL
special characters
numbers
special characters
upper case letters
special characters
lower case letters
special characters
reserved

m < p

	

so airmail < airplane

123 through 254
255

P- Highest

000
0 through 47
47 through 57
58 through 64
65 through 90
91 through 96
97 through 122



Note: Special characters are mixed in between the previously listed
categories of numbers and letters as shown .

Only unaccented characters and numbers are in numerical order in
any of the code pages supported by the operating system . All
characters are compared through pure binary sorting according to
their order in the code page you are currently using .

To type any of the special characters that are not on your keyboard
while in the System Editor, press the Alternate (Alt) key and type the
numeric value of the character you want on the numeric keypad of
your keyboard. When you release the Alt key, your system records
the numeric value you entered and displays that character on your
screen .

When airmail and airplane are compared, the first character that does
not match is the m of airmail and the p of airplane. The m is less
than the p, so airmail is less than airplane .

Equal

An equal sign ( ) can have two meanings in REXX, depending on its
position. For example :

amount = 5

	

/* This is an assignment */

gives the variable amount, the value of 5, as discussed in "Variables"
on page 130 and "Values" on page 130 . If an equal sign is in a
statement other than as an assignment, it means the statement is a
comparison. For example :

SAY amount - 5

	

/* This is a comparison */

compares the value of amount with 5. If they are the same, a 1 is
displayed ; otherwise, a 0 is displayed .
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Using Comparisons

This procedure, TF .CMD, uses comparisons and an equal expression
to determine if numeric expressions are true or false .

/* Determine if expression is true or false
/*1 is true ; O is false
a=4
b=2
c=a>b
SAY 'The result of' a '>' b 'is' c
c=a<b
SAY 'The result of' a '<' b 'is' c
c =a= b
SAY 'The result of a '-' b 'is' c
EXIT

When you run the procedure, it displays as :

[C : \] TF
The result of 4 > 2 is 1
The result of 4 < 2 is 0
The result of 4 = 2 is 0

[C :\]

The Logical NOT Operator ( -, or \ )

Logical operators can return only the values of 1 or 0. The NOT
operator (-, or \) i n front of a term reverses its value either from true
to false or from false to true .

The Logical AND Operator (&)

The AND operator (&) between two terms gives a value of true only if
both terms are true .
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SAY \ 0 /* gives '1'
SAY \ 1 /* gives '0'
SAY \ (4 = 4) /* gives '0'
SAY \ 2 /* gives a syntax error



The following procedure, AND .CMD, shows the operator checking for
two true statements .

/* Using the AND (&) Operator
/*Ois false ; 1 is true
a=4
b=2
c=5
d = (a > b) & (b > c)
SAY 'The result of (a > b) & (b > c)
d = (a > b) & (b < c)
SAY 'The result of (a > b) & (b < c)
EXIT

is' d

is' d

When run on your system, AND.CMD displays on your screen as :

[C : \] AND
The result of (a > b) & (b > c) i s 0
The result of (a > b) & (b < c) is 1

[C : \)

The Logical OR Operator ( ~ or ; )

The OR operator (1) between two terms gives a value of true unless
both terms are false .

REXX specifies two symbols as logical OR symbols, the vertical bar
(1) and the split vertical bar (1) . Depending upon your Personal
System keyboard and the code page you are using, you may not have
the solid vertical bar (1) to select. For this reason, REXX recognizes
the use of the split vertical bar also as a logical OR symbol . Some
keyboards may include both characters . In this instance, they are not
interchangeable . Depending on the code page and keyboard you are
using, the OR operator (ASCII special character value 124) may be a
solid or split vertical bar . This type of mismatch can also cause the
character on your screen to not match the character on your
keyboard .
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SAY (3=3) & (5=5) /* gives '1'
SAY (3=4) & (5=5) /* gives '0'
SAY (3=3) & (4=5) /* gives '0'
SAY (3=4) & (4=5) /* gives '0'



SAY ( 3 -
SAY ( 3 =
SAY ( 3 =
SAY ( 3 =

3 ) I ( 5 = 5 ) /* gives '1'
4 ) I ( 5 = 5 ) /* gives '1'
3 ) I ( 4 = 5 ) /* gives '1'
4) 1 ( 4 = 5)

	

/* gives '0'

The following procedure, OR .CMD, shows the OR operator in a true
statement unless both values are false :

/* Using the OR (1) Operator
/*0 is false ; 1 is true
a=4
b=2
c=5
d = (a > b) I (b > c)
SAY 'The result of (a > b) I (b > c) is' d
d = (a > b) I (b < c)
SAY 'The result of (a > b) I (b < c) is' d
EXIT

When run on your system, the procedure displays as :

[C : \] OR
The result of (a > b) I (b > c) i s 1
The result of (a > b) I (b < c) i s 1

[C : \1

Automating Repetitive Tasks

Within a procedure, you can automatically repeat a task by using
loops . Through loops, you can keep adding or subtracting numbers
until you want to stop . You can define how many times you want a
procedure to handle an operation .

Using simple loops is discussed in the following pages . You will also
have an opportunity to write another procedure .
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DO num loop Repeats loop a fixed number of times . 149

DO I = I to 10
loop

Numbers each pass through the loop. Sets
a starting and ending value for variable .
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Using Loops

If you want to repeat several instructions in a procedure, you can use
a loop. Loops often are used in programming because they condense
many lines of instructions into a group that can be run more than
once. Loops make your procedures more concise, and with a loop,
you can keep asking for input from a user unti I the correct answer is
given .

The two types of loops you may find useful are repetitive loops and
conditional loops . Loops begin with a DO instruction and end with the
END instruction .

Simple repetitive loops can be run a number of times. You can
specify the number of repetitions for the loop, or you can use a
variable that has a changing value . Conditional loops are run when a
true or false condition is met . For more information on using
conditional loops, see the Procedures Language 21REXX User's
Guide .

Repetitive Loops or DO num Loops

To repeat a loop a fixed number of times, you can use the following
simple loop :
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Term/Concept Description/Solution Page

DO WHILE Tests for true or false at top of loop .
Repeats loop on true . On false, continues
processing after END .

152

DO UNTIL Tests for true or false at bottom of loop .
Repeats loop on false . On true, continues
processing after END .

153

LEAVE Causes interpreter to exit a loop . 155

DO FOREVER Repeats instructions until the user says to
quit.

155

Getting out of
loops

Requires that you press the Ctrl+Break
keys .

156

Parsing words Assigns a different variable to each word
in a group .

156



DO num
instructions
instruction2
instruction3

END

The num is a whole number, which is the number of times the loop is
to be run .

Here is LOOP.CMD, an example of a simple repetitive loop :

/* A simple loop */
DO 5

SAY 'Thank-you'
END
EXIT

When you run the LOOP.CMD, you see this on your screen :

[C :\]loop
Thank-you
Thank-you
Thank-you
Thank-you
Thank-you

[C : \1

Another type of DO is :

DO XYZ

	

1 to 10

This type of DO numbers each pass through the loop so you can use it
as a variable . The value of XYZ is changed (increased by 1) each
time you pass through the loop. The 1 (or some number) gives the
value you want the variable to have the first time through the loop .
The 10 (or some number) gives the value you want the variable to
have the last time through the loop .

NEWLOOP.CMD is an example of another loop :
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/* Another loop */
sum = 0
DO XYZ = 1 to 7

SAY 'Enter value' XYZ
PULL value
sum = sum + value

END
SAY 'The total is' sum
EXIT

Here are the results of the NEWLOOP .CMD procedure :
[C :\]newloop
Enter value 1

2

Enter value 2

7

4

Enter value 3

6

Enter value 4

z

8

Enter value 5

10

Enter value 6

7

12

Enter value 7

14

The total is 56

When a loop ends, the procedure continues with the next instruction
following the end of the loop, identified by the END instruction .
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Conditional Loops

Conditional loops are run as long as a condition is met . The following
sections describe some instructions used for conditional loops :

The DO WHILE and DO UNTIL Instructions

The DO WHILE and DO UNTIL instructions are run while or until some
condition is met. A DO WHILE loop is :

DO WHILE expression
instruction)
instruction2
instruction3

END

With the DO WHILE instruction, the procedure evaluates if the
expression is true before processing the instructions that follow. If
the expression is true, the instructions are performed . If the
expression is false, the loop ends and moves to the instruction
following the END instruction. The DO WHILE instruction tests for a
true or false condition at the top of the loop .

The following diagram shows the DO WHILE instruction :
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A procedure using a DO WHILE loop is DOWHILE .CMD. It tests for
true or false at the top of the loop as follows :

/* Using a DO WHILE loop */
SAY 'Enter the amount of money available'
PULL salary
spent = 0
DO WHILE spent < salary

SAY 'Type in cost of item'
PULL cost
spent = spent + cost

END
SAY 'Empty pockets .'
EXIT

After running the DOWHILE procedure, you see this on your screen :

[C :\]dowhile
Enter the amount of money available
100
Type in cost of item
57
Type in cost of item
24
Type in cost of item
33
Empty pockets .
[C : \1

The DO UNTIL Instruction: ADO UNTIL instruction differs from the
DO WHILE because it processes the body of instructions first, then
evaluates the expression . If the expression is false, the instructions
are repeated (a loop) . If the expression is true, the procedure ends
or moves to the next step outside the loop .

The DO UNTIL instruction tests at the bottom of the loop; therefore,
the instructions within the DO loop are run at least once .

An example of a DO UNTIL loop follows :

DO UNTIL expression
instruction)
instruction2
instruction3

END
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The following diagram shows the DO UNTIL instruction :

DO UNTIL

Instructions
Instruction2
Instruction3

True

The DOWHILE procedure can be changed to process a DO UNTIL loop
like DOUNTIL .CMD. It tests for true or false at the bottom of the loop :

/* Using a DO UNTIL loop */
SAY 'Enter the amount of money available'
PULL salary
spent = 0

	

/* Sets spent to a value of 0 */
DO UNTIL spent > salary

SAY 'Type in cost of item'
PULL cost
spent = spent + cost

END
SAY 'Empty pockets .'
EXIT

When run, DOUNTIL.CMD displays on your screen as :

[C :\] DOUNTIL
Enter the amount of money available
50
Type the cost of items
37
Type the cost of items
14
Empty pockets .
[C :\]
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LEAVE Instruction

You may want to end a loop before the ending conditions are met .
You can accomplish this with the LEAVE instruction . This instruction
ends the loop and continues processing with the instruction following
the END. LEAVE.CMD causes the interpreter to end the loop as
follows:

/* Using the LEAVE instruction in a loop */
SAY 'enter the amount of money available'
PULL salary
spent = 0

	

/* Sets spent to a value of 0 */
DO UNTIL spent > salary

SAY 'Type in cost of item or END to quit'
PULL cost

IF cost = 'END'
THEN
LEAVE

spent = spent + cost
END
SAY 'Empty pockets .'
EXIT

The DO FOREVER Instruction

There may be situations when you do not know how many times to
repeat a loop. For example, you may want a user to type specific
numeric data (numbers to add together), and you want the loop to
perform the calculation until the user says to quit . For this procedure,
you can use the DO FOREVER instruction with the LEAVE instruction .
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A simple use of a DO FOREVER ending when the user quits, follows :

/* Using a DO FOREVER loop to add numbers */
sum = 0
DO FOREVER

SAY 'Enter number or END to quit'
PULL value
IF value = 'END'

THEN
LEAVE /* procedure quits when the user enters "end" */

sum - sum + value
END
SAY 'The sum is ' sum
EXIT

Getting Out of Loops

To stop most procedures, you can press the Control (Ctrl)+Break
keys. REXX recognizes Ctrl + Break after finishing the current REXX
instruction. However, some procedures might be waiting on external
events and will not be completed immediately . For example, if you
press the Ctrl +Break keys during the PULL answer instruction in the
following procedure, the procedure does not end . However, you can
allow the instruction to be completed by pressing the Enter key,
thereby satisfying the request for input . REXX now recognizes the
Ctrl + Break and ends the procedure .

/* Guess the secret password ! */
DO UNTIL answer = "Sesame"

SAY "Please enter the password . . ."
PULL answer

END
EXIT

If you are still unable to complete the current instruction, the
procedure might never end . Pressing the Alternate (Alt)+Cancel
(Esc) keys stops the OS/2 session and ends the procedure .

Parsing Words

The PULL instruction collects a response and puts it into system
memory as a variable . PULL can also be used to put each word from
a group of words into a different variable . In REXX, this is called
parsing . The variable names used in the next example are : first,
second, third, and rest .
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SAY 'Please enter three or more words :'
PULL first second third rest

Suppose you enter this as your response :

garbage in garbage out

When you press the Enter key, the procedure continues. However,
the variables are assigned as follows :

The variable FIRST is given the value GARBAGE .
The variable SECOND is given the value IN .
The variable THIRD is given the value GARBAGE .
The variable REST is given the value OUT .

In general, each variable receives a word, without blanks, and the
last variable receives the rest of the input, if any, with blanks . If there
are more variables than words, the extra variables are assigned the
null, or empty, value .

Using Advanced REXX Functions

As you become more skilled at programming, you may want to create
procedures that do more and run more efficiently . Sometimes this
means adding a special function to a procedure or calling a
subroutine .

The following pages discuss how these functions can help to build a
better foundation in REXX .

Term/Concept

	

Description/Solution

	

Page

Function

	

Performs a computation or an action

	

158
and returns a result .

DATATYPE()

	

Verifies that the data is a specific

	

159
type. Built-in function .

SUBSTR()

	

Selects part of a string . Built-in

	

160
function .

CALL

	

Causes the procedure to look for a

	

160
subroutine label and begin running
the instructions following the label .

Issuing commands

	

Treats commands as expressions .

	

162
from a REXX.CMD file

Responding to Error

	

Tells you if the command runs

	

163
Messages

	

correctly. If the procedure runs
correctly, no message is displayed .
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Functions

In REXX, a function call can be written anywhere in an expression .
The function performs the requested computation and returns a
result. REXX then uses the result in the expression in place of the
function call .

Think of a function as : You are trying to find someone's telephone
number (complete a function) . You call the telephone operator and
ask for the number . After receiving the number, you call the person .
The steps you have completed in locating and calling the person
could be labeled a function .

Generally, if the interpreter finds this in an expression :

name (expression)

it assumes that name is the name of a function and that this is a call to
the function name( ) . There is no space between the end of the name
and the left parenthesis . If you leave out the right parenthesis, it is
an error .

The expressions inside the parentheses are the arguments . An
argument can itself be an expression ; the interpreter computes the
value of this argument before passing it to the function . If a function
requires more than one argument, use commas to separate the
arguments .

Built-in Functions : More than 50 functions are built into REXX . Only
a few have been mentioned here . A dictionary of built-in functions is
in the Procedures Language 2/REXX Reference . See Appendix D,
"Procedures Language 2/REXX Instructions and Functions" for an
alphabetical table of REXX instructions and functions .

MAX( )

You can use the MAX( ) function to obtain the greatest number of a
set of numbers :

MAX(number, number, . . .)

For example :

MAX(2 9 4 9 8 9 6) - 8
MAX(2,4+5,6) = 9

Note that in the second example, the 4+5 is an expression . A
function call, like any other expression, usually is contained in a
clause as part of an assignment or instruction .
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DATATYPE( )

When attempting to perform arithmetic on data entered from the
keyboard, you can use the DATATYPE() function to check that the
data is valid .

This function has several forms . The simplest form returns the word,
NUM, if the expression inside the parentheses () is accepted by the
interpreter as a number that can be used in the arithmetic operation .
Otherwise, it returns the word, CHAR . For example :

The value of DATATYPE(56) i s NUM
The value of DATATYPE(6 .2) is NUM
The value of DATATYPE('$5 .50') is CHAR

In this procedure, DATATYPE.CMD uses a REXX built-in function and
asks the user to keep typing a valid number until a correct one is
typed .

/* Using the DATATYPE( ) Function */
DO UNTIL datatype(howmuch) - 'NUM'
SAY 'Enter a number'
PULL howmuch
IF datatype(howmuch) = 'CHAR'
THEN
SAY 'That was not a number . Try again!'

END
SAY 'The number you entered was' howmuch
EXIT

If you want the user to type only whole numbers, you could use
another form of the DATATYPE() function :

DATATYPE(number, whole)

The arguments for this form are :

•

	

number refers to the data to be tested .
•

	

whole refers to the type of data to be tested . In this example, the
data must be a whole number .

This form returns a 1 if number is a whole number or a 0 otherwise .
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SUBSTR( )

The value of any REXX variable can be a string of characters . To
select a part of a string, you can use the SUBSTR() function .
SUBSTR is an abbreviation for substring . The first three arguments
are :

•

	

The string from which a part is taken .
•

	

The position of the first character that is to be contained i n the
result (characters are numbered 1,2,3 . . . in the string) .

•

	

The length of the result .

For example :

S = 'reveal'
SAY substr(S,2,3) /*

SAY substr(S,3,4) /*

CALL Instruction
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Says 'eve' . Beginning with the second
character, takes three characters .
Says 'veal' . Beginning with the third
character, takes four characters .

The CALL instruction causes the interpreter to look through your
procedure until a label is found that marks the start of the subroutine .
Remember, a label (word) is a symbol followed by a colon (:) .
Processing continues from there until the interpreter finds a RETURN
or an EXIT instruction .

A subroutine can be called from more than one place in a procedure .
When the subroutine is finished, the interpreter always returns to the
instruction following the CALL instruction from which it came .

Often each CALL instruction supplies data (called arguments) that the
subroutine is to use . In the subroutine, you can find out what data
has been supplied by using the ARG instruction .



The CALL instruction displays in the following form :

CALL name Argumentl, Argument2 . . .

For the name, the interpreter looks for the corresponding label
(name) in your procedure . If no label is found, the interpreter looks
for a built-in function or a CMD file with that name .

The arguments are expressions . You can have up to 20 arguments in
a CALL instruction, or no arguments at all . An example of a
procedure that calls a subroutine follows . Note that the EXIT
instruction causes a return to the operating system . The EXIT
instruction stops the main procedure from running on into the
subroutine .

For example, REXX .CMD calls a subroutine from a main procedure .

/* Calling a subroutine from a procedure */
DO 3

CALL triple 'R'
CALL triple 'E'
CALL triple 'X'
CALL triple 'X'
SAY

END
SAY 'R . . . !'
SAY 'E . . . !'
SAY 'X . . .!'
SAY 'X . . .!'
SAY ' '
SAY 'REXX!'
EXIT

	

/* This ends the main procedure . */

/* Subroutine starts here to repeat REXX three times .
/* The first argument is displayed on screen three
/* times, with punctuation .

TRIPLE :
SAY ARG(1)"

	

"ARG(1)"

	

"ARG(1)"!"
RETURN

	

/* This ends the subroutine .
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When REXX.CMD is run on your system, the following is displayed :

[C : \]REXX

REXX!

[C : \1

Issuing OS/2 Commands from a REXX .CMD File

In a REXX procedure, anything not recognized as an instruction,
assignment, or label is considered a command . The statement
recognized as a command is treated as an expression . The
expression is evaluated first ; then the result is passed to the
operating system .

The following example, COPYLIST.CMD, shows how a command is
treated as an expression . Note how the special character (*) is put in
quotes. COPYLIST.CMD copies files from your drive A to your drive
B .
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/* Issuing a command from a procedure . This example copies

/* all files that have a filetype of LST from
/* drive A to your drive B .
SAY
COPY "a :* .1st b :"

	

/* This statement is treated as */
/* an expression .

	

*/
/* The result is passed to OS/2 . */

EXIT

Note: In the preceding example, the whole OS/2 command except for
COPY is in quotes :

•

	

If the colon () were not in quotes, the REXXSAA interpreter would
treat the a : and b : as labels .

•

	

If the asterisk (*) were not in quotes, the REXXSAA interpreter
would attempt to multiply the value of a : by .1st .

•

	

It is also acceptable to include the entire OS/2 command in
quotes so that it displays as "COPY a :* . 1st b : " .

Responding to Error Messages

There are two basic types of errors that can occur when REXX is
processing a procedure .

One type of error can occur because of the way the procedure is
written -such as unmatched quotes or commas in the wrong place .
Maybe an IF instruction was entered without a matching THEN to go
with it. This first type of error is caused by the REXX program, and a
REXX error message is issued .

A second type of error can occur because of an OS/2 command that
the REXX procedure has issued . This type of error generates regular
OS/2 error messages. When you write commands in your
procedures, consider what would happen if the command failed to run
correctly. For example, a COPY command can fail because the
user's disk is full or a file cannot be found .
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When a command is issued from a REXX procedure, the command
interpreter gets a return code and stores it in the REXX special
variable RC (return code) . When you write a procedure, you can test
for these variables to see what has happened when the command
was issued . See "Working with Return Codes" on page 165 .

Here is how you discover such a failure . When commands have
finished running, they always provide a return code . A return code of
0 nearly always means all is well . Any other number usually means
that something is wrong . If the command worked normally (the return
code was 0), you see the command prompt :

[C :\]

and you return to the screen you ran your program from in
Presentation Manager, or PMREXX prints under the last line of the
procedure The REXX procedure has ended .

In the following example, ADD .CMD has been entered incorrectly . In
line 6, the plus sign (+) has been typed incorrectly as an ampersand
(&) .

/* This procedure adds two numbers */
SAY "Enter the first number ."
PULL numl
SAY "Enter the second number."
PULL num2
SAY "The sum of the two numbers is" numl & num2
EXIT

When the above ADD .CMD is run, the following error message is
displayed .

6+++ SAY "The sum of the two numbers is" numl & num2
REX0034 : Error 34 running C :\REXX\ADD .CMD,line 6 :logical value not 0 or 1
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To get help on the error message, type HELP and the message
number:

HELP REX0034

When help is requested, as i n the preceding message number, an
error message such as the following is displayed :

REX0034 ***Logical Value not 0 or 1***

Explanation : The expression in an IF, WHEN, DO WHILE,or DO UNTIL
phrase must result in a '0' or a '1', as must any
term operated on by a logical operator .

Any command that is valid at the command prompt is valid in a REXX
procedure. The command interpreter treats the command statement
the same way as any other expression, substituting the values of
variables, and so on. (The rules are the same as for commands
entered at the command prompt .)

Working with Return Codes

When the command interpreter has issued a command and the
operating system has finished running it, the command interpreter
gets the return code and stores it in the REXX special variable return
code (RC) . In your procedure, you should test this variable to see
what happened when the command was run .

The following example shows a few lines from a procedure where the
return code is tested :

/* Testing the Return Code in a Procedure . */
'COPY a :* .lst b :'
IF rc = 0 /* RC contains the return code from COPY command */
THEN
SAY 'All *1st files copied'
ELSE
SAY 'Error occurred copying files'

REXX/Batch Files 165



166 REXX/Batch Files



Chapter 8. Using the System Editor

The information in this chapter describes how to use the System
Editor for creating and editing files . Written primarily for new
computer users, this chapter leads you step-by-step through the tasks
you perform when editing files .

Designed as a simple text editor, the System Editor runs in a window,
is menu-driven, and capable of editing ASCII text files . Consider
installing a more powerful editor if you will be doing extensive text
editing or word processing tasks . Using the System Editor, you can :

•

	

Use both the mouse and keyboard when editing files
•

	

Receive help
•

	

Change fonts and colors
•

	

Use the Clipboard to transfer text between applications .

Help is available and can be viewed by pressing the F1 key or by
selecting Help from the action bar .

This chapter describes the following System Editor basics :

•

	

Starting an editing session
•

	

Getting help
•

	

Displaying drives and directories
•

	

Saving and closing files
•

	

Ending an editing session .

The chapter then goes on and describes :

•

	

Adding and selecting text
•

	

Manipulating and merging text
•

	

Deleting and restoring text
•

	

Finding and changing text .
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Key assignments for the System Editor are described in Appendix A .

Before using the System Editor, review Getting Started to become
familiar with how to use :

•

	

Desktop Manager
•

	

Presentation Manager
•

	

File Manager
•

	

The mouse and keyboard
•

	

Windows
•

	

Paths, directories and file names .

Note: You use the File Manager, not the System Editor, to print your
files. For information on printing files, see Getting Started.
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Starting an Editing Session

There are several ways to start the System Editor :

•

	

Selecting it from Desktop Manager's Group - Main list
•

	

Entering an E at the OS/2 Full Screen or OS/2 Window
•

	

Selecting its program name (E .EXE) from File Manager
•

	

Selecting an associated file from File Manager .

To start the System Editor from Desktop Manager :

From the Group - Main window, double-click on OS/2 System Editor,
or select it and press the Enter key .

Desktop Manager

Group View Desktop He

Utilities Group--Ma i n
Program View He]

File Manager

9 Introducing OS/2

OS/2

1 p

p

OS/2 Window

OS/2 Full Screen

tg~ Print Manager

OS/2 Systan Editor

V A

The System Editor starts .

Note: To start additional file windows, return to Group - Main and
repeat the above steps .

Using the System Editor 169



To start the System Editor from the OS/2 Full Screen or OS/2 Window :

1 . From the Group - Main window, double-click on either OS/2 Full
Screen or OS/2 Window, or select it and press the Enter key .

An OS/2 command prompt ([C :\]) is displayed .

2. Type the letter E ; then press the Enter key and the System Editor
starts .

Note: When starting the System Editor from a command prompt,
you can specify the file you want to edit or name the file
you are about to create .

To start and edit an existing file, for example one named FILE1
that is on drive C in the directory Sample, you would enter :

E C :\SAMPLE\FILE1

(E) represents the System Editor, (C :) is the drive, (\SAMPLE\) is
the path and (FILE1) is the file name .

To name a file you are about to create when you start the System
Editor, leave a space after the E, type a path and name, and then
press the Enter key .

Note: If you only type E and a file name, the file you create will
automatically be placed in the current directory .

For information on specifying paths, directories and naming files,
see Getting Started .

3. The System Editor starts and you can begin editing or creating
your file .

To start the System Editor from the File Manager :

1 . From the Directory Tree, double-click on drive C, or select it and
press the Enter key .

2 . Double-click on the OS2 directory, or select it and press the Enter
key .

The list of OS2 files and subdirectories is displayed .

3. Double-click on E.EXE, or select it and press the Enter key .

The System Editor starts .

4. Begin typing your file .
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For information on how to start the System Editor from an associated
file, see Getting Started.

When the System Editor starts, a blank file window named "OS/2
System Editor - UNTITLED" or "E .EXE - UNTITLED" is displayed on
your screen. Until a file is given a name, the title bar displays the
word "UNTITLED ." The text area is blank except for a flashing cursor
displayed directly below the action bar. If you typed in a file name,
the name you typed is displayed instead of UNTITLED . If the file
already exists, its content is displayed in the window .

	 -	
0512 Sy stem Editor

	

UNTITLED v0

4

I

File Edit Options Help
4

0
∎

The System Editor window has a title bar, action bar, vertical and
horizontal scroll bars, the System Menu icon, and the minimize and
maximize icons. These window parts are described in Getting
Started .

The mouse pointer changes from (R) to the editing pointer (I) when it
is placed in the text area of a file window . The editing pointer is
removed when you start typing and displayed when you move the
mouse .
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Mode

	

Cursor

	

Description

Insert

	

I

	

Adds characters in front of text .

Overtype

You can switch between cursor modes at any time by pressing the
Insert (Ins) key .

Shown below are the System Editor action bar pull-downs .

File

Open . . .

S a V. 0

Save as . . .

Exit

	

F3

Options

Set font . .
Set colors . . .

V Word wrap

Mnemonics for pull-down choices are underscored . When assigned,
key combinations are indicated next to a choice. A choice followed
by an ellipsis (. . .) means that a pop-up window follows when that
choice is selected. A choice that can be turned on or off is preceded
by a check mark ( .J) when selected (turned on) . Some pop-up
windows can be dragged .

The System Editor is represented by the

	

icon when it is
minimized .
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Writes over selected characters .

Edit
Undo

	

AIt+Backspace

C 1e z'

Find . . .

	

Ctrl+F
Select all

Hel p

Help for help . . .

Extended help . . .

Keys help . . .

Help index . . .

About . . .

C.ut Sh#tt+Da l
Co o-, C aI+ '

S



Help Information
Help is provided for information about tasks, help for help, extended
help, key assignments, the help index, and field help . Press the F1
key or use the Help pull-down to access help .

The following is the Help pull-down :

Help for help . . .

Extended help . . .
Keys help . . .
Help index . . .

About . . .

When you request help, a panel containing help information is
displayed on your screen. After reviewing the help information, you
can remove the help panel by doing one of the following :

•

	

Press the Escape (Esc) key, or
•

	

Select Close from the Help window's System Menu .

Help for help displays information on the Help function . To view Help
for Help you can either :

•

	

Click on Help for help from the Help pull-down (or select it and
press the Enter key), or

•

	

Simultaneously press the Shift and F10 keys when a help window
is displayed. (The Shift + F10 keys are only active when a help
window is displayed .)

Extended help provides information about the active window . To
view Extended help you can either :

•

	

Click on Extended help from the Help pull-down (or select it and
press the Enter key), or

•

	

Press the F2 key when a help window is displayed . (The F2 key is
only active when a help window is displayed .)

Keys help provides a list of available function keys as well as the
actions they perform . To view Keys help you can either :

•

	

Click on Keys help from the Help pull-down (or select it and press
the Enter key), or

•

	

Press the F9 key when a help window is displayed . (The F9 key is
only active when a help window is displayed .)
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Help Index displays a list of topics on which you can get help
information . You can scroll through the list of topics and select a
topic directly from the list, or you can do the following :

1 . Click on Help Index from the Help pull-down, or select it and
press the Enter key .

2. Click on Search from the Help panel's Services pull-down, or
select it and press the Enter key .

3. Click on the Index radio button, or select it and press the Enter
key .

4. Type one or more search words in the Search string entry field .

5. Click on the Search pushbutton, or press the Enter key .

Field (contextual) help provides information about the area in an
application or pop-up that you have placed the cursor on . To access
Field help information :

1 . Place the cursor on a field (area) of interest, then

2. Do one of the following :

•

	

Press the F1 key, or
•

	

Click on the Help pushbutton, or select it and press the Enter
key .
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Creating Files
You can give files and directories any names that conform to either
File Allocation Table (FAT) or High Performance File System (HPFS)
rules. For information on specifying paths and directories and
naming files, see Getting Started .

Creating Files from a Command Prompt
Unless you specify an existing file, when the System Editor starts, a
blank file window named "OS/2 System Editor - UNTITLED" or "E.EXE
- UNTITLED" is displayed on your screen . If you named the file
before pressing the Enter key, the name you gave the file is displayed
instead of UNTITLED . You create your new file in the blank System
Editor window.

A new file can be created when you start the System Editor from one
of the OS/2 command prompts. See page 170 for information on
opening existing files and naming and creating new files from a
command prompt.

Creating Files from the Action Bar
The File pull-down is used when you create files from the action bar .
Selecting Save as from the File pull-down allows you to name and
save the file simultaneously. Save as also allows you to rename
files. Selecting New from the File pull-down opens a new UNTITLED
file window . The following is the File pull-down :

File
New

Open . . .

Save as . . .

Exit

	

F3

To create a file from the action bar :

1 . Click on Save as from the File pull-down (or select it and press
the Enter key) .

Using the System Editor 175



The Save as pop-up is displayed on your screen .

Refer to page 183 for information on using Save as.

2 . Type a path and file name in the File name entry field .

3. Click on the OK pushbutton, or press the Enter key .

The Save as pop-up is removed .

4. Begin typing your file .

If you are editing a file and want to create a new file :

1 . Click on Save from the File pull-down (or select it and press the
Enter key) to save the file you are editing .

2. Click on New from the File pull-down (or select it and press the
Enter key) .

Note: If you try to create a new file before saving your current
file, a warning message is displayed . If your file had not
been previously named, the Save as pop-up is displayed .

A blank System Editor window titled OS/2 System Editor -
UNTITLED or E .EXE - UNTITLED is displayed .

3. Do one of the following :

•

	

Click on Save as from the File pull-down (or select it and
press the Enter key) and name the file you are about to
create .

•

	

Type in the file ; then click on Save as from the File pull-down
(or select it and press the Enter key) and name the file you
created .
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Setting Options
Once an editing session has been started, various options can be
changed and set .

The following is the Options pull-down :

Options
Set font
Set colors . . .

V Word wrap

The options you set remain in effect until they are reset . They are
saved and used the next time you start editing . You can reset the
options at any time from the Options pull-down .

Set font allows you to select a font style, size and typestyle . When
editing, if you want to see how your file will actually look when
printed, choose a font style that is compatible with your printer . For
example, choose a non-proportional font such as Courier if your
printer font is non-proportional . If only one font is presently installed,
see Getting Started for information on font installation .

Note: You use the File Manager, not the System Editor, to print your
files . For information on printing files, see Getting Started .

To select fonts :

1 . Click on Set font from the Options pull-down (or select it and
press the Enter key) .

The Set font pop-up is displayed .
I

et fon

Font
System Proportional

-Font Samp e

Set

-Size

ICancel

-Typestyle

N Bold
D ;Italic ;
0 Underscore
El Stri keout

aBcDeFgHiJkLmNoPgRsTuVwXyZ

Help

The Tab key moves the cursor between selection fields . The T
and j keys move the cursor within the selection field .
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2. Select a font name from the Font selection field .

As selections are made, an example of what you select is
displayed in the Font Sample box . Select Apply to select and
then continue with selections . Select Cancel to remove the Set
font pop-up, return to the text area of the file, and leave the fonts
unchanged .

3. Select a font size from the Size selection field .

4. Select a font style from the Typestyle check box .

One or all of the check box styles can be selected . The selection
style cannot be varied within the file .

5. Click on Set, or select it and press the Enter key .

The Set font pop-up is removed, and the text within the file takes
on the font, font size and type style you selected . You can change
these selections as many times as you like during the editing
session .

Note: Refer to "Word wrap" on page 179 for more information on
displaying text i n windows .

Set colors allows you to change the foreground and background
colors of the file window . Foreground refers to the characters typed
within the window, while background refers to the window's text area .

To change foreground and background colors :

1 . Click on Set colors from the Options pull-down (or select it and
press the Enter key) .

The Set colors pop-up is displayed .
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The colors you select are displayed in the Color Sample box .
You will be able to see how selections appear together before
setting them and returning to the text area of the file . Select
Apply to display selections in the text area . Select Cancel to
remove the Set colors pop-up, return to the text area of the file,
and leave the colors unchanged .

2 . Select a color from the Foreground selection field .

3. Select a color from the Background selection field .

4. Click on the Set pushbutton, or select it and press the Enter key .

The Set colors pop-up is removed and the text area of the file is
displayed in the colors you selected .

Word wrap affects how text is displayed in a window, not how it is
stored or printed . A check mark (.J) appearing in front of Word wrap
indicates that it is turned on . Long lines are divided into short lines
so that they fit inside the border of the window . This eliminates the
need for horizontal scrolling . Word wrap is usually not appropriate
for writing lines of code .

To turn Word wrap on :

•

	

Click on Word wrap from the Options pull-down (or select it and
press the Enter key) .

A check mark (J) is placed in front of Word wrap and the
pull-down is removed .

To see how text will be printed, turn Word wrap off :

•

	

Click on Word wrap from the Options pull-down (or select it and
press the Enter key) when it is shown with a check mark .

The check mark and the pull-down are removed .

When Word wrap is off, text is displayed according to where
end-of-line (EOL) characters have been inserted . See page 182
for information on EOL characters .

Note: Refer to page 177 for additional information on seeing how
text will be printed .
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Selecting Drives and Directories and Opening
Files

You can display the contents of drives and directories and you can
open files by selecting Open from the File pull-down .
1 . Click on Open from the File pull-down (or select it and press the

Enter key) .

The Open pop-up is displayed .

The File name entry field is at the top of this window .

Located directly below the File name entry field is the Directory is
line. Directory is displays your final search path selections .
When a path is entered in the File name entry field, it becomes
part or all of the path and appears on the Directory is line. You
cannot make direct entries on the Directory is line .

The Files selection field shows the files in the selected directory .

The Directories selection field displays your drives and
directories . When selections are made from the Directories
selection field, the Directory is line reflects the selection and the
associated files are displayed in the Files selection field .

The Tab key moves the cursor between selection fields . The T
and J, keys move the cursor within the fields .

2 . Open a file .

You can open a file from the Open pop-up in these ways :
•

	

In the File name entry field, enter the path and name of the
file you want to open .
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Directory is : C :\

Files :

	

Directories :

ABIOS .SYS 4 OS2 4
AUTOEXEC.BAT SPOOL
BASEDD02 .SYS [A : ]
CMDREF .CP [C :]
COMMAND .COM
CONFIG .SYS
E .EXE 0 0

IOK

	

I Cancel I I
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Note: If you are already working i n the correct subdi rectory
when the Open pop-up is displayed, just type the name
of the file you want to open i n the File name entry
field, and press the Enter key .

•

	

Double-click on a directory name from the Directories
selection field (or select it and press the Enter key) and then
double-click on a file name from the Files selection field (or
select it and press the Enter key) .

Note: If you select a file from the Files selection field, it
replaces the name in the File name entry field .

The Open pop-up is removed, and the file you selected is
displayed .

Entering Text

You can type 255 characters on a line. Spaces between words count
as characters . The cursor moves one space to the right every time
you type a character or press the Spacebar .

To enter text, begin typing at the cursor location, or use the
Spacebar, Arrow keys (E- T j -.), or the Enter key to move the cursor
to a different location ; then begin typing .

To start a new line, press the Enter key . A new line is displayed
below the one the cursor was on, and the cursor is positioned at the
beginning of the new line .

Tabs
Tabs affect the way your file is saved to disk . When pressed, the Tab
key moves the cursor to the next tab position which is always a
multiple of eight spaces away from the start of a line . This in turn
causes text to the right of the cursor to line up with the next tab
position . An example of this is :

One(tab)Three(tab)Twelve

Your information appears as :

One

	

Three Twelve

The text is aligned and will stay aligned even when you make
changes. The System Editor adjusts the white space for you . If you
go over the eight space boundary, the tab position will change . Tab
settings can be deleted by using the Backspace key .
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To use Tabs :

1 . Type i n some information .

2. Press the Tab key .

3. Type i n some information .

4. Press the Tab key .

Repeat the above steps until all text and tab settings have been
entered .

EOL Characters
End-of-line (EOL) characters are invisible and are entered by
pressing the Enter key . EOL characters become part of your text and
can be deleted in the same manner as any other character . Any
character following an EOL character will start on a new line,
regardless of whether Word wrap is on or off .

Saving and Closing Files
The File pull-down provides three ways to save the file you are
editing :

•

	

Save
•

	

Save as
•

	

Autosave

The following is the File pull-down :

New

Open . . .

L~I

Save as . . .

Exit

	

F3

Save allows you to save and then continue editing your current file
whenever you choose . A copy of the file is written to disk with its
current name whenever you select Save .

To save and then continue editing a file, click on Save from the File
pull-down (or select it and press the Enter key) .
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The pull-down is removed and the file is saved . You can continue
adding and editing text, or you can exit the file . To ensure that all
your changes are saved, always select Save before exiting a file .

Save as allows you to name, rename and save the current version of
a file .

To name and save a file :

1 . Click on Save as from the File pull-down (or select it and press
the Enter key) .

The Save as pop-up is displayed .

Drives and directories are displayed in the Directories selection
field for reference . The Directory is line displays your path
entries .

The Tab key moves the cursor between selection fields . The T
and j keys move the cursor within the selection field .

To save the file in your current directory :

•

	

Type the name you want to give the file in the File name entry
field; then click on the OK pushbutton or press the Enter key .

To save the file in a different directory :

•

	

Select the directory in the Directory selection field .

The directory you select is immediately displayed in the File
name entry field .

2. Type the name you wish to give the file in the File name entry
field ; then press the Enter key .
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Note : A warning message is displayed if the file name entered
already exists . A warning message is also displayed if
you have not initially saved a new file . The system
recognizes the existence of a file only after it is saved .

The Save as pop-up is removed and the file is saved with the path
and name you entered. Use that path and name the next time you
request the file .

Autosave allows you to automatically save an entire file on disk after
changing or adding a specified number of changes in your file . You
must set Autosave to on in order to use it .

To set Autosave on :

1 . Click on Autosave from the Files pull-down (or select it and press
the Enter key) .

The Autosave pop-up is displayed .

2 . Select the Autosave on check box, or press the Tab key to reach
it and then press the Spacebar to select it .

Autosave is on when an X appears i n the check box .

3 . Enter a number, ranging from 1 to 9999, in the entry field .

Use the Autosave scroll bar to enter a number, or type a number
in the entry box. The number entered will represent the number
of changes to be made between Autosaves . Select Cancel to exit
Autosave without changing your current setting .

4. Click on the Set pushbutton, or Tab to it and press the Spacebar .

The Autosave pop-up is removed .

Note: Before closing a file, select Save from the File pull-down .

Deleting Files
Files are deleted from File Manager . For information on deleting
files, see Getting Started .
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Printing Files
Files are printed from File Manager . For information on printing files,
see Getting Started .

Note: Turn Word wrap off to see how a file is stored or printed . Text
is displayed according to where you have inserted end-of-line
(EOL) characters (see page 182) .

Ending an Editing Session
Ending an editing session closes the System Editor program .

To end an editing session :

1 . Click on Save from the File pull-down (or select it and press the
Enter key) .

Note: The File Changed pop-up is displayed if you try to close a
file before changes to a file have been saved .

0

Untitled has changed . Do you want to save it?

Save Save as . . .) Discard Cancel Help

To name or rename a file before closing it, select Save as . To
erase your unsaved changes and then close the file, select
Discard. To return to the file's text area, select Cancel .

2. Click on Close from the System Menu pull-down or Exit from the
File pull-down (or select it and press the Enter key) .

The file closes, the System Editor ends, and you are returned to
wherever you started the System Editor .
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Editing Files
This section provides information on :

•

	

Adding and inserting text
•

	

Splitting and joining lines
•

	

Selecting and deselecting text
•

	

Using Cut, Copy and Paste to merge text
•

	

Deleting and restoring text
•

	

Finding and changing text .

Adding and Inserting Text
To add or insert words or characters :

1 . Position the cursor at the point where you want to add or insert
text .

2. Type in the new information .

Splitting and Joining Lines
Splitting and joining lines allows you to change how your text is
formatted .

To split a line :

1 . Position the cursor where you want the text broken to start a new
line .

2. Press the Enter key .

When the Enter key is pressed, an EOL character is inserted at
the cursor position and the text splits . The text from the cursor to
the end of the line is moved to the next line .

To join lines :

1 . Press the End key to move the cursor to the end of the line .

2 . Press the Del key to delete the EOL character .

The text from the line below joins your current line at the right of
the cursor. When a line is too long to be joined to the one above,
a message is displayed on your screen telling you so .
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Selecting Text
To select text means to highlight the character, line, or block of lines
that you want to cut (remove), copy (duplicate), or paste (insert)
elsewhere within the current file or in another file. See page 197 for
information on text selection keys .

To select text with the mouse :

1 . Position the mouse pointer just before the first character to be
selected .

2. Hold down mouse button 1 ; then drag (move) the pointer to just
after the last character to be selected .

You can also drag from just after the last character to just before
the first character .

When the mouse comes to a window border during a drag, the
System Editor scrolls . This makes it possible to select more text
than can be displayed in the window .

3. Release mouse button 1 .

The area is selected. The following is an example of selected
text :

OS/2 System Editor - UNTITLED

	

0
F le Edit Options Help

This will show you an example of selected text . You can select
Once you have selected text

it can be moved to another place in your file or to a different file .
a character, a word or a block of text .

Lt

4

A selected area has an anchor point and a cursor point .

The anchor point is set when you hold down mouse button 1 and
begin a drag . It is also set when you hold down the Shift key and use
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the cursor movement keys to move the cursor. The anchor point is
set at the cursor position, and the cursor moves to the cursor point
position .

The cursor point is set when you release mouse button 1 or the Shift
key. You can drag or move the pointer to where you want the cursor
point set and then release mouse button 1 ; or using the cursor
movement keys, position the cursor and then release the Shift key .

To select one word, double-click on any part of the word . The
selection includes all blank spaces following the word . If you delete
the word, the blank spaces are also deleted . The blanks are not
deleted if you start typing .

The Edit pull-down has a Select all choice which sets the anchor point
at the beginning of the text and the cursor point at the end . This is
useful when using Cut, Copy and Paste . Information on Cut, Copy
and Paste follows .

Deselecting Text
To deselect text means to remove the highlighting and leave the text
unchanged .

•

	

To deselect text with a mouse, click once within the text area of
the window .

•

	

To deselect text with the keyboard, press one of the cursor
movement keys .

Merging Files
The System Editor can manage large files, making it possible for you
to combine several files into one . When merging files, the Edit
pull-down choices Cut, Copy and Paste are used .
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Cut, Copy, and Paste
These three choices are used for moving text and merging files and
can be found on the Edit pull-down . When using cut, copy and paste,
the Clipboard can hold a maximum of 65,535 characters . See
"Selecting Text" on page 187 if you are unfamiliar with how to select
text. The following is the Edit pull-down .

Edit
Undo

	

AIt+Backspace

C ut

	

Shft~,- O

Find . . .

	

Ctrl+F
Select all

Cut
This choice cuts selected text from your file and saves it on the
Clipboard . The cut text can then be pasted into the file you are
editing or into another file .

To use Cut:

1 . Select the text to be cut .

2. To remove the selected text, do one of the following :

•

	

Click on Cut from the Edit pull-down (or select it and press
the Enter key) .

•

	

Hold down the Shift key, then the Del key; release the keys .

The selected text is removed from the file and saved .

Copy
This choice copies your selected text to the Clipboard . The selected
text can be pasted to a new position in the file you are editing or into
another file .

To use Copy :

1 . Select the text to be copied .

2. Do one of the following :

•

	

Click on Copy from the Edit pull-down (or select it and press
the Enter key) .

•

	

Hold down the Control (Ctrl) key and then press the Insert
(Ins) key .
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The selected text is copied from the file and saved on the
Clipboard. The file remains unchanged . See Getting Started for
information about the Clipboard .

Paste
This choice takes the text you have cut or copied to the Clipboard and
inserts it into a file at the cursor's position .

To use Paste :

1 . Move the cursor to where you want the Clipboard text inserted .

2. Do one of the following :

•

	

Click on Paste from the Edit pull-down (or select it and press
the Enter key) .

•

	

While holding down the Shift key, press the Ins key .

The selected text is inserted at the cursor position .

To copy all of the text to the Clipboard :

1 . Click on Select all from the Edit pull-down (or select it and press
the Enter key) .

2. Click on Copy from the Edit pull-down (or select it and press the
Enter key) .

3. Open the file you want to paste the text into if you are not
currently in it .

4. Move the cursor to where you want the text inserted .

5. Click on Paste from the Edit pull-down (or select it and press the
Enter key) .

The text is inserted at the cursor position .

Deleting Text
The System Editor automatically deletes all selected text when you
start entering new text . Other ways of deleting text are as follows :

•

	

If you only want to delete text, pressing the Del key or Backspace
key deletes the entire selected text area.

•

	

The Del key and Backspace key also delete text if there is no
selected area . The Del key deletes the character following the
cursor. The Backspace key deletes the character in front of the
cursor.

•

	

Selecting Clear from the Edit pull-down deletes selected text .
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Clear
Use this Edit pull-down choice to delete and discard your selected
text. Clear is only active on the pull-down when text has been
selected .

To use Clear :

1 . Select the text that is to be deleted .

2. Click on Clear from the Edit pull-down (or select it and press the
Enter key) .

The text you selected is deleted from your file .

Undoing Your Last Change
You can undo the very last change you made by selecting Undo from
the Edit pull-down . This includes font, colors, and editing changes .

To undo your last change :

•

	

Click on Undo from the Edit pull-down (or select it and press the
Enter key) .

The pull-down is removed and your previous font, colors, and text
are restored .

Finding and Changing Text
You can find the occurrence of a string i n your current file . A string
can be a single character or a set of characters . Strings can be found
and changed either from the beginning of your file to the end or from
the cursor position to the end . One or all occurrences of a string can
be changed .

To locate a string :

1 . Position the cursor wherever you want the search to begin .

2. Click on Find from the Edit pull-down (or select it and press the
Enter key) .

The Find pop-up is displayed .
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Find :

Change to :

® Case sensitive

(ChangeAll

11

El Wrap

-----------------------------
L

	

4

	 J l	•

Cancel Help

3 . In the Find entry field, enter the string you want to find .

The System Editor searches only for what you enter; therefore,
the string must be entered exactly as it appears i n the file .

4. Select Wrap to search the entire file .

When selected, an X appears in the check boxes . Check box
selections remain in effect until you deselect them .

5. Select Case sensitive if you want the search to find only exact
matches of uppercase and lowercase letters .

6. Click on the Find pushbutton, or select it and press the Enter key .

When found, the string is highlighted . When the string is not
found, a message panel is displayed stating so .

To change the string :

1 . In the Change to entry field, type in what you want the string
changed to .

If this entry field is left blank, the string will be deleted when one
of the Change choices is started .
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2 . Select one of the following :

•

	

To leave a string unchanged and search for the next string,
click on Find once again (or select it and press the Enter key) .

•

	

To delete the string, click on Change, or select it and press
the Enter key . Then, click on Find ; Change; or Change All, or
select it and press the Enter key .

•

	

Return to the text area and use the Backspace or Del key to
delete the string .

A message is displayed when the string can no longer be found .
To remove the message, click on OK, or select it and press the
Enter key .

Note: When Change All is selected, the System Editor changes
all strings found without stopping .

3. To remove the Find pop-up, click on Cancel, or select it and press
the Enter key .
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Appendix A . System Editor Key
Assignments

The following table shows the assigned keys for the System Editor
program . Pressing Shift, Control (Ctrl), or Alternate (Alt) in
combination with another key starts the action assigned to those
keys. When two keys are joined by a plus (+), while holding down the
first key press the second key . When three keys are joined by a plus
(+), hold down the first two keys and then press the third key . See
the quick reference card for other OS/2 key assignments .

Editing Keys

Key

	

Purpose

Alt+ Backspace

	

Undoes the last change made .

Backspace

	

If text is selected, deletes the selected text.

If no text is selected, deletes the character to
the left of the cursor. Any remaining
characters to the right of the cursor are
shifted left.

If the cursor is at the beginning of the line,
deletes the EOL character on the previous
line. The current line is joined with the
previous one .

Displays the Find window so you can search
for and change text .

Causes the selected text area to be copied
and moved to the Clipboard .

If text is selected, deletes the selected text .

If no text is selected, deletes the character to
the right of the cursor . Any remaining
characters to the right of the cursor are
shifted left.

CtrI + F

CtrI + Ins

Delete

Enter
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If the cursor is at the end of the line, deletes
the EOL character . The line is joined with
the next line .

Splits the current line by inserting an EOL
character at the cursor position .
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Key

Insert

Shift+ Del

Shift+ Ins

Tab

Purpose
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Switches between insert and overtype mode .

In insert mode, new text is inserted at the
cursor position, moving the existing text to
the right .

In overtype mode, the new text replaces the
existing selected text .

Causes the selected text area to be cut from
a file and moved to the clipboard .

Pastes the contents of the clipboard into the
file at the cursor position .

If text has been selected, the clipboard text
replaces the selected text .

If text has not been selected, the clipboard
text is inserted at the cursor position .

Inserts a tab setting at the cursor position .



Text Selection Keys
Use these keys to select text and extend existing selected areas of
text. The selection keys move the cursor point (ending point) in the
text while keeping the anchor point (starting point) still .

Caution: If an area of text is selected, pressing any character key, the
Backspace key, or the Delete (Del) key deletes the selected text .

Key

Shift+ arrow

Shift+ Home

Shift+ End

Shift+ Ctrl + -.

Shift+ Ctrl + (-

Shift+ Ctrl + Home

Shift+ Ctrl + End

Purpose

Selects text or extends a selection in the
direction of the arrow .

Selects text or extends a selection to the
beginning of the current line .

Selects text or extends a selection to the end
of the current line .

Selects text or extends a selection to the
beginning of the next word .

Selects text or extends a selection to the
beginning of the previous word .

Selects text or extends a selection to the
beginning of the file .

Selects text or extends a selection to the end
of the file .
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Cursor Movement Keys

Key

Up Arrow (T)

Down Arrow (j)

Left Arrow (4--)

Right Arrow (-->)

Ctrl+-s

Ctrl + F-

Home

End

Ctrl + Home

Ctrl + End

PgUp

PgDn

Purpose
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Moves the cursor up one line.

Moves the cursor down one line .

Moves the cursor left one character .

Moves the cursor right one character .

Moves the cursor to the beginning of the next
word .

Moves the cursor to the beginning of the
previous word .

Moves the cursor to the beginning of the
current line .

Moves the cursor to the end of the current
line .

Moves the cursor to the beginning of the first
line in the file .

Moves the cursor to the end of the last line in
the file .

Scrolls the text up one window minus one
line .

Scrolls the text down one window minus one
line .



Appendix B. DOS Mode Messages

This appendix contains DOS mode messages that do not have online
help. The messages are listed in bold type, and the cause and action
follow the message . If the first word after the cause is COMMANDS,
the message is generated by several different programs or
commands. If the first word is SYS (system message), the message
is generated by an internal DOS mode file .

Access denied
Cause: COMMANDS. Processing the requested command
violates the access mode of the file, subdirectory, or device
involved. For example, an attempt was made to write to a file
that is read-only, read a file that is write-only, or open a
subdirectory as a file .

Action: Use a different file name, or if the file is read-only and
you need to use that file, change its attribute with the ATTRIB
command .

Bad command or file name
Cause: SYS. The command you entered is not a valid DOS mode
command .

Action :

•

	

Make sure that you are not running an OS/2-mode-only
command .

•

	

Check the spelling of the command and re-enter it.
•

	

If the command name is spelled correctly, make sure that the
default drive contains the external command or batch file you
are trying to process .

Batch file missing
Cause: SYS. DOS could not locate the batch file it was
processing. The file may have been erased or renamed by one of
the steps within it. The current drive may have been changed
within the batch file, and the batch processor can no longer find
the BAT file using your PATH . Batch processing stops and the
DOS mode prompt appears .
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Action :

•

	

If the file name was changed, correct the command that
changed the name .

•

	

If the file was erased, use your backup copy . If you used
EDLIN to create the file or make changes, rename the BAK
file to BAT .

•

	

Correct the command that deleted the file . Include the drive
letters in the PATH .

BREAK is on/off
Cause: BREAK. This message shows the status of BREAK,
either on or off .

Action: Enter the command you want. For example, if the screen
shows "Break is off" and "Break is on" is desired, enter :

BREAK ON

Cannot do binary reads from a device
Cause: COPY. You used the /B parameter with a device name
while trying to copy from the device . The copy cannot be
performed in binary mode because COPY must be able to detect
the end-of-file from the device .

Action : Re-enter COPY and omit the /B parameter, or re-enter
COPY and use the /A parameter after the device name .

Cannot load COMMAND, this session halted
Cause : SYS. The system attempted to reload the command
processor, but the area in which the system keeps track of
available storage was destroyed ; or the command processor was
not found in the path specified by the COMSPEC environment
variable . OS/2 sessions may still be active .

Action: If DOS mode is required, end all OS/2 sessions and make
sure that COMMAND.COM is present on the diskette or drive you
are using ; then restart the system .
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Cannot start COMMAND, exiting
Cause: SYS. While the system was attempting to load another
copy of the command processor, it did not find enough available
storage to contain the new copy of COMMAND.COM. OS/2
sessions may still be active .

Action :

•

	

End all OS/2 sessions that may be running .
•

	

Increase the RMSIZE value in your CONFIG .SYS file. The
changed RMSIZE is active only after the system is restarted .

•

	

Restart the system .

Code page xxx not prepared for all devices
Cause: CHCP. CHCP was unable to select the code page for one
of the following reasons :

•

	

A device was not prepared for the requested code page .
•

	

A device I/O error occurred .
•

	

The device is currently printing .
•

	

The device does not support code page switching .

Action: Make sure that there is a DEVINFO statement in the
CONFIG.SYS file for each device (for example, printer, keyboard,
and screen) .

Code page xxx not prepared for system
Cause: CHCP. CHCP was unable to select the specified code
page .

Action: Verify that the CODEPAGE statement in CONFIG .SYS
includes the code page you are attempting to prepare .

Content of destination lost before copy
Cause: COPY. An illegal concatenation of files was detected
during the COPY command . The destination file name was
included among the source files being concatenated . The
condition was not detectable until the destination file was copied
over.

Action :

•

	

Restore damaged files from your backup copy .
•

	

Information message, no correction possible . Review the
syntax of the COPY command to prevent this from happening
again .

CTTY not supported In OS/2
Cause: SYS . Information message . The DOS command CTTY
was attempted .
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Action : No action required .

Current drive is no longer valid
Cause: COMMANDS. While attempting to get the current drive
for the DOS mode prompt, COMMAND found that the drive is no
longer valid .

Action: Change your current drive to a valid drive .

Duplicate file name or file not found
Cause: RENAME . You tried to rename a file to a file name that
already exists on the disk, or the file to be renamed could not be
found on the specified (or default) drive . RENAME is warning you
that you are using the same name for two files, or it cannot find
the file you are trying to rename .

Action: Make sure that you typed the file name correctly .
Re-enter the RENAME command .

ECHO is on/off
Cause: ECHO. This message shows the status of ECHO, either
on or off .

Action: Enter the command you want . For example, if the screen
shows "Echo is off" and "Echo is on" is desired, enter the
command :

ECHO ON

Error in EXE file
Cause: SYS. An error was detected in the relocation information
placed in the file by the LINK program . This may be because of a
modification to the file .

Action :

•

	

if you are using a purchased program, rerun the program
using your backup copy .

•

	

If you are using a program you wrote yourself, go through the
LINK procedure again .

Error writing to device
Cause: COMMANDS. The system met an I/O error when writing
output to a device . The device is unable to handle the number of
bytes requested .

Action: Change the amount of data in the file and retry the
command .
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EXEC failure
Cause: COMMANDS. The system met an error while reading a
command or other program from disk .

Action: Try the command again. If the error reappears, attempt to
load from a backup copy .

File allocation table bad, drive d
Abort, Retry, Ignore?

Cause: SYS. The file allocation has been damaged .

Action :

•

	

Retry .
•

	

Restart the system .
•

	

Reformat drive d and restore any lost files from your backup
copy .

File cannot be copied onto itself
Cause: COPY or XCOPY . You tried to COPY a file and place the
copy (with the same name as the original) in the same directory
and on the same disk as the original file .

Action : Change the name given to the copy, put it in a different
directory, or put it on another disk .

File creation error
Cause: SYS and COMMANDS. An unsuccessful attempt was
made to add a new file name to the directory or to replace a file
that was already there .

Action: If the file was already there, check to see if the file is
"read-only" and cannot be replaced; otherwise, run CHKDSK to
determine if the directory is full or if some other condition caused
the error .

File not found
Cause: SYS and COMMANDS. A file named in a command or
command parameter does not exist in the directory of the
specified (or default) drive .

Action: Retry the command using the correct file name .

FOR cannot be nested
Cause: Batch file. More than one FOR command was found on
one command line in the batch file .

Action: Use only one FOR command per command line ; then
retry the command .
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Insert disk with batch file
and press any key when ready

Cause: SYS. The diskette that contained the batch file being
processed was removed. The batch processor is trying to find
the next command in the file .

Action: Insert the diskette in the appropriate drive and press any
key. Processing continues .

Insert disk with \COMMAND.COM In drive d
and press any key when ready

Cause: SYS. The system is attempting to reload the command
processor, but COMMAND.COM is not in the drive indicated by
the COMSPEC environment variable .

Action: Insert the diskette that has COMMAND.COM in the
indicated drive and press any key .

Insert diskette for drive d
and press any key when ready

Cause: SYS. In a system with logical drives, a drive that is not
the current drive is being referenced, so DOS is asking for the
diskette corresponding to the referenced drive .

Action: If the diskette ford is different from the one currently in
the drive, insert the appropriate diskette and press any key .

Insufficient disk space
Cause: SYS and COMMANDS . The disk does not contain enough
free space to contain the file being written .

Action: If you suspect this condition is invalid, run CHKDSK to
determine the status of the disk . Otherwise, use another disk and
retry the command .

Insufficient memory
Cause: COMMANDS. The amount of available storage is too
small to allow these commands to function .

Action: Increase the value for the RMSIZE statement and/or
decrease the value for the BUFFERS statement in the
CONFIG .SYS file . Restart the system and try the command again .
If the message still appears, your system does not have enough
storage to process the command .

Intermediate file error during pipe
Cause: SYS . The system is unable to create one or both of its
intermediate files because the default drive's root directory was
full, the system is unable to locate the piping files, or the disk
does not have enough space to hold the data being piped .
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Action : Erase some files from the default drive's root directory,
and reissue the command that failed . If you get the same
message, one of the programs i n the command line has erased
one or both of the piping files . Correct the program and reissue
the command .

Invalid COMMAND.COM in drive d
Cause: SYS. When the system tried to reload the command
processor, the copy of COMMAND.COM on the disk was found to
be an incorrect version .

Action : Restore the correct COMMAND.COM to the indicated
drive .

Invalid date
Cause: SYS . You entered an invalid date or delimiter . The only
valid delimiters in a date entry are hyphens (-), slashes (/), and
periods ( .), or the date separator defined for the country specified
by the COUNTRY statement in CONFIG .SYS .

Action: Re-enter a valid date .

Invalid directory
Cause: SYS and COMMANDS. One of the directories in the
specified path does not exist .

Action: Retry the command using a valid directory, or create the
specified directory .

Invalid disk change
Cause: SYS. The diskette in the drive was changed while files
were still open on the diskette .

Action : Reinsert the correct diskette .

Invalid drive in search path
Cause: SYS. An invalid drive specifier was found in one of the
paths specified in the PATH command .

Action :

1 . Enter PATH . This displays the paths previously defined .

2. Find the invalid specifier .

3. Re-enter the PATH command with the valid drive specifier
and the desired paths .

Invalid drive specification
Cause: COMMANDS. An invalid or nonexistent drive
specification was entered in the command or in one of its
parameters, or the source and target drives are the same .
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Action : Re-enter the command using a valid drive specifier .

Invalid file name or file not found
Cause: RENAME or TYPE . You tried to rename a file that was
either invalid or not found in the specified directory . TYPE does
not allow global file name characters .

Action : Enter the correct file name .

Invalid number of parameters
Cause: COMMANDS. You have specified too few or too many
parameters for the command you issued .

Action: Check the syntax of the command and re-enter the
command .

Invalid parameter
Cause: SYS and COMMANDS . One or more parameters entered
for these commands are not valid or have been placed in the
wrong order .

Action: If the program expects a drive specifier, enter a colon ( :)
following the drive letter . In other cases, make sure that the
character following the slash (/) is valid for the program being
run .

Invalid path, not directory
or directory not empty

Cause: R M DI R .

•

	

The specified directory was not removed because one of the
names you specified in the path was not a valid directory
name .

•

	

The directory you specified still contains entries for files or
other subdirectories (except for the . and . . entries) . It is
possible that there are hidden files in the directory . The
CHKDSK command detects them .

•

	

You cannot remove a current directory .

Action: Try one of the following :

•

	

Correct the invalid directory name i n the path .
•

	

Delete any files or remove any subdirectories in the
directory .

•

	

Change to a different subdirectory and try again .
•

	

Run CHKDSK *.* in the directory . If there are hidden files,
erase them according to the instructions of the program that
created them .
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Invalid path or file name
Cause: ATTRIB or COPY. You specified a directory or file name
that does not exist .

Action : Use the correct name . Retry the command after checking
for the following :

•

	

Correct spelling of names
•

	

Valid directory names
•

	

Existence of file in the subdirectory specified .

Invalid time
Cause: TIME . An invalid time or delimiter was entered .

Action: Re-enter the correct time . The only valid delimiters are :

•

	

Colon ( :) between the hours and minutes
•

	

Colon (:) between the minutes and seconds
•

	

Period (.) between the seconds and hundredths of a second .

Label not found
Cause: Batch file. A GOTO command named a label that does
not exist in the batch file . This caused the system to read to the
end of the batch file, ending batch processing .

Action: If you do not want the GOTO to end the batch file, edit the
batch file and put the label in the desired location .

Lock violation
Cause: XCOPY. A source file has part or all of it locked against
reading .

Action: Wait a short time and try again .

Memory allocation error
Cannot load COMMAND, this session halted

Cause: SYS. The system attempted to reload the command
processor, but the area in which the system keeps track of
available storage was destroyed, or the command processor was
not found in the path specified by the COMSPEC environment
variable . OS/2 sessions may still be active .

Action : If DOS mode is required, end all OS/2 sessions and make
sure that COMMAND.COM is present on the diskette or drive you
are using ; then restart the system .

Must specify ON or OFF
Cause: BREAK or VERIFY . You entered something other than
ON or OFF .

Action: Try again, specifying ON or OFF .
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No free file handles
Cannot start COMMAND, exiting

Cause: SYS . An attempt to load a second copy of the command
processor failed because there are too many file handles opened
throughout the system .

Action: To reduce the number of open files, end programs that
are using OS/2 sessions .

No free file handles
The AUTOEXEC.BAT file could not be opened
Close some files in OS/2 mode and press any key to continue

Cause: SYS . An attempt to load the command processor failed
because there are too many file handles opened throughout the
system .

Action: To reduce the number of open files, end programs that
are using OS/2 sessions .

No path
Cause: PATH. Information message. An alternate path for DOS
to search for commands and batch files is not specified .

Action: No action required unless you want to define a set of
paths. If so, enter PATH and the set of paths you want ; then, press
the Enter key .

Out of environment space
Cause: SYS . Information message . DOS did not accept the SET
command you just issued because it could not expand the area in
which the environment information is kept. This normally occurs
when you try to add to the environment after loading a program
which makes itself resident (PRINT or MODE, for example) .

Action: Edit CONFIG .SYS to include or increase the /E :
parameter in the SHELL statement; then restart the system .

Path not found
Cause: SYS and COMMANDS . A file or path named in a
command or command parameter does not exist in the directory
of the specified (or default) drive .

Action : Retry the command using the correct path and file name .

Program too big to fit in memory
Cause : SYS. The file containing the external command cannot
be loaded because it is larger than the available free storage .

Action : Increase the number in the RMSIZE statement in your
CONFIG.SYS file to a larger value and/or decrease the value for
the BUFFERS statement in the CONFIG .SYS file. Restart your
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system and reissue the command . If the message reappears,
your system does not have enough storage to process the
command .

Syntax error
Cause: SYS. The command format you typed is incorrect .
Action : Use the correct format for this command .

Terminate batch job (Y/N)?
Cause: SYS. This message appears when you press the Ctrl and
Break keys together while DOS is processing a batch file .
Action: Press the Y key to stop processing the batch file .
Pressing the N key ends only the command that was processing
when the Ctrl and Break keys were pressed ; processing resumes
with the next command in the batch file .

Top level process aborted, cannot continue
Cause: SYS. The system attempted to reload the command
processor, but the area in which the system keeps track of
available storage was destroyed ; or the command processor was
not found in the path specified by the COMSPEC environment
variable . OS/2 sessions may still be active .
Action : If DOS mode is required, end all OS/2 sessions and make
sure that COMMAND.COM is present on the diskette or drive you
are using ; then restart the system .

Unable to create directory
Cause: SYS and COMMANDS .

•

	

The directory you want to create already exists .
•

	

One of the directory path names you specified could not be
found .

•

	

You attempted to add a directory to the root directory and it is
full .

•

	

A file by that name already exists in that directory.
•

	

The directory name you specified contains invalid characters
or is a reserved device name .

Action : Do the following :

•

	

Determine if a directory by that name already exists in the
parent directory (or current directory) .

•

	

Recheck all your directory names to make sure that they are
valid .

•

	

Use CHKDSK to see if your current directory is full .
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VERIFY Is on/off
Cause: VERIFY. This message indicates the status of VERIFY,
either on or off .

Action: Enter the command you want . For example, if the screen
shows "Verify is off" and "Verify is on" is desired, enter the
command :

VERIFY ON
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Appendix C. Table of OS/2 Commands

This appendix contains an alphabetic listing of OS/2 commands by

name, mode, purpose, and type . If no mode is specified, the

command operates i n both OS/2 and DOS modes .

Note: Refer to the OS/2 Command Reference for the syntax of the

command, associated parameters, and examples .

Name

	

Mode Purpose of Command

	

Type

ANSI

	

OS/2 Permits ANSI control sequences

	

Prompt

that allow extended display and

keyboard support .

APPEND

	

DOS Establishes a path for your

	

Prompt

system to search for non-program

files outside the current directory

that the PATH command does not

search for .

ASSIGN

	

DOS Assigns a drive letter to a

	

Prompt

different drive .

ATTRIB

	

Turns on or off the read-only

	

Prompt

attribute and the archive bit of a

file, for selected files in a

directory or for all files in a

directory level .

AUTOFAIL

	

OS/2 Allows or prevents system-wide

	

Config

hard-error and exception

pop-ups .

BACKUP

	

OS/2 Backs up one or more files from

	

Prompt

one disk to another .

BOOT

	

Provides the ability to change

	

Prompt

between DOS and the operating

system from the same fixed-disk

drive .

BREAK

	

DOS Allows you to instruct DOS to

	

Config

check if you have pressed the

	

Prompt

Ctrl+Break keys when a program

requests that the operating

system perform any functions .

BUFFERS

	

Establishes the number of disk

	

Config

buffers used by your system for

maximum performance .
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Name

	

Mode Purpose of Command

	

Type

CACHE

CALL

CHCP
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Specifies the parameters that the

	

Config
High Performance File System
uses to write information to a
disk. This command is specified
as part of a RUN statement in the
CONFIG.SYS file .

Allows a file to be called from Batch
within another batch file without Config
ending the first batch file .

Allows you to switch back and

	

Prompt
forth between two code page
character sets that are defined in
your CONFIG.SYS file .

CHDIR or CD

	

Changes the directory you are

	

Prompt
presently in or displays the
directory name .

CHKDSK

	

Analyzes the directories, files,

	

Prompt
and file allocation table (FAT) on
the specified or default drive, and
produces a disk status report .

CLS

	

Clears the window or entire

	

Prompt
display screen of any information .

CMD

	

OS/2 Starts a secondary command

	

Prompt
processor .

CODEPAGE

	

Selects the system code pages

	

Config
(defined character sets) to be
prepared by the operating system
for code page switching .

COMMAND

	

DOS Starts another DOS command

	

Prompt
processor .

COMP

	

Compares the contents of two

	

Prompt
files .

COPY

	

Copies or combines one or more

	

Prompt
files .

COUNTRY

	

Identifies the country for which

	

Config
country-dependent information is
selected .

CREATEDD

	

OS/2 Creates a dump diskette .

	

Prompt

DATE

	

Displays or changes the date

	

Prompt
known to the system and resets
the date on your system's clock .



Name

	

Mode Purpose of Command

	

Type

DDINSTAL

	

OS/2 Provides an automated way to

	

Prompt
install new device drivers .

DETACH

	

OS/2 Simultaneously starts and

	

Prompt
detaches an OS/2 program from
its command processor .

DEVICE

	

Specifies the path and filename of

	

Config
a device driver to be installed in
the CONFIG .SYS file .

DEVINFO

	

Prepares a device for system

	

Config
code page switching .

DIR

	

Displays files contained in a

	

Prompt
directory .

DISKCACHE

	

Specifies the number of blocks of

	

Config
storage to allocate for control
information and for use by the
disk cache .

DISKCOMP

	

Compares the contents of the

	

Prompt
diskette in the source drive to the
contents of the diskette in the
target drive .

DISKCOPY

	

Copies the contents of a diskette

	

Prompt
to another diskette of the same
capacity .

DPATH

	

OS/2 Searches directories for data files

	

Prompt
located outside the current

	

Config
directory. (For use in
CONFIG .SYS, refer to the SET
command .)

EAUTIL

	

OS/2 Provides the ability to split

	

Prompt
extended attributes from a file
and re-join extended attributes to
a file .

ECHO

	

Allows or prevents the screen

	

Batch
display of OS/2 commands run
from a batch file . ECHO does not
interfere with messages produced
while commands are running .

ENDLOCAL

	

OS/2 Restores the drive, directory, and

	

Batch
environmental variables that
were in effect before you ran the
SETLOCAL command .
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Name

	

Mode Purpose of Command

	

Type

ERASE or DEL

	

Erases files that you no longer

	

Prompt
want (or had previously copied to
another subdirectory) .

EXIT

	

Ends the current command

	

Prompt
processor (CMD or COMMAND)
and returns to the previous one, if
one exists .

EXTPROC

	

OS/2 Defines an external batch file

	

Batch
processor, giving you the option
to use your own batch processor .

FCBS

	

DOS Determines file control blocks

	

Config
(FCBs) management information .

FDISKPM

	

OS/2 Allows you to create or delete a

	

Prompt
partition or logical drive or to
make a partition startable .

FIND

	

Searches for a specific string of

	

Prompt
text in a file or files .

FOR

	

Allows repetitive processing of

	

Batch
OS/2 commands .

FORMAT

	

Creates the directory and file

	

Prompt
allocation tables on a disk .
Formats a disk in the specified
drive to accept OS/2 files .

GOTO

	

Transfers control to the line

	

Batch
following the one containing the
appropriate label .

GRAFTABL

	

DOS Allows additional characters from

	

Prompt
a language code page to be
displayed when using display
adapters in graphics mode .

HELP

	

Allows a line of help as part of the

	

Prompt
command prompt, a help screen,
and information related to a
warning or error message .

IF

	

Allows conditional processing of

	

Batch
OS/2 commands .

IFS

	

Specifies the parameters used in

	

Config
managing disks and diskettes
formatted for file systems other
than the File Allocation Table
(FAT) .

IOPL

	

OS/2 Allows I/O privilege to be granted

	

Config
to requesting processes .
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Purpose of Command

	

Type

Logically connects a drive to a

	

Prompt
directory on another drive. (You
can only join a drive at the root
directory .)

Selects a keyboard layout to

	

Prompt
replace the current keyboard
layout for all OS/2 and DOS
full-screen sessions and all OS/2
windows sessions .

Turns ON or OFF the retrieve

	

Prompt
mode of command line editing .

Creates or changes the volume

	

Prompt
identification label on a disk .

Identifies the locations of dynamic

	

Config
link libraries for OS/2 programs .

Allows you to log system events

	

Config
and place a record of that event
in the System Log file .

Establishes the time limit for any

	

Config
program so there is no lack of
access to the processor resource .

Selects storage allocation

	

Config
options .

Creates a new subdirectory used

	

Prompt
to assist you in organizing your
files and programs .

Establishes operation modes for

	

Prompt
devices .

Reads data from the standard

	

Prompt
input device and sends data to
the standard output device
(usually the display) one full
screen at a time .

MOVE

	

OS/2 Moves one or more files from one

	

Prompt
directory to another directory on
the same drive . (If you prefer,
you can give the files different
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names .)

PATCH Allows you to apply IBM-supplied Prompt
patches to make repairs to
software .

Name Mode

JOIN DOS

KEYB OS/2

KEYS OS/2

LABEL

LIBPATH OS/2

LOG

MAXWAIT OS/2

MEMMAN OS/2

MKDIR or MD

MODE

MORE



Purpose of Command

	

Type

Establishes a path for your

	

Prompt
system to search for program and

	

Config
data files in subdirectories other
than your current directory . (For
use in CONFIG .SYS, refer to the
SET command .)

Suspends running of the batch file

	

Batch
and displays a Press any key
when ready . . . message .

Allows or prevents pausing when

	

Config
error messages are issued during
the processing of the
CONFIG .SYS file .

Converts a picture file into a

	

Prompt
format that can be exchanged
between non-Presentation
Manager applications .

Prints one or more picture files

	

Prompt
on a specified device .

Displays a picture file .

	

Prompt

Acts as the host program for the

	

Prompt
Procedures Language 2/REXX
within the Presentation Manager
session . This is required if a
Procedures Language 2/REXX
add-on function package wants to
take advantage of the
Presentation Manager
environment .

Prints or ends the printing of files .

	

Prompt

Selects priority calculation in

	

Config
scheduling regular class threads .

Changes the command prompt .

	

Prompt
(For use in CONFIG.SYS, refer to

	

Config
the SET command .)

Selects one or two operating

	

Config
modes .

Loads the user interface program

	

Config
and OS/2 command processor .

Allows you to display process

	

Prompt
status information at run time .

Recovers files from a disk

	

Prompt
containing defective sectors .
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Name Mode

PATH

PAUSE

PAUSEONERROR

PICICHG OS/2

PICPRINT OS/2

PICSHOW OS/2

PMREXX OS/2

PRINT

PRIORITY OS/2

PROMPT

PROTECTONLY OS/2

PROTSHELL OS/2

PSTAT OS/2

RECOVER



Name

	

Mode Purpose of Command

	

Type

REM

	

Adds comments or line spacing in

	

Config
a batch file or a CONFIG .SYS file.

	

Batch

RENAME or REN

	

Changes a file name .

	

Prompt

REPLACE

	

Selectively replaces files on the

	

Prompt
target drive with files of the same
name from the source drive .
Also, selectively adds files from
the source drive to the target
drive .

RESTORE

	

OS/2 Restores one or more BACKUP

	

Prompt
files from one disk to another .

REXXTRY

	

OS/2 Allows you to test lines of

	

Prompt
Procedures Language 2/REXX
instructions to see how they
operate .

RMDIR or RD

	

Removes empty directories .

	

Prompt

RMSIZE

	

DOS Specifies the highest storage

	

Config
address allowed for the DOS
operating environment .

RUN

SET

Loads and starts a system

	

Config
program during system startup .

Sets one string in the

	

Config
environment equal to another

	

Prompt
string for later use in programs .

	

Batch

SETCOM40

	

DOS Sets the COM port address so

	

Prompt
that a DOS program can access
the COM port interface directly to
support serial devices, such as a
plotter, printer, or mouse, when
the COMOx device driver has
been installed .

SETLOCAL

	

OS/2 Lets you define the drive,

	

Batch
directory, and environmental
variables that are local to the
current batch file .

SHELL

	

DOS Loads and starts the DOS

	

Config
command processor,
COMMAND .COM, or allows you to
replace the DOS command
processor with another command
processor .

Table of OS/2 Commands 217



Name

	

Mode Purpose of Command

	

Type

SHIFT

	

Allows the use of more than ten

	

Batch
replaceable parameters in batch
file processing .

SORT

	

Reads data from standard input,

	

Prompt
sorts the data, and writes it to
standard output .

SPOOL

	

OS/2 Intercepts data on its way to the

	

Prompt
printer from simultaneously
running applications, stores the
output temporarily, and then
releases the output to your
printer so that it does not merge .

Starts an OS/2 mode program in

	

Prompt
another session .

Substitutes a drive letter for

	

Prompt
another drive and path .

Specifies the location and size of

	

Config
the swap file .

Suspends or resumes logging of

	

Prompt
events i n the System Log file .
You can also display or print the
log file as well as start or stop
adding entries .

Determines the maximum number

	

Config
of independent actions, known as
threads, that can exist in the
system at one time .

Displays or changes the time

	

Prompt
known to the system, and resets
the time on your system's clock .

Sets the amount of processor

	

Config
time allocated to processes and
programs for both modes .

Selects or sets the tracing of

	

Config
system events ; also is used for

	

Prompt
debugging because it controls the
tracing action taken (how much
gets displayed to the user) during
the execution of a program .

TRACEBUF

	

OS/2 Establishes the size of the trace

	

Config
buffer.
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START OS/2

SUBST DOS

SWAPPATH OS/2

SYSLOG OS/2

THREADS OS/2

TIME

TIMESLICE OS/2

TRACE OS/2



Name

	

Mode Purpose of Command

	

Type

TRACEFMT

	

OS/2 Formats the contents of the

	

Prompt
system trace buffer, including
time stamps, and outputs it to a
display or printer for further
analysis .

TREE

	

Displays all the directory paths

	

Prompt
found on the specified drive, and
optionally lists the files i n the root
directory and in each
subdi rectory .

TYPE

	

Shows the text of a file .

	

Prompt

UNPACK

	

Decompresses files that have

	

Prompt
been compressed on the shipped
diskettes . Files that are not
compressed are copied .

VER

	

Displays the OS/2 version

	

Prompt
number .

VERIFY

	

Confirms that data written to a

	

Prompt
disk has been correctly written .

VOL

	

Displays the disk volume label, if

	

Prompt
it exists .

XCOPY

	

Selectively copies multiple files,

	

Prompt
including lower-level
subd i rectori es .
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Appendix D. Procedures Language 2/REXX
Instructions and Functions

This appendix contains an alphabetical table of Procedures Language
2/REXX instructions and functions by name, purpose, and type. More
detailed information on these Procedures Language 2/REXX (referred
to as REXX in the remainder of this appendix) instructions and
functions can be found in the Procedures Language 2/REXX
Reference .

In this table, an I identifies the terms that are REXX instructions and
an F identifies the built-in REXX functions . All REXX instructions and
built-in functions operate only in OS/2 mode .

© Copyright IBM Corp . 1991
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Name Purpose Type

ABBREV Checks to see if a string is an
abbreviation of another string .

F

ABS Returns the absolute value of a number . F

ADDRESS Returns the name of the environment to
which commands are currently being
submitted .

F

ADDRESS Changes the temporary or permanent
destination of commands .

I

ARG Returns information about the argument
strings to a program .

F

ARG Retrieves argument strings provided to
a program or internal routine and
assigns them to variables .

I

BEEP Sounds the system speaker . F

BITAND Returns a string composed of the two
input strings logically connected with
AND.

F

BITOR Returns a string composed of the two
input strings logically connected with
OR .

F

BITXOR Returns a string composed of the two
input strings logically connected with
XOR.

F

B2X Converts binary to character . F
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Name Purpose Type
CALL Allows internal routines (labels), built-in

functions, and external functions to be
called as subroutines .
If ON or OFF is specified, it can be used
to control the trapping of certain
conditions .

I

CENTER Returns a centered string . F
CHARIN Reads characters in from an input

stream .
F

CHAROUT Write characters to an output stream . F

CHARS Returns the number of characters
remaining in an input stream .

F

COMPARE Returns the result of the comparison of
two strings .

F

CONDITION Returns information about a trapped
condition .

F

COPIES Returns concatenated copies of a string . F
C2D Converts a character to decimal . F
C2X Converts a character to hexadecimal . F
DATATYPE Returns the result of checking the data

type .
F

DATE Returns the date set on your system . F
DBCS Indicates double-byte character sets,

which are used to support languages
that have more characters than can be
supported by 8 bits .

F

DELSTR Deletes a substring as a character unit . F
DELWORD Deletes a substring as a word unit . F
DIGITS Returns the current setting of numeric

digits .
F

DIRECTORY Returns the name of the current
directory .

F

DO Groups instructions and optionally runs
them repetitively. During repetitive
operations, a control variable can be
stepped through some range of values .

I

DROP Unassigns variables and restores them
to their original initialized state .

I

D2C Converts decimal to character . F
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Name Purpose Type

D2X Converts decimal to hexadecimal . F

ENDLOCAL Restores the drive directory and
environment variables in effect before
the last SETLOCAL function .

F

ERRORTEXT Returns the error message for an error
number .

F

EXIT Leaves or ends a program
unconditionally .

I

FILESPEC Returns a selected file specification of
either drive path or name .

F

FORM Returns the current setting of the
numeric form .

F

FORMAT Rounds and formats a number . F

FUZZ Returns the current setting of numeric
fuzz .

F

IF Allows conditional processing of
commands and instructions .

I

INSERT Inserts a string into a target . F

INTERPRET Processes instructions that have been
built dynamically by evaluating
expression .

I

ITERATE Alters the flow within a DO loop (that is,
any DO construct other than that with a
simple DO) .

I

LASTPOS Returns the position of the last
occurrence of a string .

F

LEAVE Exits immediately from one or more
repetitive DO loops (that is, any DO
construct other than with a simple DO) .

I

LEFT Returns the left-most portion of a string . F

LENGTH Returns the length of a string . F

LINEIN Reads a line from an input stream . F

LINEOUT Writes a line to an output stream . F

LINES Returns the number of lines remaining
in an input stream .

F

MAX Returns the largest number out of a list . F

MIN Returns the smallest number out of a
list .

F



Name

	

Purpose

	

Type

NOP

	

Indicates a dummy instruction that has

	

I
no effect. It can be useful as the target
of a THEN or ELSE .

NUMERIC

	

Changes the way arithmetic operations

	

i
are carried out .

OVERLAY

	

Overlays a string .

	

F

OPTIONS

	

Passes special requests or parameters

	

I
to the language processor .

PARSE

	

Assigns data from various sources to

	

I
one or more variables .

PARSE PULL

	

Places an answer in memory . Displays

	

I
all input as it was entered .

POS

	

Returns the position of one string within

	

F
another string .

PROCEDURE

	

Protects all of the existing variables

	

I
within an internal routine by making
them unknown to the following
instructions unless selected otherwise
through the EXPOSE option .

PULL

	

Reads a string from the head of the

	

I
currently active REXX data queue . Short
form of PARSE PULL .

PUSH

	

Stacks strings into the currently active

	

I
REXX data queue, last in first out (LIFO) .

QUEUE

	

Appends strings resulting from

	

I
expressions to the tail of the currently
active REXX data queue, first in first out
(FIFO) .

QUEUED

	

Returns the number of lines remaining

	

F
in the queue .

RANDOM

	

Returns a pseudo-random number in the

	

F
range 0 through 999 or minimum to
maximum .

RETURN

	

Returns control, and possibly a result

	

I
from a REXX program or internal
routine, to its starting point .

REVERSE

	

Returns a string swapped end-to-end .

	

F

RIGHT

	

Returns the right-most portion of a

	

F
string .
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Name

	

Purpose

	

Type

SAY Writes to the default output stream,

	

I
usually means to display to the user,
though the output destination can be
dependent on the implementation of the
program .

SELECT

	

Processes one of several alternative

	

I
instructions .

SETLOCAL

	

Saves the current working drive and

	

I
directory and the current values of the
OS/2 environment variables that are
peculiar to the current process .

SIGN

	

Returns an indication of a positive,

	

F
negative, or zero number .

SIGNAL

	

Causes an abnormal change in the flow

	

I
of control or, if ON or OFF is specified,
controls the trapping of certain
conditions .

SOURCELINE

	

Returns the line number of the final line

	

F
of the source file, or the nth line .

SPACE

	

Formats the blank-delimited words in a

	

F
string .

STREAM

	

Controls the attributes of I/O streams .

	

F

STRIP

	

Removes leading, trailing, or both

	

F
characters from a string .

SUBSTR

	

Returns the substring of a string as a

	

F
character unit .

SUBWORD

	

Returns the substring of a string as a

	

F
word unit.

SYMBOL

	

Returns the characteristics of a

	

F
symbolic name .

TIME

	

Returns the local time set on the system

	

F
in the format of : hh:mm:ss or in the
format set in the option .

TRACE

	

Selects or sets the tracing of system

	

I
events; also is used for debugging
because it controls the tracing action
taken (how much gets displayed to the
user) during the operation of a REXX
program .

TRACE

	

Returns trace actions currently in effect .

	

F
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Name

	

Purpose

	

Type

TRANSLATE

	

Translates characters in a string to

	

F
associated characters in another string ;
if neither string is specified, it converts
them to uppercase .

TRUNC

	

Returns the integer part of a number

	

F
and n decimal places .

VALUE

	

Returns or sets the value of a variable .

	

F

VERIFY

	

Verifies that a string is composed only

	

F
of characters from the reference .

WORD

	

Returns the nth blank-delimited word in

	

F
a string .

WORDINDEX

	

Returns the position of the nth

	

F
blank-delimited word or string .

WORDLENGTH

	

Returns the length of the nth

	

F
blank-delimited word or string .

WORDPOS

	

Returns the word number of the first

	

F
word or phrase in a string .

WORDS

	

Returns the number of blank-delimited

	

F
words in a string .

XRANGE

	

Returns a string of all 1-byte codes

	

F
between and including two values .

X2B

	

Converts data from hexadecimal to

	

F
binary.

X2C

	

Converts data from hexadecimal to

	

F
character .

X2D

	

Converts data from hexadecimal to

	

F
decimal .

226 Instructions and Functions



Index

A
about this operating system 1
accessing the command
reference 29

adapter, updating support 24
adding

a mouse 29
a printer driver 34
a printer name 44
a queue driver 42
a queue name 46
blank lines in REXX 129
log file entries 89

after installation, adding
options 28

allowing symbols as text 86
anchor point 187
AND operator (REXX) 146
anti-al iased text 27
APPEND command 23
append redirected output 76
apply software repairs 91
assignments, REXX 127
asynchronous communications

AUTOEXEC. BAT 110
chaining 115
ending 109
extensions 115
naming 115
nesting 115
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batch files (continued)
running 106
special types 110
STARTUP.CMD 111

baud rate settings 41
BUFFERS command 67

central processing unit (CPU) 5,

default printers 47
default queues 47
handshake settings 41
parity settings 41

queue connections 50
queue names 46
queue settings 48
spooler options 53
stop bit settings 41

CHCP command 59
CMD.EXE processing 14
code page switching

character sets 54
code page definition 54
commands that control 59
CONFIG .SYS statements 57
introduction to 54

227

modes, setting 100
attributes, extended 74
AUTOEXEC. BAT file 22, 110
AUTOFAIL command
autostart facility 111

B

87

background sessions
base printing 49

9

basic elements of REXX
batch files

122

printer driver settings 47
printer names 44
printer response time 50

10, 62
chaining, batch files 115
changing

AUTOEXEC. BAT file 22, 110
baud rate settings 41
COM port settings 41
country information 54

word length settings 41
character sets, defined 54
characters

See symbols

C
caching, HPFS 73
CALL command 23



code page switching (continued)
multilingual code page 56
national language code page
preparing for 56
supported devices 56

CODEPAGE command 58
colors (System Editor) 178
command

DEVICE 20
DEVINFO 58
DISKCACHE 68
FIND 82
GRAFTABL 59

228

commands (continued)
TRACE 89, 90

56

	

TRACEFMT 90
used more than once 19

comments in REXX 123
communication port setup 41
compatibility, DOS 95
conditionally processing

country information, changing 54
CPU 5, 10, 62
CREATEDD command 91
creating

batch files 106
HELP 87
KEYB 59

files 167, 170, 175
REXX files 106

cursor point 187LOG 89
MAXWAIT 64 customized installation 17
MEMMAN 69
MORE 82
PATCH 91
PATH 23

64

D
DDINSTAL command 22
default

printer, changing the 47
PRIORITY
PROTECTONLY 70
PSTAT 88 queue, changing the 47
RMSIZE 70
SET 23
SORT 82
SPOOL 51
SWAPPATH 69

delayed print in the DOS
session 99

deleting
printer driver 41
printer names 44
queue driver 42
queue names 46

SYSLOG 89
THREADS 64
TIMESLICE 64

operators 75
processor, OS/2

commands 84
14 configuration file (CONFIG .SYS) 17

commands
reference,

See also REXX

installing 29 configure DOS mode 17
CONFIG.SYS file 17, 93
connecting

printer drivers to a printer 45alphabetic listing 211, 221
APPEND 23 printer names with ports 45
AUTOFAIL
BUFFERS
CALL 23
CHCP 59

87
67

queues 50
control panel, displaying 37
controlling

code pages 59
OS/2 processing 14CODEPAGE 58

COUNTRY 58
CREATEDD 91
DDINSTAL 22

copy-protected DOS programs,
installing 99

COUNTRY command 58



determination, problem 87
device

driver settings 47
drivers, connecting printer 45

DEVICE command 20
devices, input and output 4
DEVINFO command 58
diagnosing system problems 88
directory, spooling to a 53
DISKCACHE command 68
display adapter support 24
displaying

control panel 37
print manager 43
queue connections 50

DO FOREVER instruction
(REXX) 155

DOS
coexistence 95
compatibility with DOS 4 .0 95
limitations 16
mode 3
mode messages 199
mode, configure 17
serial device support 100
session, delayed print in 99

E
echoing of redirection
statements 81

editing text 186
elements, definition of 122
eliminating command display
ending batch files 109
environment and setting the
environment batch file 112

EOL characters 179, 182
error logging 88
exceptions, DOS compatibility 95
EXIT instruction (REXX) 126
extended attribute support 74
extended graphics array
features 27

OS2.INI 92
STARTUP.CMD 111
with DLL extension 24

filtering information 82
FIND command 82
fonts (System Editor) 177
fonts, anti-aliased text 28
foreground session 8
forms, printer 48
full-screen program 12

G
GRAFTABL command 59
grouping instructions in REXX 138

H
handshake settings 41
HELP command 87
high performance file system (HPFS)

editing 186
filtering 82
piping 83

input
definition 4
OS/2 redirection sequences 77
redirecting 76
working with 4

229

extensions, batch files 115

F
files

See also System Editor
AUTOEXEC. BAT 22, 110
CONFIG.SYS 17,
OS2SYS . I N I 92

93

caching 73
defined 71
files 115

115
IF instruction (REXX) 138
information

changing country 54

drivers, installing 20
serial information 49



interactive session 8
I/O (input/output) 4

L
LEAVE instruction (REXX) 155
limitations, DOS 16
listing of

all commands 211
REXX instructions and
functions 221

System Editor key
assignments 195

LOG command 89
89

MAXWAIT command
MEMMAN command
memory, virtual 65

230

messages, DOS mode 199
m i nfree 70
modes, operating 3
MORE command 82
mouse, adding a 29
multiprogramming 10
multitasking

processes 10
threads 10
windows and sessions 7
with OS/2 5

N
naming batch files 115
nesting batch files 115

DOS 3, 15
OS/2 3 o 13

operating system, about this 1
operators, command 75
options (System Editor) 177
OR operator (REXX) 147
OS2SYS.INI file 92
OS2.INl file 92
OS/2

command processor 14
commands, table of 211
introduction to 1
mode 3
multitasking with 5
processing 14

installation, customized 17
installing

a mouse 29
a parallel printer driver 38

driver 40a plotter
a printer (procedure for) 34
a serial printer driver 40
anti-aliased fonts 28
copy-protected DOS
programs 99

device drivers 20
options after installation 28
the command reference 29

log system events
logging errors
loops in REXX

88
156

M
management

memory 65
process 62

K NOP instruction (REXX) 143
NOT operator (REXX) 146

key assignments (System Editor)
cursor movement 198
editing keys 195 0
text selection

KEYB command
197
59

operating modes
definition 3

redirection sequences 77
System Editor 167

output
definition 4
OS/2 redirection sequences
redirecting 76

77

64 working with 4
69



preparing for code page
switching 56

Presentation Manager program 12
preventing

program output 81
spooler function 53

print manager, displaying 43
printer

changing the default 47
driver settings, changing 47
drivers, connecting to a
printer 45

driver, adding a 34
forms 48
names, connecting with
ports 45

properties 48
response time, changing 50
setting up a 34
spooling (DOS) 99

printing
base 49
from the DOS session 99

PRIORITY command 64
problem determination 87
procedure for setting up a printer or
plotter 34

processes 10
processing commands
conditionally 84

names, adding, changing or
deleting 46

R
real mode 3
recovering

CONFIG.SYS file 93
INI files 92

redirect
input 76
parallel printer output to a serial
device 49, 101

redirection
sequences using numbers 77
statements, echoing of 81
symbols 76

reinstalling the operating
system 28

replaceable parameters 116, 117
required CONFIG .SYS
statements 17

response time (printer),
changing 50

REXX features and functions
adding blank lines 129
addition in 133
advanced features 157
AND operator 146
arithmetic section 129

231

P
processor 5,10
programs

OS/2 12parallel devices, installing 34
parity settings 41 running DOS 15

running OS/2 13
protect mode 3

70

PARSE PULL instruction
(REXX) 125

PATCH command 91 PROTECTONLY command
PATH command 23
performance, system 61

PSTAT command 88
PULL instruction (REXX) 125

piping information 83
placeholder 116
plotter

driver, installing a
setting up 34

PMPRINT queue driver

40

42 50

Q
queue

changing settings 48
connections, changing

PMREXX command 107,108
ports 45

driver, adding a 42
driver, erasing a 42



mixed case, writing in 128
multiplication in 133
NOT operator 146
OR operator 147
parsing words 156
procedures 118
quotes 128
repetitive loops 149
return codes 163
strings 124
SUBSTR( ) function 160
subtraction in 133
table of commands 221
trace function 109

232

segment swapping 65
SELECT instruction 140
selecting text

anchor point 187
cursor point 187

serial
device information 49
device support, DOS 100
devices, installing 34
printer driver 40

sessions
background 9
definition 7
foreground 8

SET command 23
setting

asynchronous communications
modes 100

communication ports 41
environment 112
ports for serial printers 41
up a printer or plotter
(procedure) 34

software repairs, apply 91

REXX features and functions
(continued)
assignments 127

REXX Instructions (continued)
grouping 138
I F 138

automating repetitive tasks 148 LEAVE 155
NOP 143
NOT 146

built-in functions 158
commands use of operating
system 126

comment line 123
comparisons 143, 146

159

OR 147
PARSE PULL 125
PULL 125

DATATYPE( ) function SAY 125
decision making 138
division in 134

SELECT 140
THEN 138

RMSIZE command 70
running

equal sign 145
error messages 163
expressions 135, 137 batch files 106

DOS programs 15
OS/2 programs 13

53

functions 158
getting started in 119
instructions 125 without print spooling
issuing OS/2 commands
from 162

labels
loops

127
149,156

S
SAY instruction (REXX) 125

AND 146
CALL 160
DO FOREVER 155
ELSE 139
EXIT 126

true and false operators
values 130
variables 130

143

working with arithmetic 132
writing a REXX procedure

REXX Instructions
135



SORT command 82
special batch files 110
SPOOL command 51
spooler

options, changing 53
preventing function in 53

stand-alone dump facility 91
START command 14, 112
starting

DOS programs 15
OS/2 programs 13
the System Editor 169

STARTUP.CMD file 14, 111
statements required in
CONFIG .SYS 17

stop adding log file entries 89
stop bit settings 41
strings i n REXX 124
supported devices, code page
switching 56

support, display adapter 24
suppressing command display 115
SWAPPATH command 69
swapping segments 65
switching code pages 54
symbols

See also Special Characters
(pipe information) 83
(conditional) 84

table of 75
•

	

(redirect input) 76
( ) (group commands) 85

or ; (OR operator) 147
•

	

(AND operator) 146
•

	

(separate commands) 85
&& (conditional) 84
-, or \ (NOT operator) 146
A (character input as text) 86
•

	

(redirect output) 76
•

	

(append redirected
output) 76

SYSLOG command 89
System Editor

action bar 172
anchor point 187
Autosave 184
case sensitive 192

System Editor (continued)
Clear choice 191
Clipboard

Copy 189
Cut 189
Paste 189

closing files 185
colors, selecting 178
Copy 189
copying text 189, 190
creating files 175, 176
cursor modes 172
cursor movement keys 198
cursor point 187
Cut 189
deleting files 184
deleting text 190

Clipboard 189
keyboard, with the 187
mouse, with the 187
starting a session 170

233

text 186, 187, 189
end of line character 179, 186
ending editing sessions
entering text 181

185

EOL characters 179, 182, 186
File pull-down 180, 182
files

closing 182, 185
creating 170, 175, 176
deleting 184
editing 186, 189
merging 188
merging text 189, 190
naming 170, 175
opening 180
options, setting 177
printing 185
saving 182,183
starting 170, 175, 176, 180

finding and changing text 191
fonts, selecting 177
formatting text 186
help 173, 174

deselecting text 188
Edit pull-down
editing

188,191



System Editor (continued)
icon 172
key assignments 195, 197,198
keyboard, editing with 187
lines, splitting and joining 186
merging files and text 187, 188,
190

mouse
editing with 187, 191
pointers 171
selecting text 187

naming and creating files 170
New 176
opening files 180
Options pull-down 177
options, setting 177, 178, 179
Paste 189, 190
paths 170, 180, 182, 183
printing 185
pull-downs 172
removing text 189
renaming files 183
restoring text 191
saving files

Autosave 182, 184
Save 182
Save as 175, 182, 183

saving text 182, 183, 184
searching for text 191
selecting drives, directories and
files 180

selecting text
anchor point 187, 188
cursor point 187, 188
Select all 188, 190

sessions, ending 185
Set colors pop-up 178
Set font pop-up 177
setting options 177, 178, 179
starting

an editing session 169, 170
files 175
from Desktop Manager 169
from File Manager 170
from the Action Bar 175
from the OS/2 Full
Screen 170

from the OS/2 Window 170
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System Editor (continued)
strings

changing 191,192
deleting 193
finding 191

tabs 181
text

adding and inserting 186
changing 191, 192, 193
copying 189
deleting 190, 191, 193
deselecting 188
editing 186
entering 181
finding 191
formatting 186
inserting 190
joining lines 186
merging 187, 190
removing 189
restoring 191
saving 182,183
selecting 187, 188, 190
splitting lines 186
undoing changes 191

warning messages 184
ways to start 169
word wrap 179
wrap 192

system performance
memory management 65

BUFFERS 67
DISKCACHE 68
MEMMAN 69
PROTECTONLY 70
SWAPPATH 69

process management 62
MAXWAIT 64
PRIORITY 64
THREADS 64
TIMESLICE 64

system problems, diagnosing 88
system trace facility 89



T
table of

OS/2 commands 211
REXX instructions and built-in
functions 221

System Editor key
assignments 195

THEN instruction (REXX) 138
threads 10
THREADS command 64
time (printer response),
changing 50

TIMESLICE command 64
TRACE command 89,90
trace facility 89
TRACEFMT command 90
types of OS/2 programs 12

U
updating support for your display
adapter 24

user and system INI files 92
using

comments 123
quotes for spacing in REXX 128
replaceable parameters 116

V
variables

environment 112
REXX 130

virtual memory 65

W
warning messages 184
windowed program 12
windows

background 9
definition 7
foreground 8
OS/2 program types 12

word length settings 41
working

with variables and arithmetic in
REXX 129

working with input/output 4
writing a REXX procedure 119, 135

Special Characters
•

	

BAT files 106
•

	

CMD files 106
•

	

DLL files 24
•

	

(redirect input) 76
() (group commands) 85
•

	

(AND operator) 146
•

	

(separate commands) 85
&& (conditional) 84
1 (OR operator) 147
(character input as text) 86

•

	

(redirect output) 76
•

	

(append redirected output) 76
(conditional) 84

(pipe output) 83
\ (NOT operator) 146
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